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Welcome to Axiom Contract
Management

Syntellis’s contract modeling and analytics tool helps organizations better predict and manage
payments, and leverage a data-driven approach for improved payer negotiations. With this software,
you can estimate net revenue by patient, and better manage contracts, claims, and payments across
your organization from both managed care and government payers.

Syntellis’s Axiom Contract Management solution helps healthcare organizations:

l Inform payer contract negotiations using empirical and modeled data

l Understand the financial impact of proposed changes to contract terms

l Optimize estimation of net patient revenue across inpatient and outpatient populations

What is covered in this document
This guide is for Axiom Contract Management administrators. System administration involves basic
configuration and maintenance tasks, some that you perform only once and some that you need to
perform regularly. You perform most admin tasks from the Axiom Contract Management Web Client.
Any tasks that are performed from the Desktop Client are noted as such.

System administrators model contracts that other users view and use in processing claims and creating
and viewing reports.

1
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This guide includes the following administrations features and tasks:

l Importing data – Building claim formats and other import formats, importing files to the system,
and viewing import activity

l Managing attributes – Creating, editing, enabling /disabling, and deleting attributes
l Modeling contracts– Including adding contracts (adding versions, provisions, attributes, clauses

and terms, thresholds and limits; attaching files and importing rates; copying contracts; and
more)

l Managing simulations – Creating, editing, and copying simulations; mapping simulations to drill-
down reporting

l Security – Application security roles and their associated access rights
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What’s new
Welcome to Version 2021.1 of Axiom Contract Management!

Enhancements in this release include:

Exclude always-payable services from Line Item MPR calculations

Nowwhen modeling professional services contracts, you can add an exclusion to a unit max limit on a
Line Item MPR calculation. The exclusion allows the always-payable services to calculate separately from
the reduction calculation, while still including them in the unit max limit count.

January 15, 2021Quarterly Release

Each quarter, 3M provides an update to the 3M GPS Grouper software integrated into Axiom Contract
Management. This update includes grouping, pricing, and regulatory updates to the APC and State-
specific eAPG groupers.
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Exclude always-payable services from LI MPR calculations on
professional claims

� Why use this feature
Nowwhen modeling professional services contracts, you can add an exclusion to a Line Item MPR
calculation with a max limit. The exclusion allows the always-payable services to calculate separately from
the reduction calculation, while still including them in the unit max limit count.

� How this feature works
What: Professional services that are always payable are excluded from Line Item MPR calculations when
those services are added as exclusions to the clause or term with the Line Item MPR. Additionally, the
clause with the always-payable services resides at the top of the clause hierarchy on the provision so that
those items are given priority, even if they do not contain the highest reimbursable service amount.

Where: This change applies to professional contracts with Line Item MPR calculation clauses.

Who: Only Axiom Contract Management administrators and users with the ability to create contracts
can add exclusions to clauses.

How:

1. Navigate to the Line Item MPR clause/term with the unit max limit.

2. Next, open the Line Item MPR clause Edit Clause dialog (or Edit Term if term). In the Exclusions
tab, click + Add a New Row, and then in the new row, enter the code of the service to be
excluded. Repeat for any additional codes that need to be excluded.

3. Click Save.

4. Ensure that the clause with the always-payable services is at the top of the clause page hierarchy;
if it is not, drag that clause row to the top of the table.

� Where to find more information
The following topics in the online help have been added or updated with information and instructions for
using this feature:

l Add an exclusion to a unit max limit Line Item MPR calculation
l About multiple-procedure payment reduction line item calculations
l Add a unit max limit to a Line Item MPR
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3M Jan 15 2021 Quarterly Release

� Why use this feature
Each quarter, 3M provides an update to the 3M GPS Grouper software integrated into Axiom Contract
Management. This update includes grouping, pricing, and regulatory updates to the APC and State-
specific eAPG groupers. These updates are necessary for clients to get the latest software and regulatory
changes for accurately grouping and pricing APC and eAPG claims.

� How this feature works
On a quarterly basis, 3M releases product Service Packs containing updates to its Group and Price service
software. Syntellis maintains Medicare contracts for many clients, and partners with 3M to handle
APC and eAPG calculations and to keep current with all regulatory changes that occur.

Where: The Group and Pricemenu in the Claims tab of Axiom Contract Management, and Group and
Price jobs in the Axiom Scheduler.

Who: Axiom Contract Management administrators who create contracts with the CMS Outpatient
calculation basis on a clause or term; users with the Scheduler role who are able to run the group and
price routine; general users reviewing results and working with applicable claims.

How: The Development team creates the update from the quarterly download. Client Success updates
the clients’ schedules and customer contracts to the required Medicare changes. The client picks up
available schedules for any new contract updates between quarters.
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Understanding the Axiom Contract Management system
Axiom Contract Management is a web application backed by an SQL database that stores contract terms,
patient claims, and payment information. The system uses the contract payment terms and the patient
claim information to calculate an expected payment for every claim submitted by the provider.

Understanding the flow of data

From billing to Axiom Contract Management
Axiom Contract Management requires many pieces of data to function properly. It is important to
understand the entire process of how data comes into, and moves through, the system.

As shown in the following diagram, when billable procedures are performed at a hospital, services data is
entered directly into the hospital’s information systems (HIS). Patient Accounting generates claim data
from this information and sends a bill in the form of an 837i 5010 for institutional claims, and as an 837p
5010 for professional claims, to the payer.

As these claims are sent out each day, a copy also goes to the Axiom Contract Management system.

NOTE: These claims should be collected after they have been sent through a claim scrubber so that
they reflect exactly what the payer receives.
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After import to Axiom Contract Management, claims arematched to the associated payer contracts
modeled in the system. These contracts can be very sophisticated and may contain combinations of
services being paid at fee schedules, per diem payments, lesser of terms, thresholds, stop losses, and
various other reimbursement methodologies. Ultimately, an expected payment is generated for each
claim that has a matching contract.

In addition, 835 remittance responses, along with posted payments and payer adjustments, flow into
Axiom Contract Management on a daily basis. With these five pieces of information (i.e., contract terms,
claim data, payments, adjustments, and remittance responses), the expected payment/contractual
generated by Axiom Contract Management allows you to identify which claims have or have not been
paid correctly.
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Managing data
This section provides information about importing data to Axiom Contract Management and integrating
data from the Contract Management system with other Axiom systems, as those integrations become
available in future releases.

About accessing data in the AxiomDesktop Client
Key Axiom Contract Management assets are available in the Axiom platform so that Axiom Contract
Management system administrators can pull and synchronize key contract, claim, and calculated claim-
level estimated payment details for use in the Desktop Client. This integration allows users to take
advantage of Axiom tools like the Axiom Scheduler Jobs Library and Axiom Reports.

During Contract Management installation, data is pulled from Axiom Contract Management and stored
in the following Axiom tables in the Table Library:

l CM Claim level estimated payment
l CM ClaimNumbers
l CM ContractDetails
l CM Last Import

In addition to the tables, an Axiom job, called Import Claim Level Estimated Payment, is created in the
Axiom Scheduler Library under Contract Management. This job helps share data from Axiom DSS with
Axiom Contract Management.

2
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When this job runs, it retrieves all of the contract detail, claim-level expected payments, and claim detail,
and uses it to update the four CM tables and keep the data in sync. Whenever users import new claims,
modify claims, calculate a payer, and so on, this job captures these changes when it runs. Generally, this
job would be set to run with the full nightly import (CMA Full Import job).

Importing data to Axiom Contract Management
Axiom Contract Management imports data in different formats depending on the type of data file the
system is attempting to access. Generally, data provided for import into the system can be categorized
into four types:

l Claims data – Claim files, both institutional and professional.
l Financial data – Payments and adjustments, both institutional and professional.
l Additional data – Primary Insurance Plan Codes, claim number mapping files, user-defined field

data, Professional Primary Insurance Plan Codes, and other contract terms.
l Remittance data – Institutional and Professional 835 files.

Claims and Financial data files must meet certain requirements before importing to Axiom Contract
Management, and they must also be in specific formats. Additional data and Remittance data files also
have format requirements. For details, see Client file specifications and Understanding data formats.

Currently, flat text files (Financial data and Additional data) can be imported using the Kreg Unified
Importer or the Axiom ETL Importer.

NOTE: The Kreg Unified Importer will eventually be phased out.

In general, the import process consists of the following main steps, depending on which importer you
use.

If using the Kreg Unified Importer... If using the Axiom ETL Importer...

1. Build fixed-width import format files
(for payments and adjustments).

2. Create an import batch. (See also:
About import batches)

3. Add files to the Import Task List.

1. Set up Axiom ETL import for flat files.

2. Ensure files are in the correct
format.

3. Drop the files in the appropriate
folders that were set up in step 1,
where they will be picked up by the
importer during the nightly import.

4. Files are auto-imported to the system during the nightly import. An Import
Summary Report is created after each successful nightly import. You can also view
import activity in Axiom Contract Management.
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Understanding data formats
All formats are built during system implementation; however, the system administrator is responsible for
ensuring that any format changes are reflected in Axiom Contract Management for importing to
continue smoothly.

IMPORTANT: If you do not maintain data formats in the system, you run the risk of inaccuracies in
your database.

� About formatting claim files for import

NOTE: UB and 1500 files are no longer accepted as import file types.

The Axiom Contract Management claim dataset is populated mainly by 837i and 837p files, which are
typically provided to the server on a scheduled basis for import and recalculation. These files must
adhere strictly to the 5010 standards and should be the “scrubbed” claims from the claims
clearinghouse.

� About formatting financial data files for import
Financial information such as payments and adjustments are imported using a format as well; however,
these file types are inherently different from the 837i/837p 5010 claim files. Typically, they are provided to
the Axiom Contract Management server as flat ASCII text files. Users with a Support license can build
fixed-width import formats if using the Kreg Unified Importer. For more information, see Importing data
to Axiom Contract Management.

Client file specifications
Client files imported to Axiom Contract Management must meet the specifications detailed in the
following tables for each file type.

� Claim data

Institutional
claims 837i
(required)

Description

Format 837i files must adhere strictly to the 5010 standards. All claims
must be “scrubbed.” Scrubbed claims typically come from a
claims clearinghouse (E-Premis, Emdeon, WebMD, CareMedic,
etc.).
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Institutional
claims 837i
(required)

Description

Frequency Daily. Claim files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a daily
basis for the previous day’s billing cycle. The folder should be
named \\servername\KHData\Hospital\837i5010.

Naming
convention

Institutional files must be unique text files and must not have
any spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example: YYYYMMDD837i.txt).

Professional
claims 837p
(optional)

Description

Format 837p files must adhere strictly to the 5010 format standards.

Frequency Daily. Claim files are dropped to predetermined import
folder locations on the Axiom Contract Management server
on a daily basis for the previous day’s billing cycle. The
folder should be named
\\servername\KHData\Hospital\837p5010.

Naming
convention

Professional files must be unique text files and must not
have any spaces or special characters in the name. Syntellis
requires that each file have a unique name concatenated
with a date stamp for the day it was created (example:
YYYYMMDD837p.txt).

� Financial data

Institutional
Payments
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Payments should be
positive values, reversals would be negative values.
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Institutional
Payments
(required)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Payment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter All records excluding payments received for professional
services (services billed on 837p).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s actual posted payments.
The folder should be named
\\servername\KHData\Hospital\Pay.

Naming
convention

Institutional Payment files must be unique text files and
must not have any spaces or special characters in the name.
Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDPayI.txt).

Institutional
Adjustments
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Adjustments should
be positive values, reversals should be negative values.
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Institutional
Adjustments
(required)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Adjustment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter Adjustment Postings. All records excluding adjustments
received for professional services (services billed on 837p).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder should
be named \\servername\KHData\Hospital\Adj.

Naming
convention

Institutional Contractual (adjustment) files must be unique
text files and must not have any spaces or special characters
in the name. Syntellis requires that each file have a unique
name concatenated with a date stamp for the day it was
created (example: YYYYMMDDAdjI.txt).

Professional
Payments
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Payments should be
positive values, reversals would be negative values.
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Professional
Payments
(optional)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Payment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter All records excluding payments received for institutional
services (services billed on 837i).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder should
be named \\servername\KHData\Hospital\Payp.

Naming
convention

Professional Payment files must be unique text files and
must not have any spaces or special characters in the name.
Syntellis requires that each file have a unique name
concatenated with a date stamp for the day it was created
(example: YYYYMMDDPayP.txt).

Professional
Adjustments
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited. Adjustments should
be positive values, reversals should be negative values.
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Professional
Adjustments
(optional)

Description

Requested
fields

Required:

l Account #
l Posting Date
l Adjustment Amount

Optional:

l UCRN/Claim Number
l Payer Code
l Payment Date
l Posting Code/Transaction Code

Filter Adjustment Postings. All records excluding adjustments
received for institutional services (services billed on 837i).

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s postings. The folder should
be named \\servername\KHData\Hospital\Adjp.

Naming
convention

Professional Contractual (adjustment) files must be unique
text files and must not have any spaces or special characters
in the name. Syntellis requires that each file have a unique
name concatenated with a date stamp for the day it was
created (Example: YYYYMMDDAdjP.txt).

� Additional data

Institutional
Primary
Insurance Plan
Code
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited.
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Institutional
Primary
Insurance Plan
Code
(required)

Description

Requested
fields

Required:

l Account #
l Primary Insurance Plan Code

Optional:

l UCRN/Claim number

Filter l Primary Insurance Only
l Date criteria based on 6 - 12month sliding window

(todayminus 6months)

Frequency Daily. To be dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\Ins.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (Example:
YYYYMMDDPlanI.txt).

Institutional
Primary
Insurance DRG
Code
(required)

Description

Format Flat ASCII text file or Pipe (|) Delimited. DRG codes should
be zero filled to 3 characters. For example, DRG 57 should
be 057.
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Institutional
Primary
Insurance DRG
Code
(required)

Description

Requested
fields

Required:
l Account #
l Primary Insurance DRG Code

Optional:

l UCRN/Claim Number

Filter l Exclude Professional Accounts
l Primary Insurance Only
l Date criteria based on 6 - 12month sliding window

(todayminus 6months)

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\DRG.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDdrg.txt).

Claim Number
Mapping File
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.

Requested
fields

This file is needed if the claim number on the claim does not
match the posting files from the hospital system.
Required:
l Account #
l UCRN/Claim Number

Filter Date criteria based on 6month sliding window (todayminus
6months).
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Claim Number
Mapping File
(optional)

Description

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\Map.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDUCRN.txt).

User Defined
Fields
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.

Requested
fields

Required:
l Account #
l User Defined Field (UDF)

Filter Date criteria based on 6 - 12month sliding window (today
minus 6months)

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. Each user
defined field feed needs a unique folder. These folders
should be named \\servername\KHData\Hospital\UDF#
where # is the number of the UDF.

Naming
convention

Files must be unique text files and must not have any spaces
or special characters in the name. Syntellis requires that
each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDudf1.txt).
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Professional
Primary
Insurance Plan
Code
(optional)

Description

Format Flat ASCII text file or Pipe (|) Delimited.

Requested
fields

Required:
l Account #
l Primary Insurance Plan Code

Optional:

l UCRN/Claim Number

Filter l Exclude Institutional Accounts
l Primary payor only

Frequency Daily. Files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\InsP.

Naming
convention

Files must be unique text files and must not have any
spaces or special characters in the name. Syntellis requires
that each file have a unique name concatenated with a date
stamp for the day it was created (example:
YYYYMMDDPlanP.txt).

� Remittance data

Institutional
and
Professional
835 (optional)

Description

Format 835 files must adhere strictly to the 5010 standards. These
files should come from the payer and not be edited.

Frequency Daily. 835 files are dropped to predetermined import folder
locations on the Axiom Contract Management server on a
daily basis for the previous day’s billing cycle. The folder
should be named \\servername\KHData\Hospital\8355010.
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Institutional
and
Professional
835 (optional)

Description

Naming
convention

Institutional files must be unique text files and must not
have any spaces or special characters in the name. Syntellis
requires that each file have a unique name concatenated
with a date stamp for the day it was created (example:
YYYYMMDD835.txt).

Build a fixed-width import format
Fixed-width import formats are generally used for importing payments and adjustments data to Axiom
Contract Management in fixed-width ASCII text files. To get the information from these downloads into
the system, you need to build a format for them. Their formats are different from a claim format in that
the data is provided in fixed columns instead of floating fields like on a claim file.

To create a file format:
1. Run UnifiedImport.exe.

2. From themenu bar, select Import Setup > Spec Imports.

3. In the System drop-down, select CMA.

4. From the Import Type drop-down, select Fixed.

5. Select Folder Based Import.

6. From the Table Name drop-down, select the name of the Import Table. In the following example,
a format is being defined to import to the CMAPostings table.

Axiom Contract Management Flat File Tables are categorized as follows:

l CMA Postings – Payments, Adjustments
l CMA Library Tables – Library APC, DRG, etc.
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l Additional Data Upload – DRG, User-Defined Data, Payer Code, etc.
By selecting CMA as the System, and in this example, CMA Postings, you are setting up the system
to create a CMA Postings format.

7. Select the Import Folder Location. You need to select a sample file to build flat file formats.
Click the ellipsis button next to Import Folder and select the folder where your sample file is
located.

IMPORTANT: This samplemust be free of print characters, headers and footers, and must
reside in a subfolder with the file path: \\YOURSERVERNAME\Data\Import.

8. Create a new format: Click New to open the format building windowwith the sample data for
selection, as shown in the following example.

9. In the fields at the top of the window, enter a format name and description.

10. On the lower left, in the Fields box, select the field to specify, and then select the data location in
the Field Selection box.

11. Click Accept to save the values to the database.
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NOTE: Fields in bold are considered required fields and must be specified. Fields in italics have
already been specified.

12. After completing the format for your flat file, click Save.

� Advanced flat file import options
When building an Axiom Contract Management Postings format, set up Advanced Options for the
following fields:

Amount Field
l Decimal Settings – Use this option to set whether the amount field in your file uses a space

decimal, implied decimal, or normal decimal. Depending on the way the amount field is provided,
you must select the appropriate DecimalFunctionID. Following are examples of each:

Space Decimal: 100 00→ 100.00

Implied Decimal: 10000→ 100.00

Normal Decimal: 100.00→ 100.00

l Negative placement – In some cases, negative signs (-) are attached to the front of the amount,
and in others, they are attached at the end.

IMPORTANT: For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any
accounts.

l Reverse sign – For the amount to populate correctly, payments and adjustments must be
positive values. Negative values are acceptable, but they will appear as a credit on any accounts.

l Post Category – Adjustment vs. Payment

l Post Prof Indicator – Professional vs. Institutional
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About import batches
Import batches are groups of tasks that tell Axiom Contract Management where to look for files, and
once found, which formats to apply to them. After you have the file to import, the next step in importing
data to the system using the Kreg Unified Importer (KUI) is creating import batches. When using the KUI,
you must create an import batch to get data into the system.

You need to create batches for claim files and any flat files that you want to import.

The setup for importing data is folder-based: a format is joined with a folder location, and upon import,
any file residing in that folder is brought in using the set format code.

IMPORTANT: All import folders must be subfolders of \\YOURSERVERNAME\Data\Import, and must
not have any spaces in the folder or file name.

After importation, the file is date-time stamped and moved into a mirrored IMPORTED folder for later
reference if needed.

Create an import batch
NOTE: This topic applies to the Kreg Unified Importer.

Before creating an import batch, you need to understand the following different types of batches used in
Axiom Contract Management:

l Claims should import from the 837i or 837p 5010 format files (claims are imported using the 5010
l Flat-file import – Folder and File based

To create an import batch:
1. Select the import type. An import batch can be created for each of the import types. Select the

appropriate import type from the drop-down menu.

2. Name and create your batch. Click Create to create a blank batch for the import type selected in
step 1.
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3. Select files/folders to import and the target table to import to. On the left side of the screen, from
Table Name drop-down, select the target table.

4. Click the ellipsis button next to Import Folder and then select the import folder or file location.

5. In the Format box, select the format to apply to the folder.

NOTE: Only one format can be applied to a folder.

6. Add your item to the batch. Click the right arrows button to add your item to the batch selected in
the drop-down on the right side of the window. To remove an item from the list, select it and
press theDelete key.

IMPORTANT: Do NOT click the Delete button. Clicking the Delete button will not remove an
item from the list, but instead will delete your whole batch.

7. Next, add the import batch to the Import Task List.
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Add import batches to the Import Task List
After creating import batches, to process them during the import, you must add them to the Import
Task List import queue. Simply creating the batches does not cause the files and folders in those batches
to import automatically.

To add or remove items from the Import Task List:
1. In the Unified Importer, from themenu bar, select Import >Manage Tasks.

2. Create and define a Task Group:

a. At the top right, click the Create New button.

b. From the Batch Types drop-down, select the batch type, and then click the arrow buttons
to add the batch types to the Task Group on the right.

In the example below, the Task Group “Example Task Group” is defined with a number of
batch imports of various types. These will all run when the Task Group is called by the
import process.
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Set up Axiom ETL import for flat files
Use these instructions to set up folder and file options for importing flat files using the Axiom ETL
importer. These instructions are for system implementers setting up new systems and for support
technicians setting up import folders for additional flat file types.

IMPORTANT: When copying an existing flat import file, you must add an underscore (_) and a
number or other character to the end of the copied file name: a copy of a file named CM_TempXXX
would be named CM_TempXXX_y; so a copy of the file CM_TempClaimAddDRG could be named
CM_TempClaimAddDRG_2.

To set up import file and folder options:
1. In the AxiomWindows Client, from the Axiom ribbon tab, click Imports > Contract Management>

[desired flat file import type] > Edit.

2. In the Flat File Import dialog, click the Source tab.

3. For Import Type, select File.

4. In File Import Options, select the following:
a. For File type, select Delimited file.

b. For Source path, select Use specified path.

c. In the Source folder field, enter the path to the folder in which the client will place files. This
is also the folder from which the importer picks up the files.

NOTE: This path is provided by the client. For requirements, see Client file
specifications.

d. For Import from, selectMultiple files.

5. In the File Options section, select the following:
a. If the first row of data in your file has column headers, select the option First row has

column names.
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b. For Delimiter character, select the pipe delimiter (|).

c. For Text qualifier character, the default is quotemarks. If your file uses a different qualifier
character, enter it in this field.

6. In theMultiple File Options section, select the following:
a. For Import order, select Creation date.

b. For Archive folder, this is the same path as the Source folder except that instead of a folder
named “Import” the folder is named “Imported,” as shown in the following example.

c. Ensure that the option Add timestamp prefix to file names when archiving successful
import files is selected.

7. If the client is using column header names in the file, click theMapping tab and then verify that
the information displayed in the Temp Table Column and Destination Column is correct.

8. If the information is not correct, select the line in the column and then type the correct heading.

9. Click Apply and then click OK.
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View import activity
To view your import activity:

1. Log in to the Axiom Contract Management Web Client.

2. In themain menu header, click Import Data and select View Batches.

TheManage Import Batches page opens.

Manage Import Batches page example

On theManage Import Batches page, you can view all data entered in the system, organized by
batch (1 file = 1 batch). This is useful when looking at the View a Claim Summary tab, where the
batch number is provided and you want to locatemore information about that batch.

Each claim batch has the following information columns:

l Import Date
l Type (type of claim)
l Batch #
l Claims Submitted (number of claims)
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l # Rejected
l # Accepted
l # Exceptions
l # Calculated
l Total Charges
l Notes – This column contains notes about the imported file; for example, if a file was not

imported because it is a duplicate, that is noted here.

3. To view batch information for Postings and other file imports, from the Select Import Type drop-
down, select Flat File Imports.

Flat file imports include payments and adjustments, as well as any additional data files you
submit, such as DRG or plan code files.

Some information is not available if the batch was imported as part of a historical data import.

TIP: In every view, the bottom left corner contains page navigation options. Click the arrows
to move to the next/previous page:

IMPORTANT: Do NOT delete batches unless instructed to do so by a member of the CMA
Support Team. If the batch information is deleted, it cannot be recreated.

About the Import Summary Report
All data entering the system runs through Syntellis’s auto-importer, which generally runs four to seven
days per week. It usually runs late at night or early in themorning so that it does not interfere with work
being done by users. When the import completes, if successful, you will receive an email confirming the
import and detailing the contents. The following is a list of terms and fields, with accompanying
definitions, found on the report.

� Import Summary Report definitions – CLAIMFILES

Field Definition

Batch Number System # assigned to each import file.

Import File Name Name and import location of file.
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Field Definition

# of Claims Read into
Temp

In Axiom Contract Management, all claims are loaded to a temporary
staging area before being transferred into the Live environment. This
allows us to run validation processes on the data to ensure the data is
correct. This number should tie to the number of billed claims in the
import file.

# of Late Charge Records Details howmany late charges were in the import file.

# of Claims Rejected to
Bad

In cases where bad data is provided, the system removes the records
associated to the bad claim and moves them into a separate area. For
details, see About problem file processing. You can run the Bad
Records report to check why any claims weremoved there. Reasons
vary as to why a claim would bemoved to bad, but most of the time it
is related to missing required data elements (e.g., account #), a
number that has a character in it and the system cannot convert it
correctly, or a bad date that does not convert. You should rarely see
anything detailed in this field. If you do, run the Rejected Records
report (available in Reports > Reports) or contact info@syntellis.com.

Valid Claim Total Charges Provides the total charges of the claims that were successfully
imported to the Live environment.

# Claims Transferred to
Live

This field indicates howmany of the temp records were imported to
the Live environment. It should be in line with the # of claims read into
temp column (unless records weremoved to bad).
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Field Definition

# Claim Exceptions In some cases, imported claims aremarked as exceptions. Following
are reasons for exception records:

l Trying to insert a series bill over an existing non-series bill claim
l Trying to insert a late charge onto a series bill
l Trying to insert a void over a series
l Trying to insert a non-series bill over an existing series bill
l Invalid Medicare Part B Type of Bill
l Trying to insert a zero payment bill into the system
l Trying to insert over higher charge claim
l Voided Claim
l Invalid Late Charge Bill (Incompatible Bill was imported after this

record)

The second sheet of the import summary report details all the
exceptions from the import, including the Bill ID (Patient Account
Number) linked to the claim in the system. In addition to Bill ID, the
supplementary details include: Batch Number, Import File Name,
Exception Reason, Bill Code, # of Claims, and Total Charges.

# of Claims Grouped Axiom Contract Management groups all outpatient claims into their
corresponding APCs based on the date of the episode of care and its
corresponding version of theMedicare APC schedule.

# of Claims Priced Any Medicare-based outpatient claim will price against the 3M pricer if
factors have been provided to Syntellis and a corresponding
calculation schedule has been built and assigned to the contract
provision. Please email your factors to info@syntellis.com.

# of Claims Calculated This field indicates the number of claims that found a contract and
calculated accordingly.

� Import Summary Report definitions – POSTINGS

Field Definition

Batch Number System assigned # to each import file.

Import File Name Name and import location of file.
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Field Definition

# of Postings Read into
Temp

In Axiom Contract Management, all claims are loaded into a temporary
staging area before they get transferred into the Live environment.
This allows us to run validation processes on the data to ensure the
data is correct. This # should tie to the # of posting records in the
import file.

# of Postings Rejected to
Bad

In cases where the data is bad, the system removes the records
associated with the bad claim and moves them to a separate area for
review by support staff. Reasons vary as to why a posting would be
moved to bad, but most of the time it is related to a missing required
field value, a number that has a character in it and the system cannot
convert it, or a bad date that does not convert. You should rarely see
anything detailed in this field. If you do, please contact
support@KaufmanHall.com.

# of BillIDs Imported Provides the number of unique account numbers in the posting file
being imported.

# ofMatching BillIDs Provides the number ofmatching billIDs found in the Live environment
for the postings being imported.

Total Valid Postings
Amount

Provides a summary of the valid posting records being imported.

NOTE: If any records are rejected to bad, their amounts are not
reflected in the Total Valid Postings Amount.

About problem file processing
When claims and remits are read into the system during the Axiom Contract Management Full Import
job, occasionally problem files occur. Problem files include duplicate files, files with invalid formats, and
files that cannot be read because of structural or other issues.

The system handles them as described in the following sections.

� Duplicate files
The system:

l Date-time stamps and copies the file to a Duplicate file folder under the EVCMA folder location
from which the file is read. If the Duplicate folder does not exist, the system creates it.

l Logs the attempt as a duplicate.
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Duplicate.
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l Updates the import report to show that the file is a duplicate and was skipped.
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Duplicate - Not Imported.

� Invalid format files
The system:

l Date-time stamps and copies the file to an Invalid file folder under the EVCMA folder location from
which the file is read. If the folder does not exist, the system creates it.

l Logs the attempt as an invalid format file
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Invalid Format
l Updates the import report to show that the file is an Invalid Format and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Invalid Type - Not Imported

� Unreadable files
The system:

l Date-time stamps and copies the file to an Unreadable folder under the EVCMA folder location
from which the file is read. If the Unreadable folder does not exist, the system creates it.

l Logs the attempt as an unreadable file
l Inserts the file entry into the TempImportBatches table without a file hash and with a status of

Unreadable
l Updates the import report to show that the file is Unreadable and was skipped
l Within the system under Import Data, in theManage Import Batches table, the Notes column lists

the file as Unreadable - Not Imported

View SQL importer log
The SQL importer log available to administrators provides better visibility into the nightly import process.
The SQL importer log records details about the last import that took place, including any errors, in an
easy-to-view format. Administrators can use this log as a diagnostic tool when errors occur because it is
more descriptive than the Axiom log.

The log records the following:

l SQL Import run ID number
l Task group ID
l Message – A brief description of the activity during each phase of the process
l Log Date/Time
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l Exception – Error and associated information
l Error – Error flag True or False; True indicates an error

To view the SQL Importer log:
In themain menu header, click Admin > SQL Importer log.
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Managing attributes
Attributes are custom tags that allow you to extend contract data models. Attributes allow you to add
information to a contract that exists on the physical contract but for which theremay not be room in the
modeled version.

l Attributes can be applied to claim and line-level reporting to enhance understanding of contracts
and calculation performance.

l Attributes provide a way for you to define, organize, and categorize all levels of a contract model.
l Attributes enhance the reporting and analysis of contract calculations.

Only users who have permissions to model contracts can add attributes to contracts.

As a system administrator, you create and manage system attributes on the Attributes page, accessible
from the Admin menu on themain toolbar.

Overview of Attributes page

Creating attributes
Attributes available to you depend on the contract level you are at when you add the attribute. If you are
adding an attribute at the contract level, the only attributes available to select will be contract type
attributes. This means that when you create attributes, think about what kind of data the attribute

3
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should hold, and at what level of the contract the attribute should be applied.

Only system administrators can create attributes.

� Create an attribute
Use these instructions to create attributes that do not contain libraries (i.e., a selection list).

To create a non-Library data type attribute:
1. In themain menu header, click Admin >Manage Attributes.

2. On the Attributes page, on the upper right, click Create New Record.

3. On the Create New Attribute page, in the Attribute Name field, type a name for the attribute.

4. In the Attribute Description field, type a description for the attribute.

5. From the Attribute Data Type drop-down, select one of the following:

NOTE: You cannot change an attribute’s Data Type after saving the attribute.

l Integer – Creates a field that accepts a number
l Money – Creates a field that accepts dollar and cent amounts
l Decimal – Creates a field that accepts decimal values
l Percent – Creates a numerical field that accepts percentages
l Text – Creates a text field for the user to enter text
l Library – Creates a list from which a user can select values. To create this type of attribute,

see Create a Library attribute.

6. From the Attribute Type drop-down, select which part of a contract the attribute should be
applied to:

NOTE: You cannot change an attribute’s Type after saving the attribute.

l Contract
l Version
l Provision
l Clause/Term

7. (Optional) By default, the attribute is enabled. To disable this attribute after creation, clear the
Enabled check box.

8. If you selected the Library attribute data type, click Save. When the page refreshes, click the Edit
Library button to the right of the grayed out Attribute Data Type field.

9. Do one of the following:
l To save but remain on this page, click Save.
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l To save and exit this page, click Save and Close.
l To save and create another attribute, click Save and New.

� Create a Library attribute
Library data type attributes allow you to create a list users can select from when applying the attribute.

To create a Library data type attribute:
1. In themain menu header, click Admin >Manage Attributes.

2. On the Attributes page, in the upper right, click Create New Record.

3. On the Create New Attribute page, in the Attribute name field, type a name for the attribute.

4. In the Attribute Description field, type a description for the attribute.

5. From the Attribute Data Type drop-down, select Library.

6. From the Attribute Type drop-down, select the contract part the attribute should be applied to.

NOTE: You cannot change an attribute’s Type after saving the attribute.

7. (Optional) By default, the attribute is enabled. To disable this attribute after creation, clear the
Enabled check box.

8. Click Save.

The page refreshes to display the Edit Attribute page with your new attribute in the dialog.

9. Click the Library button.

10. In the Edit Library dialog, click +Add new record.

11. In the Library Value field, enter the first item for the pick list in the field provided, then click Save.
The item is added to the list, and the Save and Cancel buttons are replaced by an Edit and Delete
button set.

12. Repeat step 11 until all the items in the pick list are added.

13. Click the X in the upper right corner to close the dialog.

14. On the Edit Attribute page, click Save and Close to save and exit the page, or click Save and New
to save and then create another attribute.

Edit or delete an attribute
Only System administrators can edit or delete attributes.

Editing includes:
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l Changing attribute names and values,
l Disabling or enabling attributes
l Deleting attributes

NOTE: You cannot change an attribute’s Data Type or Type. However, you can edit pick list entries
for Library data type attributes.

To edit an attribute:
1. In themain menu header, click Admin >Manage Attributes.

2. On the Attributes page, to edit an attribute, click the Edit icon ( ) at the end of the attribute’s

row and then do any of the following:
l To disable the attribute so that it cannot be used, clear the Enabled check box.
l To change the name, in the Attribute Name field, edit the name.
l To change the description, in the Attribute Description field, edit the description.
l To change the pick list selections for a Library data type attribute:

a. To the right of the Attribute Data Type field, click the Library button.
b. To edit an entry, click the Edit button for the entry, make desired changes, and then

click Update.
c. To add a new entry, click Add new record, and then enter a value, then click Save.
d. To delete an entry, click theDelete button for the entry, and then click Delete in the

confirmation dialog.

NOTE: If the library entry you are deleting is currently in use by a contract level, a
warning displays informing you that you need to remove that entry from all
contracts to which it is applied before you can delete it.

e. Close the Edit Library dialog.

3. Click Close.

To delete an attribute:

NOTE: The recommended best practice is to disable an attribute rather than deleting it.

1. Verify that the Enabled column displays an empty circle icon: ( ). If it does not, then click the

Edit button and clear the Enabled check box, then save the attribute.

2. Verify that the attribute is not currently attached to any contract level.

3. At the end of the attribute’s row, click theDelete icon ( ).

4. In theDelete confirmation dialog, click Delete.

5. Click Save.
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Managing insurance plan codes
As an administrator, you can manage insurance plan codes in your Axiom Contract Management
systems. Managing codes include creating new codes, searching for existing codes, and adding codes to
contracts.

Insurance plan codes are assigned to contract versions to determine which payers and procedures on
incoming claims apply to that version. New codes coming in on claims are automatically added to the
OrgCode PayerCode library. However, the new code will not cause the claim to trigger a contract until the
code is added to a contract version. As an administrator, you can assign a new insurance plan code to a
contract as soon as you become aware of it so that incoming claims calculate upon import instead of
waiting until the new payer code is assigned. Then, when the new code imports from a claim or an
AddPayer file, it is recognized as existing and not duplicated.

On the Insurance Plan Codes page, you can do the following:

l Add a new insurance plan code to the system
l Search for existing insurance plan codes using a variety of criteria

Create an insurance plan code
Use these instructions to add a new insurance plan code to your system if you know the payer code and
the associated organization.

To create a new insurance plan code:
1. In themain menu header, click Admin >Manage Insurance Plan Codes.

2. On the Insurance Plan Codes page, in the upper right, click Create New Payer Code.

4
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3. On the Create New Payer Code page, from theOrganization drop-down, select the applicable
organization.

4. In the Payer Code field, enter the code for the payer.

5. In the Payer Description field, type a description for the payer.

6. Do one of the following:
l To save and close the page, click Save and Close.
l To save the new code and continue working on the page, click Save.

NOTE: If you see a red line across the bottom of the page when you save, it means that payer
code is already in use in the system. You will need to use a different payer code.

The new code is now available for assigning to a version.

NOTE: Currently there is no delete function for removing an insurance plan code from the system. If
you create a code in error, assign it to a dummy contract to remove it from the available code listing.

Search for an existing insurance plan code
If you do not see the insurance plan code you want to use in a selection menu, you can search for the
code to see if it exists. You can search on the following main parameters:

l Org code
l Organization
l Payer code
l Payer description

To search for an insurance plan code:
1. Navigate to the Insurance Plan Codes page:
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l From the Admin menu, selectManage Insurance Plan Codes.
l From the Edit Versionwindow, in the Insurance Plan codes tab, click the Search icon ( ).

2. On the Insurance Plan Codes page, in the header of the column to search on, click the filter icon (
) at the right end of the column.

3. In the filter dialog, select the criteria to search on, and then click Filter.

The list is filtered to items that fit your search parameters.

4. If your search returned no results, try broadening the search criteria; for example, instead of “Is
equal to” try selecting “contains.”

5. To clear the search, click the filter icon again, and in the search dialog, click Clear.

6. If you have verified that the insurance plan code is not in the system, you can add it if you have
administrative rights.

Map provider names to Org codes
Contract Management administrators can manage provider namemappings to organizational codes
using the Provider Org CodeMapping feature.

When a claim enters the system, the provider name on it is checked against the existing list of names. If
the name is different in any way from the names already in the list (for example, spelling or word order),
it is added to the list. Administrators can then map the new provider names or the name variances to the
correct Org codes.

By default, new provider names come in with the default code. You can select the desired name from the
Org Code drop-down or, if needed, you can create a newOrg code.
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To map a provider name to an Org code:
1. In themain menu header, from the Admin menu, select Provider Org Code Mapping.

2. Locate the provider name in the list on the left. Names are listed in alphabetical order.

3. In theOrg Code column, from the Org code drop-down for the corresponding provider name,
select the desired Org code. The change is saved automatically. If the needed Org code does not
exist, you can add it using the following instructions.

4. To propagate the provider name and Org code association to existing claims, recalculate the
claims.

To add a new Org code:
1. In themain menu header, from the Admin menu, select Provider Org Code Mapping.

2. In the Add New Org Code section, in theOrg Code field, type the number to associate with the
Org code.

3. In theDescription field, type the Org code description.

4. Click Save.
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Modeling contracts
Axiom Contract Management stores contract terms, patient claims, and payment information. The
system uses the contract payment terms and the patient claim information to calculate an expected
payment for every claim submitted by the provider. After the claim is paid by the primary payer, it can be
compared to the expected payment and/or the expected contractual to see if the claim was reimbursed
according to the agreed upon contract terms.

Navigating in contracts
Contract pages in Axiom Contract Management are laid out in a simulation-to-term hierarchy, with the
simulation name at the highest level, and terms (unless the final clause has no terms) at themost
granular:

l Simulation >
o Contract >

o Versions >
o Provisions >

o Clauses >
o Terms

Drill through each level to reach the one below it. As you move through the contract levels, breadcrumbs
display at the top of the page.

To navigate to different contract levels:
l To navigate to versions, from the Contracts page, for the desired contract, hover your cursor in

the contract row, and then click Go to Versions.

l To navigate to provisions, from the Versions page, for the desired version, click Go to Provisions.
l To navigate to clauses, from the Provisions page, for the desired provision, click Go to Clauses.
l To navigate to terms, from the Clauses page, for the desired clause, click Go to Terms.

5
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l On the Terms page, or any page in between, you can backtrack to previous pages using the linked
breadcrumbs at the top of the page. Click the link to go back to the desired page.

When you backtrack, the page you backtracked from is removed from the breadcrumb trail.

Searching lists and filtering contract columns
Along with improved navigation, the updated UI for contract pages and dialogs provides new sort and
filter functionality for contract table grids, and search functionality for some dialog fields.

Many contract grid columns can be sorted and filtered. In most contract dialogs, if a drop-down field has
a long list of entries, you can search the list.

To sort and filter table columns:
1. To sort a column, click the header. A sort up ( ) or sort down arrow ( ) displays in the column

header if the column can be sorted.

2. To filter a column:
a. In the column header, click the filter icon ( ).

b. In the filter dialog, from the first drop-down, select the parameter to use, and then type the
word into the field provided. If desired, add another filter parameter.

c. Click Filter. The list filters to display results that meet the filter parameters.

d. To clear the filter, click the icon again and then, in the filter dialog, click Clear.

To search a long list of entries in a dialog drop-down field:
1. Click the drop-down, and then start typing a search word or letter.

2. The list changes to begin with the search word or letter. A small red triangle displays at the upper
left corner of the field to show that the entry has changed. Select the desired option from the list.
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Contract data requirements
For expected payments to bemodeled accurately, the contract terms must be entered correctly in Axiom
Contract Management. To accomplish this, you need a thorough understanding of the contract
language and terms as well as access to electronic fee schedules, and any other data relevant to building
a model of the signed contract. For Medicare-based contracts, you need hospital-specific factors
provided to the hospital by either the Fiscal Intermediary (FI) or by CMS directly. Often this requires
direct contact with the payer representative.

You then need to interpret these terms into Axiom Contract Management, with the understanding that
Axiom Contract Management uses specific logic to calculate a claim. This logic is discussed in the rest of
this section on building contracts.

Filter contracts on the Contracts page
You can filter the list of contracts on themain Contracts page by contract name or by the latest
expiration date.

To filter contracts:
1. If the desired simulation is not currently selected, select it from the simulation drop-down:
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2. In the Contract Name column header on the right, click the Filter icon ( ).

NOTE: To filter by expiration date, click the filter icon in the Latest Expiration Data column
header.

3. In the filter dialog, from the drop-down, select the desired filter criteria. The default criteria is
“Contains.”

4. In the input field, type the item on which to search. For example, if you selected Contains as the
criteria, type the word or phrase contained in the contract name you are searching for.

5. Click Filter.

The filtered list displays contract names based on the criteria you specified.

6. To clear the filter, click the Filter icon again, and then click Clear.

Add a new contract
The following instructions are for creating a new contract from scratch.
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To add a contract:
1. On the Contracts page, verify that you are in the correct simulation. If you are not, then from the

simulation drop-down, select the desired simulation.

2. Under the Contracts page title, click Add a New Contract.

NOTE: The Add a NewContract option is displayed only if you have administrative access.

3. In the Add a New Contract dialog, in the Contract Name field, type a name for the contract (e.g.,
Medicare Blue Cross). Do not use special characters.

4. Click Save.

NOTE: You do not need to enter the latest expiration date because that is defined by the
versions built under the contract.

5. (Optional) If desired, add an attribute to the contract.

6. Next, add a version to the contract.

Edit or delete a contract
Use these instructions to change contract settings at the contract level. You can make the following
changes:

l Change a contract name
l Change attribute values
l Delete a contract

To edit a contract:
1. Navigate to the contract.

2. At the end of the contract row, click the Edit icon ( ).

3. In the Edit Contract dialog, do any of the following:
l To change the contract name, in the Settings tab, in the Contract Name field, type the new

name.
l To change the contract’s attribute values, in the Attributes tab, make the desired changes

to the listed attributes. For more information, see Edit or remove an attribute from a
contract.

l To import attributes, see Import an attribute to a contract.

4. Click Save.
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To delete a contract:
1. Verify that the contract and its versions are not being used or do not need to be retained as

records; for example, if you created a duplicate contract by mistake and want to delete it.

2. At the end of the contract’s row, click the Delete icon ( ).

3. In the confirmation dialog, click Delete.

Assign an insurance plan code to a version
For a claim to calculate on a contract, Axiom Contract Management must knowwhich payers calculate
against the version. Use these instructions to assign an insurance plan code to a contract version or to
change the assigned code.

1. Navigate to the contract version.

2. At the end of the version row, hover your cursor and then click the Edit icon ( ).

3. In the Edit Version dialog, click the Insurance Plan Codes tab.

4. Do one of the following:
l Import insurance plan codes from another version.
l Continue to step 5 to add codes from the list of unassigned codes.

5. In theUnassigned list, select the insurance plan codes (org code - payer code combinations) to
add to the version by clicking the Assign icon ( ) on the right end of the row, as shown in the

following example.
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l If there aremultiple organizations, then before selecting codes, click the Viewing drop-
down and select the organization from which to select codes.

NOTE: You can assign codes from multiple organizations, but the list is filtered by
organization. Before saving, change the organization to add more codes.

l If you cannot locate the desired insurance plan code, search for it in the system: at the top
right of the Edit Version dialog, click the search icon, as shown in the following example,
and then search for the desired code.

NOTE: Administrators can add new insurance plan codes to the system. For more
information, seeManaging insurance plan codes.

6. When finished adding codes, click Save.

Checked circle indicates this version has assigned insurance plan codes

7. If you are building a contract, the next step is to add a provision.

Copying contracts
After a set of contracts is built into Axiom Contract Management, you can use the contract parts as the
basis for new contracts. You have a number of options when copying contracts:

l Copy a version to the same or different contract
l Copy a version to a different contract (using the import version feature)
l Copy a version from a file (using the import file feature)
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l Copy a provision to the same version
l Copy a provision to a different version in the same or different contract
l Copy a clause or a term

Modeling versions
A version is a defined time frame during which the contract as a whole is valid and the terms are
consistent. It can represent the fiscal year, the calendar year, or some other defined period. In the Axiom
Contract Management contract hierarchy, versions reside directly under contracts but above provisions.

Add a version
After creating a contract, the next step is adding a version. Instead of names, versions are identified by
their active period, which is the time frame defined by their start and expiration dates. Versions are
assigned numbers that correlate to the version’s original start and expiration date period. Generally, the
older a version, the lower the number used to identify it. So, for example, version 1would be older than
version 2, and so on.

Use these instructions to add a new version to a contract. You can also copy a version by importing it
from another contract, or you can import a version from an external file.

To add a new version:
1. On the Contracts page, hover your cursor over the desired contract row to view theGo to

Versions link, then click the link.

TIP: If the list of contracts is long, find the desired contract by filtering the list.

2. On the Versions page, click Add a New Version.

3. In the Add a New Version dialog, in the Start Date field, type in the date or click the calendar icon
( ) and select the date on which the version takes affect.

� About Start Date / Expiration Date
In Axiom Contract Management, a version represents a defined time frame for the contract. The
time frame used can be from the time period on a certain contract where the terms remain
consistent. It can represent the fiscal year, or it can represent the calendar year. To minimize the
number of contracts built, we recommend that you build versions defined by contract periods
where terms remain unaltered.

4. In the Expiration Date field, type in the date or click the calendar icon ( ) and select the date on
which the version’s active period ends.
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5. In the Calculation Date field, select the calculation date for the version—either the date of
discharge or the date of admission.

� About Contract Calculation Date
You have two options when calculating claims: you can choose to calculate them by the date they
were admitted (Admit), or by the discharge date (Discharge).

The one you use depends on the payer, which you should confirm with them. The default is by
discharge date.

6. Click Save.

7. (Optional) If desired, add an attribute to the version.

8. (Optional) If desired, attach a document to the version.

9. Next, assign an insurance plan code to the version.

10. Add a provision to the version.

Assign an insurance plan code to a version
For a claim to calculate on a contract, Axiom Contract Management must knowwhich payers calculate
against the version. Use these instructions to assign an insurance plan code to a contract version or to
change the assigned code.

1. Navigate to the contract version.

2. At the end of the version row, hover your cursor and then click the Edit icon ( ).

3. In the Edit Version dialog, click the Insurance Plan Codes tab.

4. Do one of the following:
l Import insurance plan codes from another version.
l Continue to step 5 to add codes from the list of unassigned codes.

5. In theUnassigned list, select the insurance plan codes (org code - payer code combinations) to
add to the version by clicking the Assign icon ( ) on the right end of the row, as shown in the

following example.
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l If there aremultiple organizations, then before selecting codes, click the Viewing drop-
down and select the organization from which to select codes.

NOTE: You can assign codes from multiple organizations, but the list is filtered by
organization. Before saving, change the organization to add more codes.

l If you cannot locate the desired insurance plan code, search for it in the system: at the top
right of the Edit Version dialog, click the search icon, as shown in the following example,
and then search for the desired code.

NOTE: Administrators can add new insurance plan codes to the system. For more
information, seeManaging insurance plan codes.

6. When finished adding codes, click Save.
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Checked circle indicates this version has assigned insurance plan codes

7. If you are building a contract, the next step is to add a provision.

Import insurance plan codes to a version
When creating or editing a contract version, you can import insurance plan codes from another version.
The import feature imports copies of the insurance plan codes.

To import insurance plan codes to a version:
1. Navigate to the version to which you want to add codes.

2. At the end of the version row, hover your cursor and click the Edit icon ( ).

3. In the Edit Version dialog, click the Insurance Plan Codes tab.

4. In the lower half of the dialog, click the Import tab.

5. In the list of contracts, locate and expand the version that has the codes you want. To import a
code, click the arrow icon at the end of the code row, as shown in the following example:

The code is copied to the Assigned section of the dialog.

6. Click Save
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NOTE: If you copy a code you do not want, before saving, you can remove it by clicking
Remove icon ( ). To remove after saving, from the Assigned section, click the Unassign icon (
) for that code.

Remove an insurance plan code from a version
Use these instructions to remove an assigned insurance plan code from a contract version.

To remove an insurance plan code:
1. Navigate to the contract version.

2. At the end of the version row, click the Edit icon ( ).

3. In the Edit Version dialog, click the Insurance Plan Codes tab.

4. In the Assigned section of the dialog, for the code to remove, at the end of the code row, click the
Unassign icon ( ).

5. Click Save.

Edit or delete a version
After copying or importing a version from another contract, you may want to make some changes to it.
You can do the following:

l Change the start/expiration dates
l Change the calculation basis
l Add or remove insurance plan codes
l Add or remove attributes or change attribute values
l Add documents or remove attached documents

You can also delete a version if it is not in use and does not contain historical data that needs to be
preserved.
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To edit a version:
1. Navigate to the contract and then click Go to Versions.

2. At the end of the desired version row, click the Edit icon ( ).

3. In the Edit Version dialog, do any of the following as needed:
l To change the Start Date or Expiration Date, in the Settings tab, type in the dates, or click

the Calendar icon ( ) and select the desired dates.

NOTE: You cannot change the dates to any time period that would cause an overlap
with another version on the contract. Also, if any provisions are attached to this
version, you cannot change the version time frame to be inside of the provision time
frames.

l To change whether the calculation is based on the discharge or admit date, in the Settings
tab, in the Calculation Date field, select the desired option.

l Add or remove an assigned insurance plan code.
l Add, edit, or remove attributes.
l Attach or remove a document.

4. Click Save.

To delete a version:
1. Navigate to the version.

2. Verify that the version and its provision, clauses, terms, etc., are not in use and do not contain
data that needs to be preserved as records.

3. At the end of the version row, click the Delete icon ( ).

4. In the conformation dialog, click Delete.
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Copy a version
Use these instructions to copy a version to the same contract. To copy a version to a different contract,
use the Import Version feature.

To copy a version:
1. Navigate to the version to be copied.

2. At the end of the version row, hover your cursor and click the Clone icon ( ).

3. In the Clone Version dialog, on the Settings tab, note that the Start Date and the Expiration Date
have been set one year ahead of the Start and Expiration dates of themost recent previous
version in the version list (not necessarily the one you copied). You can change these dates from
the Edit Version dialog if needed; however, if the changed dates conflict with any provisions that
were copied over with the version, a conflict message displays in the dialog, as shown in the
following example:

4. By default, any provisions, insurance plan codes, attributes, and attached documents are
included in the copy. However, if you do not want to copy everything, clear the check boxes for
the items that you do not want included in the copy.

Administrator's Guide Axiom Contract Management │ 61



NOTE: You cannot make changes to the other tabs in the Clone Version dialog. Save the
version and then make changes in the Edit Version dialog.

5. Click Save.

6. (Optional) Edit the version.

Import a version from a contract
Use these instructions to import a copy of a version from another contract. You can also import a version
from a file.

To import a version from one contract to another:
1. Navigate to the contract needing the version.

2. In the contract row, click Go to Versions.
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3. On the Versions page, click the Import Version icon ( ) and select Import from another

contract.

4. In the Import a New Version dialog, if you need to switch to a different simulation, then from the
Simulation drop-down, select the simulation.

5. In the Select a version to import section, expand the listed contract that contains the desired
version to copy, and then click the version row. The row does not stay selected, but the name of
the selected row displays at the bottom left of the dialog.

6. By default, the check boxes to include any provisions, insurance plan codes, attributes, or
documents attached to the version, are selected. Clear the check boxes for those items that you
do not want to include.
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7. Click Import.

8. (Optional) If desired, add an attribute to the version.

9. (Optional) If desired, attach a document to the version.

10. If needed, assign an insurance plan code to the version.

Import a version from a file
Use these instructions to import a copy of a version from a file. You can also import a copy of a version
from another contract.

Administrator's Guide Axiom Contract Management │ 64



To import a version from a file:
1. Navigate to the contract that needs the version.

2. In the contract row, click Go to Versions.

3. On the Versions page, click the Import Version icon ( ) and select Import from a file.

4. In the Import a New Version dialog, in the Select a version file to import list, do any of the
following:

l To view the version file before importing it, click the Download icon ( ) for the version,

and then click the downloaded file to view it. (The file downloads in .xml format.)
l To select a version file, click it.
l If the version file you want is not listed, upload the file:

a. In theUpload a file to the list section, do one of the following:
o Drag and drop a version .xml file to the gray area marked Drop files here to

upload.
o Click Select files and select a file to upload.

b. Click Upload.
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c. Locate the uploaded file in the list and select it.

5. Click Import.

6. If desired, edit the version.

Export a version
Export a version when you want to create an importable file of the version or if you want to create a
backup.

IMPORTANT: Export/Import Provisions is not a preferred tool to copy contracts into Live. It should
be done as a time-saving safety net in case a contract is irreversibly altered incorrectly.

We recommend that you maintain your own contract backups in case of an irreversible error. You can
create backups using the Export Version feature.

To export a version:
1. On the Contracts page, navigate to the desired contract version.

2. At the end of the version row, click the Export icon ( ).

3. In the Export Version dialog, type a name for the exported version file or leave the default.
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4. Click Export.

The exported version file will be available in the Import Version dialog when you select to import a
version from a file.

Attaching supporting documents to a contract
NOTE: This topic applies to supporting documents attached to versions. Other file types such as rate
files, fee schedules, translation tables, thresholds, and adjustments are added to contracts at the
clause or term level. For information on managing these files, see Using Rates.

When modeling contracts, you may need to attach documents to support the contract. You attach these
kinds of files to contracts at the version level. You can attach files such as images, PDFs, Excel
worksheets, or any other document supporting the contract. Users can download, open and view the
documents as long as they have access rights to do so. Keep in mind that to view attached files, users
must also have an application installed that can read the file type. Only system administrators can delete
documents from contract versions.

Versions with attached files display a circle with check mark icon ( ) in their Attached Docs column.

Upload a document to a contract version
Use this method to attach an external file to a contract version. You can also import a copy of a
document attached to another contract.
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To attach a file to a contract:
1. Navigate to the desired contract version.

2. At the end of the version row, click the Edit icon:

3. In the Edit Version dialog, click theDocuments tab.

4. In theUpload a document tab, do one of the following:

l Click Select files, and then navigate to and select the desired document.
l Drag and drop a document file into the shaded area that reads “Drop files here to upload.”

5. When you see the document listed in the dialog, click Attach.

6. Click Save. When you open the Edit Version dialog again, the uploaded document is listed in the
Attached Docs section of the Documents tab.

Copy an attached document to another version
Use these instructions to copy a file attached to one version of a contract to another version of the same
or different contract.

You can download, open and view the documents as long as you have access rights to do so.
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NOTE: To view attached files, you must have an application that can read the file type installed on
your computer. Keep this in mind when attaching files.

To copy an attached file from one version to another:
1. Navigate to the contract version to add a file to.

2. At the end of the version row, click the Edit icon:

3. In the Edit Version dialog, click theDocuments tab.

4. In the lower half of the tab, click the Copy a document tab.

5. In the list of contracts, expand the desired contract name and version that contains the file to
copy.

6. Do one of the following:
l To copy all documents attached to the source version, click the up arrow icon ( ) at the

end of the version row.
l To copy selected documents attached to the version, click the up arrow icon(s) for the

desired document(s).

7. Click Save. When you open the Edit Version dialog again, the copied documents are listed in the
Attached Docs section.
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View a file attached to a version
When calculations are off, or there is a discrepancy in the contract data, it may be helpful to view the
actual contract to compare it against themodeled one. If the actual contract is attached to themodeled
contract as a file or files, you can view it as long as you have permissions to view attached files.

NOTE: If you do not have the application required for viewing the document installed on your
computer, you will not be able to open and view the file.

To view an attached contract file:
1. Navigate to the contract version with the attached document.

2. At the end of the version row, click the Edit icon ( )

3. In the Edit Version dialog, click theDocuments tab.

4. In the Attached documents section, locate the document to view and then click the download
icon ( ) at the end of the row. A copy of the document downloads to the bottom of your screen.

5. Click the document file to open and view the document.

Delete a file attached to a version
System administrators can delete files attached to contract versions.

To delete a file attached to a version:
1. Navigate to the contract version.

2. At the end of the version row, click the Edit icon ( ).

3. In the Edit Version dialog, click theDocuments tab.

4. In the Attached Docs section, for the desired document, click the Delete icon ( ) at the end of the

row.

Modeling provisions
A provision defines the type of bill for which services are provided: Inpatient, Outpatient, Skilled Nursing,
etc. As a component of the version, multiple provisions may exist within a version to differentiate
contract rates for a given timeframe.
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Add a provision
You can add a provision to a contract by creating a new one, by copying and editing an existing one, or
by importing one. Use the following instructions to create a new provision.

TIP: Use this option when there is no similar provision to copy or import.

To create a new provision:
1. Navigate to the desired contract version.

2. In the desired version row, click Go to Provisions.

3. On the Provisions page above the table of provisions, click Add a New Provision.

4. In the Add a New Provision dialog, the Start Date and Expiration Date of the provision are
automatically set to match that of the version the provision is under. If you need to change the
dates, type in new dates or click the calendar icon ( ) and select the dates.

5. Click the Type of Bill tab.

Use this tab to select the Type of Bills that should calculate under the provision. For example, if
both the inpatient and outpatient contracts pay 75% of charge, you can create one contract
provision to handle both bill types. The provision’s purpose is to select the bill types that calculate
similarly under a specific date range.

6. In the Available section of the tab, click the plus icon to the left of the desired Type of Bill to
expand its codes, then select the bill codes to apply by clicking the Assign icon ( ) at the end of

the row for each desired bill code.
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NOTE: You cannot add attributes to the provision until you save it.

7. Click Save.

8. (Optional) If desired, add an attribute to the provision.

9. (Optional) If needed, add a schedule to the provision.

10. (Optional) If needed, add a modifier to the provision.

11. (Optional) If needed, add a global limit to the provision.

12. If needed, enter provision factors manually or import factors from a file or other provision.

13. Next, add a clause to the provision.

About bill types
The bill type, or Type of Bill (TOB), is a three-digit numeric code on a claim that identifies the specific type
of bill being sent to the payer. The first digit represents Type of Facility (Hospital, Skilled Nursing, etc.),
the second digit represents the Bill Classification (Inpatient, Outpatient, etc.), and the third digit
represents the Frequency (Admit/Discharge, Late Charges, Series, etc.).

The TOB submitted on the claim is important not only for determining the provision on which the claim
will calculate, but also for how the claim is handled during import. For every patient account, the
importing logic first checks whether the account already exists in the system. If it does, the system
applies a series of logical statements and the instance of the claim is brought in as Active, an Exception,
or a Voided Record. All claims are brought in as the Active claim if no other instance of the claim exists,
and as long as the claim is not a Late Charge (e.g., TOB XX5) or a Voided Record (i.e., TOB XX8).
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A Late Charge is always brought into the system as an Exception Record. If an active record exists for that
patient account, the late charge is attached to the active claim and the line items from the late charge are
appended to the active record. If no active record exists, the late charge claim sits idle as an Exception
until an active record is brought in for that particular account number. At that time, it appends to the
newly imported active claim.

Series TOBs (e.g., XX2, XX3 and XX4) are handled differently. If a Series Start bill (e.g., XX2) already exists
in the system and another is imported, the imported one becomes the newActive claim and the
previous instance is considered Replaced. The same applies to a Series End TOB (e.g., XX4). Multiple
Series Interim bills can exist on a claim; however, if an XX3 comes in and has the same admit and
discharge dates as a previous XX3 as well as the same total charges, it will replace thematching instance.

The standard Admit/Discharge claim (e.g., XX1) always comes in as active, and replaces the existing active
record as long as the charges are equal to or greater than the current record. The claim comes in as an
Exception if total charges are less than the existing claim. A Replacement claim (e.g., XX7) always replaces
the existing active record no matter what the total charges are for the claim, and regardless of whether or
not there are late charges appended to the current record.

Replacement and Late Charge claims are not allowed with Series claims. Both come in as Exception
records if a series TOB exists on the account. The reverse is true as well: Series claims are not allowed on
non-series accounts.

About provision factors
Provision factors are used in various CMS calculations. Certain factors, along with other contract rules
related to modifiers, are required for APC and eAPG contracts.

Some of the factors are considered National Factors (e.g., Labor Related Standard Amount, Federal
Capital Rate, etc.), which means that they are the same across the nation. Some factors are Hospital
Specific and can only be answered by the hospital’s Medicare Specialist to whom notices are sent when
the factors are changed, or when a new fiscal year begins and all factors have changed. Any field labeled
“Release” cannot receive a manual entry; instead, it will be updated when rates are attached to the
clause or term.

To use any CMS-related calculation basis (e.g., CMS DRG, CMS Psych, CMS CMG, or Schedules related to
CMS), you must complete the factor forms. You can add the following types of provision factors:

l CMS DRG – Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient services that are paid using a code called a DRG.

l CMS CMG – Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient Rehab services.

l CMS Psych – Add hospital and federal values specific to the date of the provision. Used in the
calculation of inpatient Psych services.
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l Schedules – Select 3M schedules for outpatient services that are paid with APC or eAPG. These
schedules contain the hospital-specific and federal values appropriate for the date range of the
provision.

l Modifiers – Enter modifier values used in line-level calculations within the provision. Lines with
modifier codes are calculated using these values. Four functions are allowed with modifiers:
addition, subtraction, multiplication, and division.

For instructions on adding CMS factors to provisions, see the following:
l Manually enter CMS DRG provision factors
l Manually enter CMS CMG provision factors
l Manually enter CMS Psych provision factors
l Import and export provision factors

Manually enter CMS DRG provision factors

Use these instructions to add CMS DRG provision factors used when calculating Medicare Inpatient
services.

To add CMS DRG factors to a provision:
1. Navigate to the desired provision.

2. On the Provisions page, in the CMS DRG column for the desired provision, click the Edit icon (

).

3. In the Edit Factors dialog, in the Settings tab, enter amounts in the fields provided, as needed.

NOTE: Fields with names in blue indicate they are required for calculated payment. Fields with
names preceded by a red percent sign (%) require you to enter the percentage amounts as
decimals.

4. If needed, assign transfer codes:
a. Click the Transfer Codes tab.

b. In the Available Codes section, locate the desired code in the list.

c. On the right end of the list, click the Assign icon ( ) to move the selected code to the

Assigned Transfer Codes section.

5. Click Save.

6. If needed, add outlier exclusions.

Manually enter CMS CMG provision factors

Use these instructions to add CMS CMG provision factors used when calculating inpatient rehab services.

You can also import provision factors.
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To add CMS CMG factors to a provision:
1. Navigate to the desired provision.

2. On the Provisions page, in the CMS CMG column for the desired provision, click the Edit icon (

).

3. In the Edit Factors dialog, in the Settings tab, enter amounts in the fields provided, as needed.

NOTE: Fields with names in blue indicate they are required for calculated payment. Fields with
names preceded by a red percent sign (%) require you to enter the percentage amounts as
decimals.

4. If needed, assign transfer codes:
a. Click the Transfer Codes tab.

b. In the Available Codes section, locate the desired code in the list.

c. On the right end of the list, click the Assign icon ( ) to move the selected code to the

Assigned Transfer Codes section.

5. Click Save.

Manually enter CMS Psych provision factors

Use these instructions to add CMS Psych provision factors used when calculating Inpatient psych
services.

NOTE: Before adding a CMS Psych provision factor, the provision must have a completed CMS DRG
with a DRG Release named in the DRG Release field. The DRG Release comes from the DRGWeight file
uploaded at the clause/term level.

To add CMS Psych factors to a provision:
1. Navigate to the desired provision.

2. On the Provisions page, in the CMS Psych column for the desired provision, click the Edit icon (
).

3. In the Edit Factors dialog, do one of the following:
l Import CMS psych factors from another provision or a file.
l In the Settings tab, enter amounts in the fields provided, as needed.

4. To add ECT codes, do the following:
a. Click the ECT Codes tab.

b. In the Available Codes section, to add a code, click the code’s up Assign icon ( ). The code

displays in the Assigned ECT Codes section.
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5. Click Save.

Select outlier exclusions

� About modeling changes to the inpatient CMS DRG calculation
To accurately model changes made to the Inpatient CMS DRG calculation, you may need to determine
the high-dollar outlier exclusion amount. To exclude high-dollar charges like transplant acquisition
charges or coagulation factors from the CMS DRG outlier determination, you can specify the Line Item
Codes or Rev Codes associated with these charges to exclude them from the outlier determination within
the CMS DRG calculation. Use the Exclusions tab when defining a provision for Medicare and Medicare-
like contracts.

After selecting the exclusions, you add a clause or term with the CMS DRG calc basis, and then attach
DRGs and other required DRG-related elements. When incoming claims are processed against the CMS
DRG calculation, if a claim has any CMS DRG items that match the clause or term on the provision, the
system inspects the lines on the claim for the selected exclusion codes. The system totals any claim items
that match the exclusion codes and then subtracts this amount from the total charges when determining
the outlier portion of the CMS DRG calculation.

To specify outlier exclusions:
1. Navigate to the desired provision.

2. On the Provisions page, in the CMS DRG column for the desired provision, click the Edit icon (

).

3. In the Edit Factors dialog, click theOutlier Exclusions tab.

4. At the top of the tab, select the exclude option:
l Rev Code – Select exclusion items by revenue code.
l Line Item Code – Select exclusion items by line item code.
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5. In the lower half of the tab, locate the item(s) to exclude, and then click the Assign icon ( ) to the

right of each item to move that item to the top half of the tab.

6. Click Save.

Import and export provision factors

When copying or creating contract provisions, you can import CMS DRG, CMS CMG, or CMS Psych
factors from a file or from another provision instead of populating the factors fields manually.
Additionally, you can export factors to an Excel file.

� Import provision factors from another provision
To import provision factors from another provision:

1. Navigate to the provision needing factors.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Edit Factors dialog, click the Import tab.

4. In the Import tab, do the following:
a. If needed, from the Simulation drop-down, select the desired simulation.

b. Expand the contract and version with the desired provision and factors.
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c. In the Provision list, for the desired provision, click the import factors icon ( ).

The Factors dialog opens, displaying the imported factors.

5. In the Factors dialog, click Save.

� Import provision factors from a file

NOTE: Excel files used to import factors need to adhere to a specific format. To ensure your file is
formatted correctly, download the template and enter or copy the desired factor information to it,
then save and import it using the following instructions.

To import provision factors from a file:
1. Navigate to the provision needing factors.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Edit Factors dialog, click the Import tab.

4. In the Import tab, do the following:
a. Click the Import From File tab.

NOTE: The imported factors file must adhere to the factors template.

b. If needed, on the right side of the dialog just above the Import button, click the download
icon ( ) to download the template. Complete the information in the template, then

name and save it. Or, you can import factors that you exported from another provision to
an Excel file provided the file matches the factors template layout.

c. On the left of the dialog, do one of the following:
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l Click Select files... and then select a file or files to import.
l Drag and drop the desired files to the gray area marked Drop files here to upload.

d. Click Save.

The factors display in the corresponding CMS tabs for the type(s) of factor(s) imported.

5. In the Factors dialog, click Save.

� Export provision factors to an Excel file
To export provision factors:

1. Navigate to the provision with the factors to export.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Factors dialog, at the bottom, click Export.

The data is exported to an Excel file at the bottom of your screen. Data is exported from all three
CMS tabs. If no data exists for a particular column, then in the Excel file, that tab displays with
headings only but no data. The file is automatically formatted correctly for importing to another
provision.

4. If desired, click the file to open and view it.

Edit or delete provision factors

You can edit provision factors manually in the Factors dialog, or you can export the factors to a file, edit
the file, and then re-import the file.

To manually edit provision factors:
1. Navigate to the desired provision.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Edit Factors dialog, make changes as needed to the desired fields.

4. Click Save.
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To delete provision factors:

IMPORTANT: This option deletes all saved settings and any outlier exclusions and transfer codes in
addition to the factors.

1. Navigate to the desired provision.

2. In the factor type column (e.g., DRG, CMG, Psych), click the Edit icon ( ).

3. In the Edit Factors dialog, at the bottom, click Delete.

4. In the confirmation dialog, click Delete.

Add a modifier to a provision
Modifiers are used for line-level calculations within a provision. Lines with modifier codes are calculated
using modifier values. Four functions are allowed with modifiers: addition, subtraction, multiplication,
and division.

Use these instructions to add a modifier to a provision.

To add a modifier to a provision:
1. Navigate to the desired provision.

2. In theModifiers column for the provision, click the Edit icon ( ).

3. In the Edit Modifiers dialog, in the Available Codes section, locate the desired code and then click
the Assign icon ( ) to move it to the Assigned Modifiers section.
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4. In the Assigned Modifiers section, in the Sign column, select the desired operator from the drop-
down.

5. In the Value column, use the up and down arrows in the field to set the value.

6. Click Save.

Assign a schedule to a provision
Use these instructions to assign a schedule to a contract provision. A schedule is a reference from the 3M
Grouper that is used for calculating outpatient APCs and eAPGs for a variety of contracts. Schedules are
required when you model contracts having APC or eAPG reimbursement for outpatient services.

To assign a schedule to a provision:
1. Navigate to the desired provision.

2. In the Schedule column for the provision, click the Edit icon ( ).

3. In the Edit Schedule dialog, from the Select a Reimbursement Type drop-down, select the kind of
reimbursement the provision uses. This selection determines the schedules available in the next
drop-down.

4. From the Select a Schedule drop-down, select the desired schedule.

5. Click Save.

Copy a provision
If an existing contract is similar to the one you are working on and needs only slight modifications, you
can copy that provision instead of re-building it from scratch, then edit the copy. Use the following
instructions to copy a provision within a version. To copy a provision from a different version, use the
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Import Provision feature.

To copy a provision within the same version:
1. Navigate to the provision to be copied.

2. At the end of the provision row, click the Clone icon ( ).

3. In the Clone Provision dialog, in the Settings tab, type in dates or click the calendar icons ( ) and

select a Start Date and Expiration Date for the provision.

NOTE: The system will not allow you to select dates that are outside of the associated
version’s active period. You also cannot create a provision with dates that overlap another
provision that has the same bill type.

4. By default, any attributes are included in the copy. However, if you do not want to copy them,
clear the Include Attributes check box before saving. You can add other attributes after you save
the new provision.

NOTE: You cannot add or remove bill types from the Clone Provision dialog. You must save
the copy and then make changes through the Edit Provision dialog.

5. Click Save.

6. (Optional) Edit the provision as desired.
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Import a provision
Use these instructions to copy a provision from one contract to another. The Import Provisions feature
allows you to bring in provisions from a contract in any simulation.

To import a provision:
1. Navigate to the desired contract version.

2. In the version row after the version number, click Go to Provisions.

3. On the Provisions page, note the date range of the version displayed at the top of the page. The
provision you select to copy must fall within that date range. If it does not, you can change the
date range on the copy before importing it.

4. On the Provisions page above the table of provisions, place your cursor over the arrow, and then
click Import from another contract.

5. In the Import a New Provision dialog, from the Simulation drop-down, select the simulation
containing the provision you want to copy.

6. In the Select a provision to import list of contracts, expand the desired contract and version to
locate the provision to import.

7. If any of the Start or Expiration dates are red for the provision you want to import, click in the
Start Date and Expiration Date fields and select dates that match the Start and Expiration dates of
the version to which you are importing the provision. When updated successfully, the dates turn
black and the provision check boxes are enabled.
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8. Select the check box for the desired provision (you can import more than one).

9. (Optional) If applicable, select to import associated attributes or other attachments by selecting
the corresponding check box below the list of contracts.

10. Click Import.

Edit or delete a provision
After copying a provision, you may want to make some changes to it. You can do the following from the
Edit Provision dialog:

l Change the start/expiration dates
l Change the Type of Bill
l Add or remove attributes or change attribute values

You can also delete a provision after verifying that the provision and its clauses/terms, etc., are not in
use and do not contain data that need to be preserved as records.

To edit a provision:
1. Navigate to the desired provision.

2. At the end of the provision row, hover your cursor to view the icons and then click the Edit icon (
).

3. In the Edit Provision dialog, do any of the following as needed:
l To change the Start Date or Expiration Date, in the Settings tab, click the Calendar icon (

) and select the desired date.
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NOTE: The system will not allow you to select dates that are outside of the associated
version’s active period or that overlap with another provision that has the same bill
type(s).

l To change the bill codes or type of bill, click the Type of Bill tab and do any of the following:
o To remove a bill code, in the Assigned section, click the Remove icon ( ) for the

type of bill.
o To add a bill code, in the lower half of the tab, in the Available section, click the plus

icon to the left of the desired Type of Bill to expand its codes, and then select the bill
code by clicking its Assign icon ( ).

l Add, edit or remove attributes.

4. Click Save.

To delete a provision:
1. Navigate to the provision to be deleted.

2. Verify that the provision and its clauses, terms, etc., are not in use and do not contain data that
need to be preserved as records.

3. At the end of the provision row, click the Delete icon ( ).

4. In the conformation dialog, review the information and then click Delete.

Modeling clauses and terms
Clauses and terms are provision building blocks; they are the vehicle that defines contract terms, rates,
and limits. A clause and term are interchangeable in how they calculate; however, a term always resides
beneath a clause. The clause is considered the parent of the term. A clause can have no terms or it can
havemultiple terms. A term always has the one clause under which it resides. The order and the
selections made on a clause/term determine how the claims filter through the calculation criteria.

� Clause and term order significance
Axiom Contract Management calculates claims in a top-down manner for both clauses and terms. This
means that a claim initially tries to match to the first clause listed in the provision. If there is no match, it
continues on to the next clause, regardless of whether or not a term exists on clause 1. If, on clause 2, the
claim matches the defined criteria, it stops and makes the calculation. Then it continues on to the first
term of the clause (if it exists), and then the second term (again, if it exists) beforemoving on to clause 3,
and so on. The only way to stop a claim from moving to the next clause (or term) is to set it as terminal.
For information on changing the order of a clause or term, see Edit or delete a clause or term.
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� Clause or term Calc Basis
The following example shows some of the possible selections for the clause/term calculation basis. You
cannot edit these. The calculation basis is used in conjunction with the calculation type and measure to
determine a specific reimbursement method.

The Calc Basis paired with the rates loaded for the clause or term determine whether a claim will qualify.
For example, if you select Admit Diagnosis Code, Axiom Contract Management only finds claims for
which the defined clause/term codes match the admitting diagnosis code on a claim.

The CMS-based options include specially built calculation rules that are used with the defined factors for
the provision.

Certain calc basis options are considered claim level and some are considered line item level. Selecting
one or the other determines the options available for Calc Type and Calc Measure. For example, DRG is
considered claim level, whereas RevCode is considered a line item level calculation basis.

Example of Calc Basis column in list of clauses

� Calc Type
There are three possible selections for the Calc Type field. Either the clause/term will be paid at a Dollar
Rate, a % of Charge, or a % of Cost, with the first two selections being themost commonly used. The calc
types available for selection are determined by the Calc Basis selected.

� Calc Measure
The five possible selections for the Calc Measure field are: Per Claim, Per Diem, Per Date, Per Line Item,
and Per Line Item Qty. These options are limited based on the calc basis selected for the clause/term. For
example, if DRG is selected as the calc basis, the option for Per Date, Per Line Item, and Per Line Item Qty
are not applicable because those are used with line item level parameters only.
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� Terminal vs. Non-terminal
Setting a clause or term as terminal or non-terminal (the default) determines if a claim will continue
calculating on the clause or term below it.

Setting a clause to Terminal (i.e., Yes) stops the claim from progressing to the next clause; it does not
stop it from moving through all of the terms (if any) below that clause.

Setting a term to Terminal stops it from progressing to the next term under the same clause; it does not
stop it from moving through any clauses (if any) below it. For the terminal logic to apply to a claim, it
must qualify on the defined calculation criterion for the clause or term.

For example, if a claim has an implant revenue code, a certain dollar amount will apply to that rev code
line item for all claims, and even if a claim qualifies for this payment, it will continue down to the next
clause. If the claim qualifies for Orthopedics, it stops there, and Orthopedics will be the only other
possible payment method on the claim, as that is a terminal clause. If it is not an Orthopedic claim (based
on the defined DRG), it will continue on. If a claim qualifies on Clause 8Med/Surg, it could also qualify
and reimburse on Clause 9 ICU, as that is a non-terminal clause.

Example Clauses/Terms page with Terminal column outlined in red

Managing clause and term descriptions
The description is the first criterion that you need to define for a clause or term. A few standardized
descriptions are already included with the initial Axiom Contract Management installation, but you can
add, edit, and delete descriptions at any time.

Clause and term descriptions are available in all simulations.

� Add a new clause or term description
To add a new description:

1. In themain menu header, click Admin >Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. In the upper right corner of the page, click Create New Record.

3. On the Create New Clause/Term Descriptions page, in theDescription field, type the description.
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The field has a 50-character limit.

4. Do one of the following:
l To save and return to themain Clause/Term Descriptions page, click Save, and then, in the

upper right corner of the page, click Back to Descriptions.
l To save and close the page, click Save and Close.

The new description is now available from the Description drop-down when you or others are adding or
editing clauses and terms.

� Edit or delete a clause or term description

IMPORTANT: If you change a description, the change will be reflected in all accounts and data where
the description is used.

To edit a description:
1. In themain menu header, click Admin >Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. In the list of descriptions, locate the desired description. If needed, click the Filter icon ( ) and

filter the list.

3. At the end of the description row, click the Edit icon ( ).

4. On the Edit Clause/Term Descriptions page, in theDescription field, make the desired change.

5. Do one of the following:
l To save and return to themain Clause/Term Descriptions page, click Save, and then, in the

upper right corner of the page, click Back to Descriptions.
l To save and close the page, click Save and Close.

To delete a description:
1. In themain menu header, click Admin >Manage Clause/Term Descriptions.

The Clause/Term Descriptions page opens.

2. In the list of descriptions, locate the desired description. If needed, click the Filter icon ( ) and

filter the list.

3. At the end of the description row, click the Delete icon ( ).

4. In the confirmation dialog, click OK.
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About multiple-procedure payment reduction line item calculations
When modeling contracts, you can includemultiple-procedure payment reduction calculations by
percentage to handle contracts with multi-procedure payment reduction (MPR) line items in excess of
three reimbursement rates. This calculation handles dollar and percentage rates. The Line Item Code
MPR calculation basis calculates claims that are reimbursed based on multiple rate tiers. This calculation
basis is available in the Calc Basis menu for clauses and terms, as shown in the following example:

Line Item MPR uses translation tables similar to Line Item ASC. Translation tables consist of columns of
line item codes and their associated Group column. (Descriptions are not needed in the table because
they are automatically populated based on the existing Line Item Code library entries.)

IMPORTANT: When adding translation tables and rates to a line item MPR clause, you must add the
translation table file before you add the rates file, or else the rates will not load.
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The Rates dialog for Line Item MPR has a ten-tier procedure reduction calculation consisting of nine rate
columns and one sub rate column on the Category Assignment tab (see following image example) to
handle procedure reduction logic in contracts. You do not need to specify all ten tiers, but at minimum
you must specify one rate and the Subrate column. You can enter rates manually or upload translation
and rates tables. For more information, see Import rates for a clause or term.

With Line Item MPR, rates may be either percentages (loaded as decimals) or dollars.

When loading rates using an Excel file, the subratemust be defined. The subrate is the last payable rate.
Therefore, if a contract says all services are reimbursed at 100/50/25/25, then program 100% of the given
rate in Rate 1, 50% of the given rate in Rate 2, and 25% of the given rate in the Subrate. This will calculate
all services found in the translation table.

If reimbursement is limited to a set number of services, use the rate columns and subrate to limit
reimbursement. For example, if only three services are payable, program Rate 1-3 with the appropriate
value and subrate with $0. This prevents any services from calculating after the third procedure.

As with Line Item ASC, reimbursement order is determined by rate, assessing the services with the
highest reimbursable amount, and paying those first.

NOTE: In the case of professional contracts with services that are always payable, you can ensure
that these are calculated first regardless of highest reimbursable amount. For details, see Add an
exclusion to a professional Line Item MPR calculation.
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When a qualifying claim comes in and triggers the Line Item MPR clause, the system determines the
group it belongs to based on the translation table. After all qualifying line items are grouped, the system
assigns the rates to each group based on the Day of Service and rates set for the clause/term.

For more information, see the following:

l Add a clause to a provision
l Add a term to a clause
l Add a unit max limit to a Line Item MPR
l Modeling clauses and terms

� Claim voucher reports display Line Item Code MPR calculation details
When reconciling an MPR calculation on a claim, you can use the voucher report to see which line items
on the claim triggered Line Item CodeMPR on a contract and were paid based on that calculation logic.
You can use this detail to track down under or over payments and to justify proper payment from the
payer.

In the following example, a claim voucher report displays the following details for a Line Item MPR
calculation on a claim:

l The service codes on the claim that matched those on the Line Item MPR clause
l The service date detail, line item code with description, and the group, units, and qualified level
l Payment amount for each

Create a Line Item MPR clause or term
Use these instructions to create Line Item MPR calculations on a clause or term. Line Item MPRs calculate
claims that are reimbursed based on multiple rate tiers.
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To create a line item MPR clause or term:
1. Navigate to the Clauses or Terms page for the desired provision.

2. Click +Add a New Clause (or +Add a New Term).

3. In the Add a New Clause (or Term) dialog, from the description field, select a description.

4. From the Calc Basis drop-down, select Line Item Code MPR.

5. From the Calc Type drop-down, select either Dollar Rate or% Charges, whichever applies.

The Calc Measure drop-down is set automatically to Per Line Item, which is required for this
calculation basis.

6. For Terminal? select either Yes orNo.

7. Click Save.

8. Import translation tables and then import rates.

About volume discount calculation line items
Users modeling contracts can includemulti-channel discount calculations to handle volume discount
pricing on claim line items. The line item codeMulti-Channel Discount calculation basis calculates claims
against contract line items that are reimbursed based on volume tiers. This calculation basis is available
in the Calc Basis menu for clauses and terms, as shown in the following example of the Edit Clause dialog:
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This calculation basis pays a set amount based on the number of units found for a set of procedures on a
claim.

Multi-Channel Discount line items use translation tables similar to the way Line Item ASC does.
Translation data consists of a column of line item codes and a Category column. The description does not
need to be in the translation table because it automatically populates with the description in the Line
Item Code Library.

The Rates dialog for this type of line item contains multiple lines for specifying categories, number of
units, rates, and the effective range of those rates based on unit volume. You can enter rates manually or
upload translation and rates tables. For more information, see Import rates for a clause or term and
Import translation tables.

For each category, claims are paid based on a volume discount of tiered pricing. The following example
shows items for categories 1 and 2. If an incoming claim fits Category 1 and has three units, the rate paid
is $4.00 because the Effective Range is 3 <= Units < 4. If the claim has four units, the rate paid is $5.00
because the Effective Range is 4 <= Units < 5. Any claim with eight units or more is paid at the $11.00 rate.
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For more information, see the following:

l Modeling clauses and terms
l Add a clause to a provision
l Add a term to a clause

� Claim voucher reports display Volume Discount calc details
When reconciling a multi-channel discount payment calculation on a claim, you can use the voucher
report to see which line items on the claim triggered a Line-Item CodeMulti-Channel Discount calculation
on the claim, and were paid based on that calculation logic. You can use this detail to track down under
or over payments, and to justify proper payment from the payer.

In the following example, a claim voucher report displays the following details for a multi-channel
discount calculation on a claim:

l The Line item Multi-Channel Discount codes on the claim that matched those on the clause
l The service date detail and the category
l Payment amount for each

Add a clause to a provision
When creating a clause, you need to define the services being reimbursed and their contracted rates. For
this, you select the calculation criteria. (For information on Calc Basis, Calc Type, Calc Measures, and
Terminal vs. Non-terminal, seeModeling clauses and terms.) You can also add attributes to a clause.
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To add a new clause:
1. Navigate to the desired provision.

2. On the Provisions page, in the desired provision row, click Go to Clauses.

3. On the Clauses page above the table of clauses, click Add a New Clause.

The Add a New Clause dialog opens.

NOTE: The clause number is assigned by the system and cannot be edited initially, but after
creating the clause and saving it, you can move it to a different position in a group of two or
more clauses on a provision.

4. From theDescription drop-down, do one of the following:

l Select a description for the clause.

TIP: In drop-downs with numerous results, like Description, you can search for a specific
result: click in theDescription field and begin typing a search word. Matches display in
the drop-down results; click a description to select it.

l Add a new description: click theDescription field name, which is linked to the Clause/Term
Descriptions page where you can add a new description if you are an administrator.

5. From the Calc Basis drop-down, select the basis for calculation.

6. If applicable (depends on the selected Calc Basis), from the Calc Type drop-down, select the
calculation type.

7. If applicable, from the Calc Measure drop-down, select themeasure on which the calculation is
made (for example, Per Claim, Per Line Item, Per Diem).

8. From the Terminal? drop-down, select Yes for Terminal orNo for non-terminal.

9. Do one of the following:
l To add rates, continue to step 10.
l To add thresholds, skip to step 11.

10. To add rates, do one of the following:
l For a single rate, type the rate into the Rate field.

NOTE: Some calculation bases and their associated calculation types and measures
require multiple rates or rates from an uploaded file. When this occurs, the Rate field is
inactive.

l For multiple rates, enter rates manually or import rates from a file.
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NOTE: The Include clause in Global Limit check box is enabled automatically if the parent
provision contains a global limit.

11. To add thresholds, do one of the following:

l Add thresholds manually.
l Import thresholds.

NOTE: Not all calculation bases allow thresholds. For more information, see About
Thresholds.

12. Click Save.

13. (Optional) Add an attribute.

14. If needed, add a limit.

Add a term to a clause
A term always resides beneath a clause. The clause is considered the parent of the term.

When creating terms, you need to select the calculation criteria. For information on Calc Basis, Calc Type,
Calc Measures, and Terminal vs. Non-terminal, seeModeling clauses and terms.

To add a new term:
1. Navigate to the desired clause.

2. In the row for the desired clause, click Go to Terms.

3. On the Terms page, above the table of clauses, click Add a New Term.

The Add a New Term dialog opens.

NOTE: The term number is assigned by the system and cannot be edited initially, but after
creating the term and saving it, you can move it to a different position in a group of two or
more terms on a clause.

4. In theDescription drop-down, do one of the following:

l Select a description for the term.

TIP: In drop-downs with numerous results, like Description, you can search for a specific
result: click in theDescription field and begin typing a search word. Matches display in
the drop-down results; click a description to select it.

l Add a new description: click theDescription field name, which is linked to the Clause/Term
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Descriptions page where you can add a new description if you are an administrator.

5. From the Calc Basis drop-down, select the basis for calculation.

6. From the Calc Type drop-down, select the calculation type.

7. If applicable, from the Calc Measure drop-down, select themeasure on which the calculation is
made.

8. From the Terminal? drop-down, select Yes for Terminal orNo for non-terminal.

9. To add rates, do one of the following:
l For a single rate, type the rate into the Rate field.

NOTE: Some calculation bases and their associated calculation types and measures
require multiple rates. When this occurs, the Rate field is inactive.

l For multiple rates, enter rates manually or import rates from a file.

10. Click Save.

Using rates
Rates are entered at the clause or term level of a contract. Once the clause or term is added, you need to
define the services being reimbursed and their contracted rates.

There are two kinds of rates: rates and thresholds. This topic is about rates. For information on
thresholds, see Using thresholds.

You can add rates or thresholds to a clause/term but not both.

� Rate requirements
Rates require the following:

l Code – The code for the procedure or service that appears on claims.
l Description – Populated from the code description library for the code being used, but if the code

is not in the library, you can add it manually.
l Rate – Contracted charge for the procedure or service.

The following calculation bases require information additional to a code and rate, and therefore require
uploaded rate files and additional uploaded files as listed:

l Line Item ASC – Excel upload only; translation file and rate file
l Line Item MPR – Excel upload only; translation file and rate file
l Line Item Incidental – Excel upload only; translation file and rate file
l Line Item Bundle – Requires two codes and a rate
l Line Item Modifier – Requires additional field for modifier associated with the code
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l Line Item Plus Rev Code – Requires combination of codes: Line Item and Revenue Code
l Line Item POS – Requires additional field for Place of Service
l Multi-Channel Discount – Two files needed: translation file and rates/units
l RevCode Incidental – Excel upload only; translation file and rate file
l DRG Cost Outlier – Requires Code, RCC, Threshold, Reduction Percent and Reduction Amount
l CMS Outpateint – Ability to adjust 3M output by Overall Adjustment, APC Status Indicator, APC

or Line Item
l CMS Psych, CMS DRG, CMS CMG – Require detailed Excel file uploads that work with the provision

factors

When setting rates, a rate codemay exist only once per clause/term, with one exception as noted:

l A codemay only exist once per clause/term. For example: DRG 775may be added at $5000.00. If
you try to add code 775 again, a message displays indicating that this code already exists.

l The exception is Line Item plus RevCode. In this case, the code combination may only exist once.
For example: Line Item Code 36415with RevCode 0301may exist along with Line Item Code 36415
with RevCode 0302 because the combination of codes is unique.

� Entering rates
Rates can be either dollar amounts or percentages.

l If the calculation type is Dollar Rate, then the rate should be a monetary value with two decimal
places (13000 = 13,000.00).

l If the calculation type is %Charges or%Costs, then the rate needs to display four decimal places
(70% = .7000 or 74.25% = .7425).

l Admin users can manually enter rates, edit the rates, and delete the rates.
l Admin users can edit and deletemultiple rates at a time.

Multiple rates entered manually or uploaded from a file display in the Edit Rates dialog. Admin users
need to be able to check any combination of lines and have the “Set Rate To” or “Factor Rate By” applied
to those selected. Admin users also need the option to Select/De-Select All entries across pages of rates.

l In the Edit Rates dialog, rates can be filtered by the Code and Description columns.

Manually add rates to a clause or term

Use these instructions when you need to manually add rates to a clause or term. You can also import the
rates from a file instead of adding them manually if you prefer or if you have a page or more of rates.

To manually add rates to a clause/term:
1. Navigate to the desired clause or term.

2. In the Rates column, click the Edit icon ( ) (if no rates are attached, the icon will be grayed out).
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3. In the Edit Rates dialog, click Add a New Row. A new row displays in the Rates Data View tab on
the left, as shown in the following example:

4. In the Code field, type a code associated with the chosen calculation basis for the clause/term. (To
see the calculation basis, open the Edit Clause/Term dialog and view the Calc Basis field.) The code
description will autopopulate. If no description is associated with the code, it will read “NO
DESCRIPTION,” and will be selected so you can enter a description manually.

IMPORTANT: Once you save the description, you cannot change it.

5. In the Rate field, type a corresponding rate.

6. Add more rate rows as needed. To apply the same rate to multiple codes, see the following step 7.

7. (Optional) To apply the same rate to some or all the entered codes, or to adjust some or all of the
rates by a specific factor:

a. On the left, select check boxes for the rate rows to affect.

b. At the bottom of the dialog, from the Adjust selected rows drop-down, do one of the
following:

l Set rate equal to – To set all checked rows to the same rate, in the field to the right
of the drop-down, enter the desired rate.

l Factor rate by – To adjust all checked rows by an entered value, enter the
adjustment percentage as a decimal value (for example, enter 1.02 to increase the
set rate 2%),

c. Click Apply.

8. (Optional) To delete a rate, select the check box for that row, and then at the bottom right of the
dialog, click Delete Selected. In the confirmation dialog, click OK.

9. Click Save.
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Import rates for a clause or term

When working with large fee schedules, or when working with certain calculation bases, manually
entering rates may not be feasible or allowed. In such situations, you can import the fee schedule or
rates table from an Excel file. If you are also importing translation tables, you need to import those
before you import rates, or else the rates will not load.

IMPORTANT: There aremany types of rate files (DRG, Line Item Code, Rev Code, etc.). When
importing rates, make sure the rate file you upload matches the specific type of calculation basis
used by the clause or term. For example, if the clause or term uses CMS DRG, then a DRG rate file
that has a dollar rate would use these options: Calc Basis = DRG; Calc Type = Dolar Rate; Calc Measure
= Per Claim.

When importing rates, you first upload the rate file to the server, and then you attach it to the contract.

To import the rates:
1. Navigate to the clause or term needing rates.

2. In the Rates column of the clause/term row, click the Edit icon ( ).

3. In the Edit Rates dialog, click the Files tab.

4. On the left side of the dialog, under the listed calculation basis for the clause/term, the Rates
folder should be selected as the rates file destination. If it is not, select it.

5. On the right side of the dialog, in theUpload files to a selected folder area, do one of the
following:

l Drag and drop the rates file.
l Click Select files and then select a rates file.
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6. Click Upload. The uploaded file displays on the left under the destination folder, as shown in the
following example:

7. Select the uploaded file.

8. (Optional) To rename, the file, on the right side of the dialog, the file name displays in the Rename
a selected file field. If desired, rename the file and then click Rename.

9. On the right side of the dialog, click the Specify tab. The top part of the tab displays an image
corresponding to the data in the uploaded file.

10. On the lower right of the dialog, in the Excel Column, for each row in the Rates Column, select
from the drop-down the letter that corresponds to the column in the image above. In the
following example, Code corresponds to column A in the Rates file. Do this for each field in the
Rates Column that needs to bemapped.
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11. For Excel data has column headers? select the appropriate option.

12. Click Save specifications.

13. Click the Import tab.

14. If needed, from the File Type drop-down, select Rates.

The file you uploaded displays under Specified Rates Files.

15. On the right side of the dialog, click Attach. When the file is attached, the check box displays
checked:
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16. To view the imported rates, click the Rates tab.

17. Close the Edit Rates dialog.

View rates for a clause or term

A clause or term may have a single rate, multiple pages of rates, or a set of tiered rates, depending on the
service or procedure; or group or combination of services/procedures, contract type, provision, and so
on.

If a clause or term has a single rate, the rate displays in the Rate field of the Edit Clause (or Edit Term)
dialog.

If a clause or term has multiple rates or a set of tired rates, the Rates are displayed in the Edit Rates
dialog. The Edit Rates dialog also displays associated information and any attached files, if applicable.

To view the rates associated with a clause or term:
1. Navigate to the desired clause or term.

2. On the Clauses/Terms page, look in the Rates column.

l If the clause/term has a single rate, the Edit icon is grayed out ( ). To view the single rate,
at the end of the row, click the Edit icon ( ), and then, in the Edit Clause/Edit Term

dialog, look in the Rate field.
l If the clause/term has multiple or tired rates, the Edit icon is not grayed out. Click the Edit

icon. In the Edit Rates dialog, rates are displayed in the Rates tab.
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Example of Rates dialog for a clause with multiple procedures and rates

Import translation tables
Translation tables are crosswalk code tables that map equivalent, identical, or similar information across
two or more distinct data sets. Most crosswalking is done between a newer version and an older, out-of-
date version of the same code set. Certain Contract Management calculation bases, such as the
following, all require translation tables:

l Line Item Code Incidental
l RevCode Incidental
l Line Item CodeMPR
l Line Item Code ASC
l Multi-Channel Discount

If you select any of these calculation bases, the Edit Rates dialog will contain a Translation Data tab in
addition to the other tabs.

IMPORTANT: When adding translation tables and rates to a line item MPR clause, you must add the
translation table file before you add the rates file, or else the rates will not load.

Importing translation tables follows the same basic process as importing rate files.
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To import a translation table:
1. Navigate to the clause or term.

2. In the Rates column, click the Edit icon ( ) (if no rates are attached, the icon will be grayed out).

3. In the Edit Rates dialog, click the Files tab.

4. On the left side of the dialog, the Translation Tables folder under the calculation basis for the
clause/term should be selected as the destination of the translation file. If it is not, select it.

5. On the right side of the dialog, in theUpload files to a selected folder area, either drag and drop
a translation table file to this area or click Select files and select the file to upload.

6. Click Upload. The name of the file displays under the folder on the left side of the dialog.

7. Select the uploaded file.

8. (Optional) To rename, the file, on the right side of the dialog, the file name displays in the Rename
a selected file field. If desired, rename the file and then click Rename.

9. On the right side of the dialog, click the Specify tab. The top part of the tab displays an image
corresponding to the columns and rows in the uploaded file.

10. In the lower right of the dialog, in the Excel Column, for each row in the Rates Column, select
from the drop-down the letter that corresponds to the column in the image above. In the
following example, column A corresponds to the Line Item Code column in the translation tables
file, and column B corresponds to ASC. Do this for each field in the Rates Column that needs to be
mapped.
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11. Select whether or not the file uses headers, and then click Save Specifications.

12. Click the Import tab. If needed, from the File Type drop-down, select Translation Tables.

The translation table file should display under Specified Translations Files.

13. On the right side of the dialog, click Attach. When attached, the check box to the left of the listed
file displays as checked.

14. To view the uploaded data, click the Translation Data tab.

15. Close the Edit Rates window.
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Attach or re-attach a file
Sometimes you need to attach multiple files; for example, if a clause or term has multiple Rev Code
calculation bases. While you can upload more than one file of a kind (e.g., rates, translation, etc.), only
one of those file types can be attached to the clause or term at a time. So, if a clause has a calculation
basis that requires a rates file and a translation data file, you can attach only one of each kind to the
clause at a time. When you attach a different file of the same type, the data in the new file replaces
previous data stored in the clause/term.

If you accidentally attach the wrong schedule or other file, or want to use a previously uploaded file, do
the following:

1. In the Edit Rates dialog, after uploading the desired file, click the Import tab.

2. If needed, from the File Type drop-down, select the file type.

3. In the Specified [type] Files section, do one:
l To use the original file, click Reattach.
l To use the newly uploaded file, click Attach.

NOTE: To add additional rates, there are two options: 1) Upload, specify and attach a new file that
includes all rates required for the clause/term, or 2)manually add the new codes and rates.

IMPORTANT: Be aware that if a rate file is re-attached, any rate codes added manually will be
replaced by what is in the file.

Copy, move, delete, or download attached files
Use these instructions to handle attached files, such as rate files, residing in system folders. If there are
schedules or rate files you can use from other contract version(s), in the Files tab of Edit dialogs for
attached files, you can either move a file or make a copy from another folder location by dragging and
dropping. You can also download a file, make changes to it and then upload it.

To move, copy, download, or delete a file:
1. Navigate to the desired contract level and then open the Edit dialog for the attachment. For
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example, if working with a rates file, then in the Rates column, click the Edit icon ( ).

2. In the Edit dialog, click the Files tab.

The left side of the tab displays the Rates Library and the folder system leading to the attached file.

NOTE: To see the folder structure for all simulations, above the folder structure, select the
Show all folders option.

3. Drill down through the clause/term calculation basis to the desired document, select the file, and
then do any of the following:

IMPORTANT: Although information imported from files is retained when you delete or move a
specified file, if you import another file and attach it to the clause or term, the previous
information is replaced with the new information.

� Copy the file to another folder
a. Below the folder tree, in theDrag/Drop section, select the Copy check box.
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b. Drag the file to the destination folder. The original file stays in the source folder.

� Move the file to another folder
a. Below the folder tree, in theDrag/Drop section, select theMove check box.

b. Drag the file to the destination folder.

� Delete the file

NOTE: If the file is in use (the file icon to the left of the name is solid), you can delete it without
removing the information from the clause or term as long as the imported file was the last one
attached. You can also reattach a file before deleting it from the server.

a. Select the file, and then click theDelete button below the folder tree.

b. Click Delete in the confirmation dialog.

� Download the file
a. Select the file.

b. Click theDownload button below the folder tree. he downloaded file displays at the
bottom of the page, as in the following example:

From here, you can open the file, make changes, move the file elsewhere on your
computer, or upload the file to the Contract Management system.

4. Close the Edit dialog.

Edit or delete a clause or term
You can make the following changes to a clause or term:

l Change the description
l Change the calculation basis, calculation type, and calculation measure, where applicable
l Change the terminal setting
l Add or remove attributes or change attribute values
l Add or remove attached rates
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To edit a clause or term:
1. Navigate to the desired clause or term.

2. At the right end of the clause or term row, hover your cursor and click the Edit icon ( ).

3. Do any of the following as needed:

NOTE: The term number is assigned by the system and cannot be changed.

l To change the description, from theDescription drop-down, select a different description.

NOTE: Administrators can add a new description.

l To change the calculation basis, type, and measure, select from the corresponding drop-
downs. Calculation type and measuremay or may not be changeable depending on the
calculation basis selected.

l To change the terminal setting, select from the Terminal drop-down.
l To change the rates, in the Rate field, type a new rate. If needed, import a rates file.
l To change attributes, click the Attributes tab and add, import, edit, or remove attributes.

4. Click Save.

To delete a clause or term:
1. Navigate to the desired clause or term.

2. At the end of the row for the clause or term, hover your cursor and click the Delete icon ( ).

3. In the Confirmation dialog, click OK.

Copy a clause or term
Use these instructions to copy a clause or term to the same contract. To copy a clause or term to a
different contract, you need to copy the provision it is attached to.

To copy a clause or term:
1. Navigate to the clause or term to be copied.

2. At the end of the row, hover your cursor and click the Clone icon ( ).

The Clone Clause or Clone Term dialog opens.

3. At the bottom of the dialog, clear any check boxes for items that you do not want to copy from
the original clause or term.
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NOTE: As stated at the bottom of the dialog, you must save the copy before you can edit the
rest of the settings.

4. Click Save.

5. (Optional) Edit the new copy as desired. For example, you may want to give the copy a different
description.

Set up post-grouper custom pricing
Some stateMedicaid and commercial Medicare-like plans useMedicare grouping methodologies but
then override some of the reimbursement rules for certain status indicators or APC codes. Or, they
simply pay at a percentage aboveMedicare. For claims reimbursement, you need to be able to model
these kinds of adjustments.

NOTE: These instructions do not apply to actualMedicare contracts, only Medicare-like contracts
from commercial plans.

When modeling contracts for commercial Medicare-like plans that use customized Medicare grouping
methodologies, you can include adjustments to the CMS Outpatient calculation. For example, you can
set rates for clauses and terms that use the CMS Outpatient calculation basis and adjust those rates as
needed.

During the CMS Outpatient calculation, the system receives the results from the 3M grouping and pricing
process and pulls the results into the voucher. You can adjust the voucher results as necessary for
payment in the following ways:
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l Adjust the CMS Outpatient calculation basis in the Rates window:
o No Adjustment – No adjustment is made to the rates coming from the grouping and

pricing process. This is the default selection.
o Overall Percentage – Adjust the post-grouping and pricing rate by a specified percentage.
o APC Status Indicator – Adjust the calc basis based on the SI.
o APC code adjustment – Adjust the calc basis based on the APC code.
o Line-item code adjustment – Adjust the calc basis based on the line-item code.

Adjust rates for a CMS Outpatient calculation
Use these instructions to modify rates for a CMS Outpatient calculation basis on a clause or term, as part
ofmodeling post grouper custom pricing.

To set up post-grouper custom pricing on a contract:
1. Navigate to the desired clause or term with a CMS Outpatient calculation basis.

2. In the Rates column for the clause/term, click the Edit icon ( ).

3. In the Edit Rates dialog, in the Adjustments tab, select the type of adjustment:
l No Adjustment – No adjustment is made to the rates coming from the grouping and

pricing process. This is the default selection.
l Overall Percentage – Adjust the post-grouping and pricing rate by a specified percentage.
l APC Status indicator – Adjust the calc basis percentage based on the Status Indicator.
l APC – Adjust the calc basis percentage based on the APC groupings.
l Line Item Code – Adjust the calc basis percentage by specific line items on a claim.

4. Do one of the following, depending on your selection in the previous step:
l If you selected Overall Percentage, then in the Adjustment field, enter a percentage

written as a decimal value (e.g., 0.07), and then click Save. Skip to step 14.
l If you selected APC Status Indicator, APC, or Line Item Code, proceed to step 5.

5. Click the Files tab.

On the left side of the dialog, the folder corresponding to the selected type of adjustment is
selected as the destination.

6. On the right side of the dialog, in theUpload files to a selected folder area, do one of the
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following:
l Drag and drop the rates file.

l Click Select files, and then select the desired file.

7. Click Upload. The uploaded file displays under the folder on the left side of the dialog.

8. On the left, select the uploaded file. On the right side of the dialog, click the Specify tab.

9. The top part of the tab displays an image corresponding to the data in the uploaded file. On the
lower right of the dialog, in the Excel Column, for each row in the Rates Column, select from the
drop-down the letter that corresponds to the column in the image above. In the following
example, APC Status Indicator corresponds to column A in the Rates file. Do this for each field in
the Rates Column that needs to bemapped.

NOTE: Some files may contain fields that do not need to bemapped, or may not contain data
for an optional field; however, if you try to save the file without mapping a critical field, the
save will not work. In the following example, “Description” is not considered a critical field, so
saving without mapping this field works.

Administrator's Guide Axiom Contract Management │ 113



10. For Excel data has column headers? select the appropriate option.

11. After mapping, click Save specifications.

12. Click the Import tab.

13. From the File Type drop-down, select the file type. The file you uploaded should display under the
gray header. On the right, click Attach.
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After attaching, the file’s check box displays as checked.

14. Close the Edit Rates dialog.

Using thresholds
A threshold is a specific type of calculation that can be placed on either a clause or a term within a
contract. Thresholds are used in situations where additional criteria, not just the code, is needed to
qualify the service for reimbursement. For example, the payor may require that the Total Charges of the
claim exceed a certain amount in order to qualify for additional reimbursement. Or, theremay be
different rates payable depending upon howmany days a patient is in the hospital.

NOTE: Clauses and terms can have either rates or thresholds, but not both.

A threshold’s parameters are defined by a Thresh Basis. A Thresh Basis a type ofmeasurement used to
define the tiers or levels of reimbursement within a threshold calculation. It is used in conjunction with
both a Lower Bound and an Upper Bound to make a claim qualify for the clause/term. A Thresh Basis can
be either claim-based (for example, Total Claim Days or Total Claim Charges), or line item-based (Total
Line Charges/Units or Total Daily Line Charges/Units). Not all calculation bases allow thresholds. For
example, Line Item ASC and Line Item MPR do not allow thresholds.

� Using calculation bases, measures, and types in thresholds
The Calc Basis, Calc Measure, and Calc Type, selected based on standard contract modeling rules, define
how the claim pays on the clause or term if the Thresh Basis Lower Bound and Upper Bound criteria are
met. As in normal contract modeling rules, the Calc Basis is used to determine if a claim qualifies for the
clause or term. The Calc Measure and Calc Type combined define how the claim is paid.

The following table provides a list of the possible combinations that can be used with Thresholds. Notice
that the first four are claim level, while the remaining three are line item based. These three calculation
options are used to apply a rate on the claim, but the rate will be held within the limits of the Apply to
Start and Apply to End fields that are set in the Threshold form.

Calc Basis Calc Measure Calc Type

DRG, CPT4, Rev Code, etc. Dollar Rate Per Diem
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Calc Basis Calc Measure Calc Type

DRG, CPT4, Rev Code, etc. Dollar Rate or % Charge Per Claim

Any and All Services Dollar Rate Per Diem

Any and All Services Dollar Rate or % Charge Per Claim

CPT4 or Rev Code Dollar Rate or % Charge Per Date

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item

CPT4 or Rev Code Dollar Rate or % Charge Per Line Item Qty

� Threshold examples
The following examples illustrate two situations for using thresholds.

NOTE: Regarding Lower Bounds – The Total Charges or Total Covered Days needs to fall within the
bounds. On the second tier, you may repeat the Low Bound or you may use the given start for the
next tier. The result will be the same as the Apply Start comes into consideration and will only apply
the rate on the excess.

It is important for the first tier to have bounds that capture the full range from 1 to infinite, as that will
ensure the lower tier is also calculated in these examples.

Charges
A payer might state that inpatient services are paid at 50% of charges but any inpatient claim that has
charges in excess of $100k will pay “Tiered Reimbursement” for which there would be varying
reimbursement rates depending upon the charges. In this example, you need to define a couple of key
terms:

l The Thresh Basis is Total Charges because we are paid a different rate based on the charges on the
claim (after we exceed $100k on a claim reimbursement changes)

l Two Rates need to bemodeled. As an example:
o 50% for the all claims up to $100k
o 75% on all claims exceeding $100k

l The bounds capture the Total Charges from the claim. For the 50%Rate, the Lower Bound would
be $1 and the Upper Bound would be infinite ($99,999,999). The next fields control the application
of the rate. The Apply to Start would be $1 and the Apply to End would be $99,999k because we
want the 50% to apply to all charges up to $100k.

l For the 75%Rate, the Lower Bound could again be $1 or change to $100k and the Upper Bound
would be $99,999,999. Remember, the Total Charges need to fall within the bounds. However, the
Apply to Start would now be $100k and the Apply to End would be $99,999,999 because wewant
the 75% to apply only to the charges over $100k.
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Days
A popular example of Day Thresholds is Maternity Cases. Often Maternity pays a Case Rate for a set
number of days and then adds reimbursement for days in excess.

l The Thresh Basis is Per Diem because we are paid a different rate based on the Covered Days on
the claim

l Two Rates need to bemodeled. As an example:
o The Case Rate for Days 1-3
o The Per Diem Rate for Days greater than 3

l The bounds capture the Total Covered Days from the claim. For the Case Rate, the Lower Bound
would be 1 and the Upper Bound would be infinite (999). The next fields control the application of
the rate. The Apply to Start would be 1 and the Apply to End would be 1, because wewant the
Case Rate to only calculate once. So wewill have it calculate on the first day (eliminate claim
variability).

l For the Per Diem Rate, the Lower Bound could again be 1 or it could be 4 and the Upper Bound
999. Remember, the Total Covered Days need to fall within the bounds, but the Apply columns
control applying the rate. So the Apply to Start would be 4 and the Apply to End would be 999
because wewant the Per Diem Rate to apply only to days exceeding the defined parameters of the
case rate.

Manually add a threshold to a clause or term

Use these instructions to add a simple threshold to a clause or term. For adding more complicated
thresholds, see Import a threshold for a clause or term.

To import a threshold file:

1. Navigate to the desired clause/term.

2. In the Threshold column, click the Edit icon ( ). If you are adding a threshold for the first time,

the icon is grayed out.

3. In the Edit Thresholds dialog, in the Thresholds tab, click Add a New Row.

4. Enter information in the following column fields: Code, Description, Rate, Thresh Basis, Lower
Boundary, and Upper Boundary, and Apply to Start and Apply to End, as desired. For information
on these fields, see Using calculation bases, measures, and types in thresholds and Threshold file
requirements. To locate codes, use the look up option.

5. To add another threshold, repeat steps 3 and 4.

6. (Optional) If you need to add multiple rows that will have the same information for each code, you
can copy the rows instead of adding each manually.

7. Click Save.
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Copy threshold rows

When entering thresholds manually, often the Thresh Basis, upper bound, lower bound, etc., will be the
same for every code. If a threshold entry exists that can be copied to other codes, you can use the
Duplicate selected row option.

To copy threshold codes:
1. Navigate to the clause or term with the desired threshold record. In the Threshold column, click

the Edit icon ( ).

2. In the Thresholds tab, do one of the following:
l Click Add a New Row and then manually enter the information for the first record to

duplicate, then select the row’s check box.
l For an existing row, select the row’s check box.

3. On the bottom right, select theDuplicate selected rows check box, and then click the Look up
codes button.

4. In the Look Up tab, find the code to add to the row, select the check box to the left of the code,
and then click Create Threshold Record.
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The selected codes are added to the Threshold tab as records.

5. Click Save.

Look up threshold codes

Use this feature to find threshold codes and add them as threshold records to clauses and terms.

To find codes to add as threshold entries:
1. In the Edit Thresholds dialog for the clause/term, click the Look Up tab.

2. Verify that theDuplicate selected rows option is NOT selected.

3. Locate and select the desired codes, and then, at the bottom right of the dialog, click Create
Threshold Records.

The record is added to the list of threshold codes in the Thresholds tab.

4. Click Save.

Import a threshold for a clause or term

When adding a threshold to a clause or term, you select themethod of payment for the clause or term.

You can add thresholds to a clause or term manually; however, you can add more complicated
thresholds using the attach thresholds option. With this option, you build your threshold requirements
in Excel and upload them to the system instead of entering them manually one at a time. This is the
preferred method for more complex thresholds. For information on threshold files, see the following
Threshold file requirements.

Before attaching threshold files, review the file requirements:
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� Threshold file requirements
Unlike regular rate files, threshold files require a minimum of the following fields:

l Code – Code used for match (DRG, CPT4, etc.)
l Rate – The rate to reimburse if claim/linematches the threshold conditions (Percentage or Dollar

Rate). Percentages must be represented as decimal values. For example, 100%→1. 99%→ .99
l Thresh Basis – The thresh basis controls which piece of information on the claim/line is analyzed

by the calculation engine to determine if there is a match. Enter the corresponding number below
in the Excel file. For example, if calculating Per Diem, enter 1 for each entry in the file.

o Claim Level Based

o (1) Total Days (Per Diem)

o (2) Total Charges (Per Claim)

o Line Item Based

o (3) Line Charges (Per Line Item),
o (4) Line Units (Per Line Item Qty),
o (5) Total Daily Units (Per Date Units),
o (6) Total Daily Charges (Per Date Charges)

l Lower Bound / Upper Bound – The lower bound represents the lowest value for your thresh basis
trap. The upper bound represents the highest value for your thresh basis trap. Anything greater
than or equal to the lower bound, and less than or equal to the upper bound, will be considered a
match.

l Apply to Start / Apply to End – In some cases, you may only want to apply a percentage (%) to a
range of your charges, or only apply a per diem on certain days. If this is the case, you would set
your “apply to start” and “apply to end” to the range of days or charges to which you want to
apply your rate.

A Description is not needed in the file because it will populate from the corresponding library. Codes that
are in the file but do not have a library entry will get a default description of NO DESCRIPTION.

To import threshold files to a clause or term:
1. Navigate to the desired clause/term.

2. In the Threshold column, click the Edit icon ( ). If you are adding a threshold for the first time,

the icon is grayed out.

3. Click the Files tab.

4. In theUpload tab on the right, drag the threshold file to theUpload files to a selected folder
area or click Select files and select the threshold file.

5. Click Upload. The file name displays under the Thresholds folder on the left.

6. Select the file, and then click the Specify tab on the right. The top part of the tab displays an image
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corresponding to the data in the uploaded file.

7. Define the columns of your file (refer to Threshold file requirements if needed):

a. On the lower right of the dialog, in the Excel Column, for each row in the Rates Column,
select from the drop-down the letter that corresponds to the column in the image above.
In the following example, Code corresponds to column A in the threshold file. Do this for
each field in the Rates Column that needs to bemapped.

b. For Excel data has column headers? select the appropriate option.

8. Under themapping table on the right, click Save Specifications.

9. At the top of the dialog, click the Import tab. The file you uploaded displays under Specified
Thresholds Files.

10. On the right side of the dialog, click Attach. When the file is attached, the file’s check box displays
as checked.

11. To view the imported thresholds, click the Thresholds tab.

12. Close the Edit Thresholds dialog.
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Using limits
Axiom Contract Management gives you the ability to model “lesser of” and/or “greater of” language
common among many payers. These are known as limits because they limit reimbursement for a
particular case, and can be added to any clause, term, or provision in a contract. In the contract level
hierarchy, limits sit on top of clauses and terms, which means they belong to the particular clause or
term they reside on. Global limits belong to the provision that they reside on.

� Limit restrictions
In Axiom Contract Management, you do not need to worry that your limit may not be compatible with
the parent clause or term that you are adding it to because the system handles it automatically. The type
of limit you can set on a particular clause or term depends on its parent type. For example, if you are
creating a limit on a case rate type clause, the type of limits available when you build it are restricted to
case rate calculation bases and types. If you are creating a limit on a line item clause or term, the limit
selections will be for line item calculation bases and types.

� What is a Maximum?
AMaximum sets a limitation on the particular clause or term it sits on, restricting it to a specified amount
that it can receive at most. For example, if you would like to limit reimbursement to the lesser of 100% of
charges on a DRG Case rate clause, you would set a max on that clause paying 100% of Any/All Services.
When the claim is calculated, the calculation will create a record for the DRG Case rate, a record for the
Maximum, and then compare the two and pay whichever is less.

� What is a Minimum?
Aminimum sets a limitation on the particular clause or term it sits on, restricting it to a specified amount
that it must receive at a bareminimum. For example, if you have a percent of charge clause that pays
50% of charges but your contract states that you will receive at least $500 for every claim, then you would
create a minimum on your % of charge clause, setting it to pay $500 of Any/All Services per claim.

� Limit hierarchies
In many cases, you will be creating contracts for which you have terms attached to clauses, and would
like to limit both the clause and its attached terms. You can do this by setting limits on both terms and
their corresponding parent clause; however, there is a hierarchy involved when doing so.

After all applicable terms are calculated, the clause limit is applied as a final step to determine if the limit
(s) apply or not. Remember, terms report their reimbursement back to their parent clause, so if a limit
exists on the clause, all terms attached to it are subject to that limit.

There are cases in which you will not want to include a particular term’s reimbursement when applying
the limit. The system allows for this by enabling you to toggle a term’s Include option. When you set a
limit on a term, a check box becomes enabled on the term, allowing you to include its reimbursement or
to exclude its reimbursement from reporting back to the parent clause’s limit. In Axiom Contract
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Management, these are known as “carve-out” terms. Their reimbursement does not count toward the
parent clause limit and are added to the result after the limit winner is determined. The Include option
can be located on terms for normal limits, and clauses for global limits.

Creating limits

Limits are defined generally as Maximums and Minimums, and they either cap or raise reimbursement.

You can create limits on the following contract levels:

l Provisions
l Clauses
l Terms

NOTE: Limits on provisions are called global limits because they apply to all clauses and terms under
the provision.

To create a limit:
1. Navigate to the desired clause or term.

2. To add a limit to a clause or term, do one of the following:
l Add a line item limit.
l Add a maximum and/or minimum limit.

3. To add a limit to a provision, add a global limit.

After setting a limit, the Edit icon is no longer grayed out.

Create a maximum or minimum limit

Adding a minimum or maximum limit to a clause or term restricts the reimbursement to a specified
amount that it can receive at most or at least.

NOTE: You can create only onemaximum and oneminimum per clause or term.

To create a maximum or minimum:
1. Navigate to the desired clause or term.

2. In the Limits column, click the Limit icon ( ).

3. On the Limits page, do one of the following:
l To create a maximum, select theMaximum check box.
l To create a minimum, select theMinimum check box.

4. In theDescription field, select a description from the drop-down.

5. In the Calc Basis field, select a calc basis from the drop-down.
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6. Select a Calc Type and a Calc Measure.

NOTE: Depending on which calc basis you selected, you may or may not need to, or be able
to, select a calculation type and calculation measure.

7. Click Save.

8. To set rates, do one of the following:
l For a single rate, type the rate into the Rate field.
l When multiple rates are required, a Rates button displays below the grayed-out Rates field.

To add multiple rates, click the Rates button and then add rates manually or import rates.

9. If you are creating both a maximum and a minimum, select theMinimum check box and then
complete the fields as you did for themaximum limit. You will need to save your selections before
you can enter a rate.

10. Click Save.

11. (Optional) If desired, set an exclusion for the limit(s).

Create a global limit

Global limits allow you to set a maximum and a minimum amount for reimbursement on a claim. Global
Limits are applied at the provision level and apply to all clauses and terms under the provision. To apply a
limit to a specific clause or term only, see Creating limits.

To create a global limit:
1. Navigate to the desire clause or term.

2. In theGlobal Limit column, click the In theGlobal Limits column, click the Limit icon ( ).

3. On theGlobal Limits page, add a maximum or a minimum, or both, as desired. The steps for
setting both are identical:

a. Select theGlobal Maximum (or Global Minimum) check box. Below the check box, settings
fields display populated with defaults.

b. In theDescription and the Calc Basis fields, select from the drop-down. You can search the
lists in these drop-downs by clicking the field and then typing the description or calculation
basis to search for. The list filters to the first letter or word you typed.

c. For Calc Type and Calc Measure fields, either leave the default or change the selection as
needed.

NOTE: In some cases, you will not be able to select an option different from the default
if the field is dependent on another field. For example, the selected Calc Type can limit
the Calc Measure you can select.
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NOTE: You cannot set a rate or an exclusion until you save your selections for the other
fields.

4. Click Save.

5. Do one of the following:
l For single rates, in the Rate field, enter a rate.
l When multiple rates are required, a Rates button displays below the grayed-out Rates field.

To add multiple rates, click the Rates button and then add rates manually or import rates.

6. (Optional) Set an exclusion.

7. Click Save.

Create a line-item limit

When a limit is defined on a line-item clause or term, it no longer compares the final reimbursement for
that clause or term to the limit, but instead compares the reimbursement to the limit on a line-by-line
basis. Themost common way to use the line-item limit is by capping fee schedules at the charge amount.
The capping of fee schedules is language common to several managed care contracts, which typically
would state that all fees are paid the lesser of charges or the pre-determined fee scheduled amount.

To create a line item limit for a clause or term:
1. Create the clause or term, or navigate to an existing clause or term that has a line item calculation

basis.

2. In the Limits column, click the Limit icon ( ).

3. On the Limits page, select either theMaximum orMinimum check box.

4. From theDescription drop-down, select a description.
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5. From the Calc Basis drop-down, select Line Item Code.

6. From the Calc Type drop-down, select Dollar Rate.

7. From the Calc Measure drop-down, select Per Line Item.

8. Click Save.

9. Below the Rates field, click the Rates button and attach your fee schedule to the clause/term. See
Import rates for a clause or term for detailed instructions on attaching fee schedules.

Set a limit exclusion

NOTE: Exclusions can be set in two places, depending on the calculation basis. When the Calc Basis
for a clause or term is either Itemized Charge Code or LI MPR, exclusions are set from the
clause/term Edit dialog. When the Calc Basis is Any and All services, exclusions are set from the
Limits/Global Limits dialog.

You can set exclusions on limits placed on clauses or terms, and on global limits placed on provisions.
Exclusions are available only when the calculation basis for the provision, clause, or term is Any and All
Services. Rates are entered manually.

l Manual entry is used to enter codes into the grid
l Services are excluded by either Date of Service or Total Charges

o There are before or after, less than or greater than selections
o Numeric values are entered for days or dollars

l Exclude by Service Code drop-down list determines which Code library we are validating against –
Charge Code or Rev Code. The functionality will always be the same, whether in clauses, terms,
lLimits, or global limits. Only the context changes.

To set exclusions on a limit:
1. Navigate to the provision, clause, or term with the limit needing an exclusion.

2. In the provision/clause/term row, in the Limits column (Global Limits if a provision), click the
Limit icon ( ).

3. On the Limits page, under theMaximum limit fields, click Exclusions.

4. In the Edit Exclusions dialog, on the right side, from the Exclude by Service Type drop-down,
select the service type: Line Item Code or Rev Code.

5. On the left side of the dialog, click +Add a New Row.

6. Enter the following information in the new row:
a. In the Code field, type the code.

b. If the code is in the system, the description displays in theDescription field and cannot be
edited. If the code is new to the system, type a description into the field.
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c. Enter a rate in the Rate field.

NOTE: You can enter negative rates as well as positive ones. To enter a negative rate,
put a minus sign (or hyphen) before the number.

7. To add another exclusion, repeat step 6.

8. Click Save.

Add a unit max limit to a Line Item MPR

Use these instructions to add a Unit Max limit on a contract clause or term that uses the Line Item MPR
calculation basis. Setting a unit max limit puts a cap on howmany units are paid. The unit max acts as a
counter; when the limit is reached, additional claims for that item that are eligible are not reimbursed
(they are paid at $0).

NOTE: The Unit Max limit used on an MPR calculation applies to professional claims only.

To add a unit max limit to a Line Item MPR calculation:
1. Navigate to the clause or term that has the Line Item MPR calculation method.

NOTE: Be sure you have added translation tables and rates to the clause before setting a limit.

2. In the Limits column of the clause/term row, click the Limit icon ( ).

3. On the Limits page, click theMaximum check box.

4. From theDescription drop-down, select a description.

5. From the Calc Basis drop-down, select Unit Max.

Notice that you cannot change the selected Calc Type.

6. From the Calc Measure drop-down, select whether themax should be applied per claim, per date,
or per line item.

NOTE: When creating a unit max limit, you cannot change the default Calc Type or Calc
Measure after selecting Unit Max as the Calc Basis.
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7. In the Rates field, enter the unit limit. For example, if the unit is the number of therapy sessions
and the contract stops paying after the 6th visit, enter 6.

8. Click Save.

The voucher report for claims that are run against this limit will display the limits and a payment of
0 once the rate cap is met.

Add an exclusion to a unit max limit Line Item MPR calculation

Use these instructions to add an exclusion to a unit max limit on a Line Item MPR calculation for
professional contracts. The exclusion allows always-payable services to calculate separately from the
items in the reduction calculation while still being counted in the unit max limit.

To add an exclusion to a Unit Max Limit Line Item MPR calculation:
1. If not already set up, create a clause for the always-payable services with the following selections

(do not forget to select the calculation type):

a. For Calc Basis, select Line Item Code.

b. For Calc Measure, select Per Line Item.

c. For Terminal?, select one:
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l No – Select to allow a claim to continue calculating on the clauses/terms below this
one.

l Yes – Select to prevent a claim from calculating on any clauses/terms below this one.

d. Click Save.

2. Add a unit max limit to the Line Item MPR calculation.

3. Exclude the always-payable services from the Line Item MPR:

a. At the end of the Line Item MPR row, hover your cursor and click the Edit icon ( ).

b. In the Edit Clause (or Edit Term) dialog, click the Exclusions tab.

c. Click +Add a New Row.

d. In the Code column, type the code for an always-payable service. Repeat for any additional
codes needing to be excluded.

e. Click Save.

4. To ensure that the always-payable services are included in the Unit Max Limit count and that they
process first, drag the clause row to the top of the table if it is not already there: select the row and
hold down your mouse button while dragging the row to the top of the table. The Unit Max limit
Line Item MPR clause does not need to be directly below it as long as it is lower in the table than
the one for always-payable services.

Using attributes
Users who have permissions to model contracts can add attributes to contracts.

Attributes are custom tags that you add to contracts and contract levels (i.e., versions, provisions, and
clauses/terms) to:

l Extend the contract data model – Attributes allow you to add information to a contract that exists
on the physical contract but for which theremay not be room in themodeled version.

l Organize key aspects of payer contracts
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l Enhance reporting across contracts and payers by
l Augment reporting for current calculations and modeling detail
l Ensure key details are collected during contract building

Attributes can be applied at all contract levels: contract, version, provision, clause and term. You can
apply an attribute from the list of attributes for that contract level or you can import an attribute from
another contract at the same level. Contract levels with applied attributes display a circled with check

mark icon ( ) in their Attributes column.

Attribute data:

l Name – Attribute name
l Description – Explanatory information about the attribute
l Data Type – The format of the attribute’s data value (e.g., text, integer, percent, etc.). For

example, if the Data Type is text, then the attribute’s value field accepts only text entries. The
following are the data types for attributes:

o Integer – Accepts a number
o Money – Accepts dollar and cents amounts
o Decimal – Accepts decimal values
o Percent – Accepts percentages
o Text – Accept text
o Library – A drop-down list from which you select a value for the attribute

l Attribute Type – The contract level at which the attributed can be used (i.e., contract, version,
provision, clause/term)

l Enabled/Disabled –Whether or not the attribute is available for use. If an attribute is disabled by
the system administrator, it will not display in any attribute selection lists.

Add an attribute to a contract level
You can add attributes to contracts at each level: contract, version, provision, and clause/term. When
adding attributes, you can add only attributes of the type that corresponds to the contract level. For
example, you can add only version attributes to versions, and clause/term attributes to clauses or terms.

To add an attribute to a contract level:
1. Navigate to the desired contract level.

2. At the end of the contract/version/provision/clause or term row, hover your cursor, and then
click the Edit icon ( ).

3. In the Edit [contract level] dialog, click the Attributes tab.
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4. In the Attributes section, for the desired attribute, select the attribute value from the Attribute
Value field.

Attribute values depend on the attribute’s data type (e.g., text, integer, percent, etc.).

Attribute Data
Type

Selection process

Library Select from a drop-down list of options

Text Input the desired text

Decimal Click the arrows to indicate the number of decimals

Integer Click the arrows to indicate the number of integers

Money Click the arrows to indicate the amount ofmoney

Percent Click the arrows to indicate the percentage.

In the following example, to add the contract attribute Color, select the desired color from the
drop-down.

5. Click Save.

Import an attribute to a contract level
Use these instructions to add attributes to contracts by importing them from other contracts. When you
import an attribute, the system copies the attribute from the source and applies the copy to the target
contract level.

� Import an attribute to a contract
1. Navigate to the contract that needs the attribute.
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2. At the end of the contract row, hover your cursor, and click the Edit icon ( ).

3. In the Edit Contractwindow, click the Attributes tab.

4. In the Import Attributes section, verify that displayed simulation is the one with an attribute you
want to use. If not, then from the Simulation drop-down, select the desired simulation.

5. In the list of contracts, locate and expand the level that has the attribute you want.

NOTE: Only contract-level attributes will be included in the list to choose from.

6. To import the attribute, click the Assign icon ( ).

7. Click Save.

� Import an attribute to a version, provision, clause, or term
1. Navigate to the contract level needing the attribute.

2. At the end of the version/provision/clause/term row, hover your cursor and click the Edit icon (
).

3. In the Edit [contract level] dialog, click the Attributes tab.

4. Across from the Import Attributes section title, from the Simulation drop-down, select the
desired simulation.

5. In the list of contracts, expand the desired contract levels to reach the desired level and then
expand that level item. For example, if you are importing attributes for a clause, navigate to the
desired clause and then expand the clause to view its attributes.

6. Do one of the following:
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l To import all of the [contract level]’s attributes, click the Assign icon ( ) at the end of the
row.

l To import selected attributes, click the Assign icon ( ) for the desired attributes.

Example of version-level attribute list

7. Click Save.

Edit or remove an attribute from a contract
Use these instructions to change an assigned attributes value or to remove the attribute from the
contract level.

To edit or remove an attribute:
1. Navigate to the desired contract level.

2. At the end of the contract/version/provision/clause or term row, click the Edit icon ( ).

3. In the Edit [contract level] dialog, click the Attributes tab.

4. Do any of the following:
l To change an assigned attribute’s value, select the value from a drop-down or, if an integer,

money, or percent value, type in the desired amount; the field is automatically formatted
for the entry type. If a text value, edit the text as desired.

l To remove the attribute from the contract level, if the value is from a drop-down, select
from the drop-down. If the value is an integer, delete the value (setting the value to zero
does not remove the attribute, it just changes it to 0) by selecting the value and pressing
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theDelete key.

5. Click Save.
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Managing simulations
The ability to run a nearly endless number of simulations is one way that Axiom Contract Management
sets itself apart from older editions. Simulations are an essential tool during contract negotiations,
allowing you to model a number of proposed contracts and run reports for comparison to determine
which proposal is most profitable.

Create a simulation
Creating simulations that model the identical contract structure allows you to get a more accurate view
of how facility reimbursement is changing, and which services are affected. After creating a simulation
you can add contracts to it.

To create a simulation:
1. At the top of the Contracts page, to the left of the simulation drop-down, click the Edit icon:

2. In the Edit Simulations dialog, above the table of simulations, click Add a new Simulation. A new
simulation row is added to the table, as shown in the following example.

6
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3. In the new row, type a name for the simulation and then click Save. The newly created
environment can now hold contracts.

4. Add a contract to the simulation.

Edit or delete a simulation
Use these instructions to change a simulation name or to delete a simulation.

To change a simulation name or delete a simulation:
1. At the top of the Contracts page, click the Edit Simulations link.

2. In the Edit Simulation dialog, for the desired simulation, click and then edit the name.

3. To delete a simulation, at the end of the simulation row, click the Delete icon ( ).

4. Click Save.

5. Close the Edit Simulation dialog.

Setting up reporting across simulations
Axiom Contract Management administrators can assign simulations to the Expected Payment drill-down
reporting field for side-by-side reporting and analysis. Administrators can map up to four simulations for
a total of fivemapped simulations. The first mapped simulation is to the Live environment, which you
cannot change.

� How the mapping works
The Estimated Payment fields in drill-down reports are used in this case to compare estimated payments
between different simulation environments. These fields are defined with the following field names:
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l TotalExpectedPayment1where 1= Live simulation; so TotalExpectedPayment1 equates to
Estimated Payments from Live in drill-down reports

l TotalExpectedPayment2where 2 = a simulation of your choice
l TotalExpectedPayment3where 3 = a simulation of your choice
l TotalExpectedPayment4where 4 = a simulation of your choice
l TotalExpectedPayment5where 5 = a simulation of your choice

When users build drill-down reports, they need to include the TotalExpectedPayment variable for the
desired simulation in a calculated field they add to the report.

In the following example, a contract is compared between two simulations. The calculated fields Exp
Pay1, Exp Pay1%, and Exp Profit1 aremapped to the Live environment by using the variable Total
Expected Payment1 in the equation for each calculated field:

l Exp Pay1 = Sum (Total Expected Payment1)
l Exp Pay1% = Sum (Total Expected Payment1)/Sum (Total Charges)*100
l Exp Profit1 = Sum (Total Expected Payment1)-Sum (Total Cost)

The calculated field Exp Pay2% is mapped to the EPAY2 simulation by using the variable
TotalExpectedPayment2 in the equation: Exp Pay2% = Sum (Total Expected Payment2)/Sum (Total
Charges)*100

The generated example report looks like the following:
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IMPORTANT: Since only administrators can see which simulations aremapped to each mapping
assignment field, as an administrator, you will need to create the custom calculated fields needed
and name them appropriately. For example, a calculated field representing Sum(Total Expected
Payment 1) for a simulation named Aetna KMC could be named AetnaKMC Exp Payment. For
information about creating calculated fields, see Add calculated fields to a report.

� Map simulations to drill-down reporting Expected Payment fields
To map simulations to expected payments variables:

1. In themain menu header, click Admin > Simulation Mapping.

2. For Mapping Assignment 2, from the drop-down, pick a simulation to assign to the Estimated
Payment drill-down reporting field.

NOTE: Mapping Assignment 1 is set to the Live simulation environment. This cannot be
changed.
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3. Repeat for the other mapping assignments as desired.

4. Click Save.

When you make a change to this assignment and click Save, the field is cleared to ensure that all past
calculation results from previously used simulations are not still stored and used in the report.

NOTE: Results from a newly assigned simulation become available only after a user calculates
contracts within the selected simulation. Past calculation results are not retained for a simulation
when it is assigned to a different mapping field.
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Working with claims
The View a Claim function in Axiom Contract Management allows you to access or view all information
related to claims. Themultiple forms of information are compiled from data contained in the Claims,
Payments, and adjustments imports. Other important data fields are calculated by the system, or
imported from other Syntellis systems.

You have the following options for selecting and viewing claims:

l Patient Account # – Account number or billing identification number imported from the claim
l Patient Name – Patient name imported from the claim (you can also search for the name in this

field if you do not know the full name)
l Claim #/UCRN – Unique record number or Claim Sequence number assigned by the patient

accounting system

� Access View a Claim
To access View a Claim:
In themain menu header, click Claims > View a Claim.

The Claims page opens with fields for selecting a claim to view:

The Axiom Contract Management system defaults to show Live Claims Only. To have the system return
results for all instances of the claims, clear the Live Claims Only check box beforemaking a View a Claim
Selection.

View a claim by selected criteria
Use these instructions to view claims by patient account number, patient name, or client #/UCRN.

7
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NOTE: By default, the selection criteria includes only live claims. To include all claims, clear the Live
Claims Only check box before clicking View Claim(s).

To select claims by patient account number:
1. On the Claims page, from the View Bymenu, select Patient Acct #.

2. In the Account # field, enter the account number and then click View Claim(s).

To select claims by patient name:
1. From the View Bymenu, select Patient Name.

2. In the Patient Name field, type the patient last name, and then click View Claims(s). If this does
not return the desired claim, type in the patient’s first and last names.

TIP: You can also search for patient names using the percent symbol % as a wildcard: %son
(returns claims for patients whose first or last name ends in the letters “son”); son% (returns
claims for patients whose first or last name begins with the letters “son”); %son% (returns
claims for which the letters “son” appear anywhere in the first or last name).

NOTE: If the criteria selected matches multiple claims, all of those claims will appear in the
Account Selection List.

To select claims by Claim #/UCRN:
1. From the View Bymenu, select Cliaim #/UCRN.
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2. In the Claim #/UCRN field, enter the number and then click View Claim(s).

� Account Selection List details

TIP: To sort any column in the table of selection list results, click the gray column head.

The account selection list results contains the following claim fields:

l Acct# – Lists the account number imported from the claims.

NOTE: Account numbers in this column are also links that will take you to the Claim Details
page for the respective claim.

l Claim Type – Identifies the type of claim and its status in Axiom Contract Management
l Organization – Identifies the organization imported from the claim
l Patient Name – First and Last name imported from the claim
l MRN –Medical Record Number imported from the claim, if applicable
l Admit Date – Admission date imported from the claim
l Discharge Date – Discharge data imported form the claim
l Sub Date – Submission date imported from the claim

l Total Charges – Total Charge amount imported from 0001 line on the claim form minus non-
covered charges

View claim details
The claim details page of Axiom Contract Management provides an easy-to-use interface that allows you
to view all information associated with a claim. Use the tab-based pages to navigate from summary-level
information to detailed line item information. To view information on a tab, click the tab name.
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Above the row of tabs is a line of additional options:

l View Voucher – Click this button to open a new browser tab containing the Claim Voucher
Report. The Claim Voucher Report provides an explanation of exactly how the system arrived at
the expected payment, and howmuch the payer has paid. This information is ideal for follow-up
with the payers to ensure proper payments are being received.

l Recalculate – Click this button to recalculate the current claim. For more information, see
Recalculate a claim from Claim Detail.
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l Go to Contract – Click this button to open the contract’s clause or term page to which the claim
applies in a new browser tab. Additionally, the specific contract clause is highlighted, as shown in
the following example.

l Grouper Edits – Click this button to detail all APC and eAPG edits. This is important when
determining why a Medicare claim has an expected payment = $0. In Axiom Contract
Management, if there is an edit on a line item (code, modifier, etc.), the system automatically pays
the claim at $0. This helps you easily identify claims that can potentially be fixed and re-billed for a
higher total redemption from Medicare. Following is an example of Grouper Edits for APC ICD9
Code edits.

� Claim Detail tabs

� Summary tab
The Summary tab displays information identifying the type of account, the contract used for calculation,
and important demographic information. The Summary tab also contains all the information necessary
to identify whether a claim is paid correctly:

l Expected Payment – Calculated expected payment using contract terms
l Expected Contractual – Total Covered Charges minus Expected Payment
l Actual Payments – Total of all Payments imported by Account # from payment import file
l Actual Contractual – Total of insurance contractual imported by Account # from Contractual File
l Payment Variance – The difference between Expected Payment and Actual Payments
l Contractual Variance – The difference between Expected Contractual and Actual Contractual
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l Total Cost – Sum of Fixed, Variable, and Indirect Cost
l Fixed Cost – Imported from Cost Accounting System – represents fixed cost (materials and labor)
l Variable Cost – Imported from Cost Accounting System – represents variable cost (overtime)
l Indirect Cost – Imported form Cost Accounting System – represent cost not specifically assigned

to dept.
l Actual Profit – Total Covered Charges minus Actual Payments
l Expected Profit – Total Charges minus Expected Payment

� Codes tab
The Codes tab contains all code-related information imported from the claim form. This information
includes:

l ICD9 Codes – Diagnosis and Procedure Codes
l Condition Codes
l Occurrence Codes
l Occurrence Span
l Value Codes
l User Defined Codes

You can navigate through the various code types by clicking the name of that code type. Code type
selection options are shown outlined in red in the following example.

� Demographics tab
Use the Demographics tab to view demographic information imported from the claim.
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� Insurance tab
Use the Insurance tab to view information imported from the claim associated with Primary, Secondary,
and Tertiary payer information.
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� Line Items tab
Line Items tab is very important for claim review. Access the tab by clicking the Line Items tab. This tab
displays imported Revenue Code detail for all claims, and Medicare APC information for Medicare OP
claims. The following examples represent a view of a Non-Medicare Claim and aMedicare Claim,
respectively.

Non-Medicare claim

Medicare claim

Medicare Claims contain two non-Imported Fields with values assigned by the 3M APC GPS software
during import:

l APC – Ambulatory Payment Classification

l Status Indicator (SI) – Identifies type of APC
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To see the description of a code listed in the Line Items tab, move your cursor over that tab, as shown in
the following example:

� Physicians tab
The Physician tab displays physician information imported from the claim.

� Postings tab
The Postings tab details each payment posted to a claim. The system default view is Payments; however,
you can change the view to show the different types of postings individually or together by clicking the
Contractuals or All radio buttons, respectively.
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� Tracking tab
The Tracking tab allows you to mark an individual claim for follow-up. This includes identifying:

l The claim’s status
l A generalized assignment category
l The person the claim is assigned to
l Ten user-defined fields
l Any additional notes

It also allows you to view the claim’s Tracking History to see how it has been managed, and follow it
through the recovery process. A summary of this information is provided on the Summary tab for quick
reference when you open an account.
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View Grouper Edits for a claim
When claims are grouped and priced, they may create edits that affect reimbursement. You can view
these edits on a claim and switch to any relevant simulation these claims apply to from the Grouper Edits
dialog. A Simulation menu at the top of the dialog allows you to select different simulations to see any
grouper edits that simulation produces for the given contract (the contract needs to bemodeled in the
simulations you select).

To view grouper edits on a claim:
1. From the Claims menu, select View a Claim.

2. Filter for and select the desired claim.

3. On the Claim Details page, in themenu above the tabs, click Grouper Edits.

4. At the top left of theGrouper Edits dialog, from the Simulation drop-down, select the desired
simulation.

The report lists any grouper edits that resulted from grouping and pricing the claim in the selected
simulation.
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Using claim tracking
Use Claim Tracking to organize institutional claims that need attention and easily locate them at another
time.

Assign a claim
Assigning a claim is the first step in using the Claim Tracking feature.

To assign a claim:
1. In themain menu header, click Claims > View a Claim.

2. In the View Claim By section on the left, select the criteria for the claims to view, then click View
Claims.

3. In the Acct # column, click the number of the claim to assign.

4. On the Claim Details page, click the Tracking tab.

5. Select the following claim details:
l Claim Status – Select Open, Closed, or other user-defined status (Needs Review, Insurance

Pending, etc.).
l Assignment – Select the general reason for assignment. This is also a user-defined field.

l Assigned To – Select the user assigned to this claim. This is a list of all system users, and is
generated by Syntellis, and cannot be changed.

l User Defined (1 – 10) – Select up to five user-defined fields with numeric formats, and five
with character formats. Administrators can edit them as needed.

l Notes – (Optional) Add any additional information in this text box. For example, provide
details about the generalized assignment reason to offer more specifics to this particular
claim.

6. Click Save. The claim displays in the Tracking History section.
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Claim details example

NOTE: System administrators can build new Claim Status options, Assignment options, and User
Defined options into the system from Claim Tracking, as described in Edit user-defined claim tracking
quick filters.

As you follow the claim through the recovery process, you can make additional notes to any of the
critical information on the page. Themost recently saved information displays at the top of the Tracking
History section.

Search assigned claims
You can search for assigned claims using the Quick Filters option or an existing filter containing saved
criteria.

To search for assigned claims using quick filters:
1. In themain menu header, click Claims > Track/Assign Claims. The claim tracking page opens.

2. In the View Tracking tab, leave the default filter setting at Use Quick Filters.

3. In the Select quick filters section, select the following claim details:
l Assignment – Select the general reason for assignment, or select Any to return all claims

that match any assignment.
l Assigned To – Select the user assigned to this claim, or select Any to return claims that

match any user. This is a list of all system users, and is generated by Syntellis, and cannot
be changed.
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l Status – Select Open, Closed, or other user-defined status (Needs Review, Insurance
Pending, etc.).

l Opened By – Select the user, or select Any. This list cannot be changed.
l Closed By – Select the name of the user or select Any. This list cannot be changed.

NOTE: Only users who set a claim tracking status to “closed” on a claim appear in this
list.

l Denial Category – Select a category or select Any to return claims that match any of the
categories.

l Denial Reason Code – Select a code or select Any to return claims that match any of the
denial reason codes.

l Service Location – Select a location or select Any to return claims that match any of the
locations.

l Priority – Select the priority or select Any to return claims that match any priority.
l Closed Reason Code – Select a code or select Any to return claims that match any of the

codes.

4. Click View Claim(s). This list of claims matching the set criteria displays below the filter options.

5. To export the list of claims, click Export List. The list is exported to an Excel file that displays in the
lower left corner of the page. Click the file to open it.

6. To view a claim in the list, in the Acct # column, click the linked account number.

To search assigned claims using an existing filter:
1. On the Claims Tracking page, click Use Existing Filter.

2. From the Select existing filter drop-down, select a filter.

3. Click View Claim(s).
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Search results are displayed in the lower part of the page:

Edit user-defined claim tracking quick filters
Some of the claim criteria used in claim tracking Quick Filters can be user-defined. Quick filters allow you
to locate only the claims that match the selected Quick Filter criteria.

To edit user-defined claims criteria:
1. In themain menu header, click Claims > Track/Assign Claims. The claim tracking page opens.

2. In the View Tracking tab, ensure that Use Quick Filters is selected.
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3. In the Select quick filters list, click the desired user-defined quick filter. The edit dialog for that
variable opens. In the following example, the Status variable options are being edited.

4. Do any of the following as desired:
l To add a new option, click Add New. A new line is added to the table. Type the option in

the row.
l To edit an option, click in the row and make the desired change.
l To delete an option, click the blue cell to the left of the name and then click Delete.

5. Click Save.

6. Click Close.

Build an advanced claims tracking filter
Use these instructions to build an advanced filter for searching tracked claims.

You can build filters here as shown in the following example. Use the same steps as for building an
Advanced Filter in Reports.

To build a new filter:
1. On the Claim Tracking page, click Use Existing Filter.
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2. Click Build Filter.

3. Follow the instructions beginning with step 2 in Build an advanced filter.

Assign claims from claim tracking
Assign claims from the Claim Tracking page by performing a mass modification.

To assign claims from Claim Tracking:
1. In themain menu header, click Claims > Track/Assign Claims. The Claim Tracking page opens.

2. Click theModify Tracking tab. This tab provides threemethods for selecting claims: Current View,
Quick Filters, or Existing Filters.

3. Select one of the following options and follow the provided instructions.

� Current View
Use this method to modify the tracking details of claims currently in the tracking page:

a. Click Use Current View.

b. In the Select modifications column, edit the tracking detail options.

c. ClickModify Claims. Also, if claims are in the Current View, you can sort the claims and
export them to MS Excel. You can sort on the current page, or, if there are numerous pages
of claims, you can sort the entire set. This option is boxed in green in the following example.
To the right of the Sort feature is another set of options. Here you select whether to export
the current pages or all pages in the set. Then, to export to Excel, click the Export List
button next to the View Claim(s) button, as shown outlined in red in the following Quick
Filters example.
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� Quick Filters
To use this method to mass modify claims:

a. Click Use Quick Filters.

b. In the Select quick filters column, specify the tracking details of the claims to modify.

c. In the Select modifications column, specify the new tracking details to apply.

d. Do one of the following:
l To modify the claims immediately, clickModify Claim(s).
l To review the claims found, click View Claims; then, if the returned dataset is

correct, clickModify Claims.

� Existing Filters
The Existing Filters list contains filters built in Claim Tracking, and advanced filters built in Reports.
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IMPORTANT: Use caution when using Advanced Filters from Reports to select accounts in
Claim Tracking. Basic report parameters require you to specify a contract to run your report
on as well as a discharge date range. The advanced filter does not necessarily specify a payer
or date range; therefore, your returned results may be for all payers for the entire database.
Modify by filters carefully and be sure to view your results before applying changes.

To use this method to assign claims based on existing filters:

a. In the Select existing filter drop-down, select a filter. Alternatively, you can click the Build
Filter button and build a filter from scratch, as explained in Build an advanced filter.

b. In the Select modifications column, specify tracking details to apply by editing the
modifications.

c. ClickModify Claim(s). This can also be done in two steps by first clicking View Claim(s).

� Customizing filters
As mentioned in Assign a claim, Axiom Contract Management includes ten User Defined fields, five of
which are formatted numerically and five of which are formatted as characters. You can also hide
columns to prevent them from entering claim tracking reports. For example, if you want to eliminate the
name field from claim tracking to comply with HIPAA regulations, contact a Syntellis representative.

Simulate adjustments to claim charges
Use the Charge Adjustments feature to preview adjustments to claims charges in simulations to
understand the impact they will have on your net reimbursement and future contract performance.

NOTE: This feature is available to administrative users only.

To preview claim charge adjustments:
1. If one does not already exist, create a simulation and add contracts for which you want to preview
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price changes.

2. From the Claims menu, select Charge Adjustments.

3. From the Simulation drop-down, select the simulation that has the contracts against which you
are running claim adjustments.

NOTE: This feature cannot be used in the Live environment.

4. In the Adjust By section, select the desired type of adjustment:
l No Adjustment – Select and then click Clear to clear the current selected adjustment type

and its calculations.
l Overall Percentage – Adjust the charge by a specified percentage.
l Revenue Code – Adjust the charge by programming different revenue codes if they are

different rates, for example.
l Line Item Code – Adjust the charge by specific line items on claims.

5. Do one of the following depending on your selection in the previous step:
l If you selected Overall Percentage, then, in the Adjustment field, enter a percentage

written as a decimal value (e.g., 0.07), and then click Save. Skip to step 7.
l If you selected Revenue Code or Line Item Code, proceed to step 5.

6. To adjust by Revenue Code or Line Item Code, you can input the codes manually or you can
upload a file with the code adjustments. Do one of the following:

l To enter the code adjustments manually:

a. Click +Add new record.
b. In the Code column, type the code, then press the Tab key.
c. In theDescription column, type a description and then press Tab.
d. In the Adjustment column, click the up or down arrow to reach the desired

adjustment number.
e. Click Save changes.
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l To upload a file of code adjustments:
a. Click Select Files.
b. Navigate to and select the file containing the codes and their adjustments.

IMPORTANT: The file should be an Excel file and must have three columns in the
following order: the first column must contain the codes, the second for the
descriptions but can be left blank, and the third should contain the adjustments.
If the Description column is left blank, the system will populate it from the
appropriate library.

The file’s contents display on the page:
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c. (Optional) If desired, you can edit the file contents from this page:
o Edit any entry by clicking it and making changes.

o Delete an entry by clicking the delete icon ( ) at the right end of the row and
then confirming the deletion.

o To add a new code line item, click Add new record and input values.
o To cancel an edit, click Cancel changes (you cannot cancel changes after

saving them).
o Click Save changes to save your edits.

7. Do one of the following:
a. To view how the adjustments affect your reimbursements, calculate the claims and then

view the Voucher details; or from the Reports menu, run any of the standard reports for
the adjusted claims.

b. To preview a new adjustment, select theNo Adjustment option, click Clear, and then
repeat the steps starting with step 4.

NOTE: You cannot select a different adjustment option without first clearing the
existing one. Clearing removes adjustments from all claims in the selected simulation.

The adjustment about to be cleared is listed before clearing. After clearing, Clear Adjustments reads “None.”

Administrator's Guide Axiom Contract Management │ 161



Grouping and pricing APC and eAPG claims
Many contracts include clauses or terms that include APC or eAPG reimbursement methods. Before
these contracts can be calculated, the claim line items need to be grouped and priced into APCs or
eAPGs.

Grouping and pricing can be a slow process when there are hundreds of thousands of claims, which is
why claims processing is usually done during the nightly import. However, you may need to group and
price claims on demand.

The Group and Price Claims page in the Claims section of Axiom Contract Management enables you to
set up, save, and execute claim grouping and pricing tasks. Previously, all grouping and pricing took place
either by a member of Client Success or during the nightly import process on claims coming into the
system. Now you can run this process anytime on selected claims. For information, see Group and price
APC and eAPG claims.

Additionally, you can also use the Shift Date By feature to view a forecast of how new schedules will affect
claims for the coming year.

Group and price APC and eAPG claims
For contracts with clauses or terms that include APC or eAPG reimbursements, you can group and price
claim line items into APCs or eAPGs. You can also run a projection of what future claims will look like by
shifting dates on claims forward in time to understand the impact of new CMS grouping and pricing logic.
For information, see Shift claim dates for grouping and pricing forecasts.

NOTE: Your system must have licenses for APCs and/or eAPGs.

To group and price claims:
1. From the Claims menu, select Group and Price.

2. From theGrouping/Pricing Typemenu, select the desired option:
l APC
l eAPG

NOTE: Only options for which you are licensed display.

3. In Select claims by, select the desired option:

� Patient Account Number
a. In the Patient Account # field, enter the patient account number.

b. From the Claim Status drop-down, select the status of claims to include.
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c. From the Simulation drop-down, select the simulation the claims are in.

� Claim Number/UCRN
a. In the Claim #/UCRN field, enter the claim number or UCRN.

b. In the Claim Status field, select the status of claims to include.

c. From the Simulation menu, select the target simulation for the claims.

� Date Range
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

d. From the Claim Status drop-down, select the status of claims to include.

e. From the Simulation drop-down, select the target simulation for the claims.

� Contract
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

NOTE: You do not have to select Start and End dates if you want to work with the entire
time frame selected by the provision/version.

d. From the Claim Status drop-down, select the status of claims to include.

e. In the Contracts section, from the Current View drop-down, select the target simulation.

f. In the Contracts section, select the contracts to include. You can select an entire contract,
only certain versions of a contract, or specific provisions of a contract.

� Insurance Plan Code
a. Select theDate Type.

b. For Start Date, click the calendar icon ( ) and select the date range start date.

c. For End Date, select the date range end date.

d. From the Claim Status drop-down, select the status of claims to include.
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e. In the Ins Plan Code table, from the Current View drop-down, select the target simulation.

f. In the Ins. Plan Code table, select the insurance plan codes to include. You can also select
an entire payer organization if desired.

4. Do one of the following:

l To perform the grouping and pricing now, click theGroup and Price button.
l To process the grouping and pricing later, save the selected claims as a grouping and pricing

task:

a. In the upper right of the page, type a name in the field provided.

b. Click Create a Saved Task

A confirmation message displays that the grouping/pricing task has been queued to run or saved,
depending on your selection.

NOTE: If you selected to save the claims as a group and price task, your task is listed in the
Saved Tasks tab, where you can run it at any time.

Shift claim dates for grouping and pricing forecasts
Users who group and price claims for APG and eAPG contracts can shift dates on claims forward in time
to accurately understand the impact of new CMS grouping and pricing logic for the upcoming year.

IMPORTANT: The shift claim dates feature works only in non-Live simulations.

When the new CMS grouping methods and schedules are released, you can get a forecast of how they
will affect your APC and eAPG claims reimbursements by running some of your historical claims through
the grouping and pricing process using the new rules. Normally, grouping logic prevents you from using
future logic against historical claims because they are service-date specific. However, if you shift your
historical claim dates into the next year, you can align your service dates with the 3M logic.

NOTE: You can also shift the dates backward in time by using a negative number of units. You might
do this if you want to knowwhat this year’s claims reimbursements would have paid last year.

The Group and Price Claims page includes a Shift Date By section that remains inactive until you select a
non-Live simulation in which to group and price your claims. You can use the date shift feature for any
claims selection method (Patient Account Number, Claim Number/UCRN, Date Range, etc.) as long as
you select a non-live simulation.
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To date shift a set of claims for grouping and pricing:
1. In themain menu header, click Claims >Group and Price.

2. On theGroup and Price Claims page, from theGrouping/Pricing Type drop-down, select the
type.

3. In the Select claims by section, select an option, For details, see Group and price APC and eAPG
claims.

4. From the Simulation drop-down, select the desired simulation.

IMPORTANT: The simulation must not be Live.

5. In the first Shift Date By field, click the up or down arrows to select the number of units to shift
the date by.

6. In the second Shift Date By field, click the drop-down and select the unit to shift the date by
(Days, Months, Years).

7. Click Group and Price.

8. After grouping and pricing, view the claim voucher report to see the results.

In the following example, the top of the voucher report shows that the service took place in 2013,
but on the bottom, you see that for calculating the expected payment, it used a future Grouper
Schedule, and therefore, a different Grouper Logic.
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Compare line-level APC calculation detail results
When running drill-down reports on claims and line items, you can include line-level calculation detail
results created from grouping and pricing APCs from any simulation configured for drill-down reporting.
You can do a side-by-side simulation comparison down to the line-level of detail to compare the impact
of APC schedule changes on a set of claims.

NOTE: Your Axiom Contract Management administrator sets up simulations for drill-down reporting.

Claims and Line-level APC results for up to four simulations at a time
In addition to the Live simulation, up to four simulations can be set up to handle reporting of APC detail
at the claim level. Previous to the 2019.3 release, we only stored grouped and priced APC results from the
Live simulation. Now, we have extended grouping and pricing to all other simulations. The fields that are
populated on the Claims and Line items tabs are available for the other four simulations selected for drill-
down reporting. This means there are four fields for each claim and line level field currently populated
during the group and price process (for example, fields such as PPSPayment, CoPay, Outlier, etc.).

Line Item tab Groupings:

l APC2
l APC3
l APC4
l APC5

Line Item tab Measures:
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l Expected Payment 2 - 5
l OPPS EPay CMS 2 - 5
l OPPS EPay Copay 2 - 5
l OPPS EPay Outlier 2 - 5

Claims tab Measures:

l Total OPPS EPay 2 - 5
l Total OPPS EPay CMS 2 - 5
l Total OPPS EPay Copay 2 - 5
l Total OPPS EPay Outlier 2 - 5

To use these new fields in a drill-down report:
1. Run an APC group and price against claims in a simulation mapped to drill-down reporting:

a. Ensure your simulation environment contains the APC contract(s) with the appropriate
Schedule(s).

b. Ensure your simulation environment is mapped to drill-down reporting. You may need to
verify this with the Axiom Contract Management administrator.

c. Group and price the desired set of APC claims for the desired simulation (or simulations, if
you are performing a comparison). For more information, see Group and price APC and
eAPG claims.

2. Create a drill-down report using the desired Claim tab or Line Item tab fields, then add filters to the
report as needed to limit the data included, and then generate the report.

For more information, see the following:

l Build a new drill-down report
l Apply filters to a drill-down report
l Export a drill-down report

Run a saved group and price task
These instructions are for running a saved group and price tasks from the Claims Group and Price Tasks
page.

To run a saved group and price task:
1. From the Claims menu, select Group and Price.

2. Click the Saved Tasks tab.

3. If needed, filter the list for the simulation and Task Type.

4. On the right side of the page, for the desired task, click Run Once.
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The page displays a brief notification that the task was queued.

5. To delete a task when finished, in the row for that task, click Delete.
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Calculating claims
Claims calculation is the process by which a claim is filtered through the defined contract structure to
generate a claim payment voucher and a total expected payment amount. Claims are calculated in Axiom
Contract Management in two ways:

l Nightly import process —Occurs during the import process and is done without any user
intervention.

l On-demand calculation —Users can perform ad-hoc claim calculation from the Recalculate Claims
feature, and also while viewing a claim from the Claim Detail page. Administrators can recalculate
claims from the Recalc History page, and calculate simulated adjustments to claim charges.

Typically, every claim that enters the system calculates automatically during the nightly auto-import
process; however, there are times when you need to manually recalculate a claim using the ad-hoc
methods.

You might need to recalculate a claim for several reasons. Themost common reason is a contract term
modification. If a claim is calculated on a specific clause of a contract and that clause is adjusted in a way
that the claim nowqualifies for another clause or rate, a recalculation is warranted.

� Automatic calculation
Every new claim entering the system that has a matching Contract → Version → Provision →
Clause/Term will automatically generate an expected payment during the auto-import process. This
ensures that new information entering the system can be used during reporting and other analysis. No
user intervention is needed, but it is important to note that if the contract structure is not kept up to
date, then new claims that enter the system will not generate an expected payment. It is also important
to note that even though a contract may exist for payer, if it is not modeled accurately, then the
expected payment information will probably be inaccurate.

Keep an eye on contracts approaching expiration and make sure to extend the expiration date (if
applicable), or model the new contract in Axiom Contract Management.

� Ad hoc calculation
You can select to recalculate a claim at any time using the Recalculate Claims feature (Claims >
Recalculate). You can recalculate claims by a variety of criteria:

l Recalculate by patient account number
l Recalculate by Claim Number/UCRN
l Recalculate by Date Range
l Recalculate by Contract
l Recalculate by Insurance Plan Code
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NOTE: You can also recalculate a claim from the Claim Detail page.

Recalculate a claim
Each of the following criteria give you more flexibility in determining which claims to recalculate.

l Patient Account Number and Claim Number/UCRN are typically used to calculate single
accounts/claims.

l Date Range and Contract allow you to select several claims at once for calculation.
l Insurance Plan Code allows you to recalculate all claims that have a specific payer code.

You select the claim to calculate in the Claim Type field. Your options are Institutional, Professional, or All.
Since professional claims are stored in Axiom Contract Management as separate bills, you must select
the appropriate Claim Type before calculating a claim.

The Claim Status field allows you to select whether to calculate on the Live accounts for a particular
account # or all accounts (Live and Inactive).

NOTE: Reports in the system are based on the Live accounts, so it is not always required to
recalculate inactive claims unless you are including those in your analysis.

To access Recalculate Claims:
In themain menu header, click Claims > Recalculate.

The Recalculate Claims page is displayed. Use the criteria explained in the following sections when
determining what to calculate.

NOTE: You can also recalculate a claim directly from a claim’s Claim Detail page. For information, see
Recalculate a claim from Claim Detail.
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� Recalculate by Patient Account Number
You can calculatemultiple accounts simultaneously by separating account numbers with a comma. If
there are claims that match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by account number:
1. In the Recalculate Claims tab, click the Patient Account Number option.

2. In the Patient Account # field, enter the account number.

3. From the Claim Type drop-down, select the type.

l Institutional
l Professional
l All

4. From the Claim Status drop-down, select the status:
l Live Claims Only
l All

5. From the Simulation drop-down, select the simulation.

6. Click Recalculate.

� Recalculate by Claim Number/UCRN

IMPORTANT: This option should only be used if you are using the system’s Claim Number / UCRN
feature.

If any claims match your criteria, a message displays that says the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

To recalculate by Claim Number / UCRN:
1. In the Recalculate Claims tab, click the Claim Number/UCRN option.

2. In the Claim #/UCRN field, type the number.

3. Select the Claim Type:
l Institutional
l Professional

4. Select the Claim Status.

5. Select the Simulation.
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6. Click Recalculate.

� Recalculate by Date Range
The date range option allows you to select all claims that fall between a specific date range and
recalculate them.

To recalculate by date range:
1. In the Recalculate Claims tab, click theDate Range option.

2. In theDate Type field, select the type of date:

l Discharge Date – Date the account was discharged
l Admit Date – Date the account was admitted
l Submission Date – Date the bill was submitted to the payer for reimbursement

3. For the Start Date and End Date fields, select the desired dates.

You can enter dates manually, or use the drop-down calendar. Clicking any date sets that as your
start/end date.
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4. Select the Claim Type:
l Institutional
l Professional

5. Select the Claim Status.

6. Select the Simulation.

7. Click Recalculate.

If there are claims that match your criteria, a message informs you that the recalculation task has been
queued successfully. If no claims match your criteria, a message informs you that no claims met your
selected criteria, and to try again.
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� Recalculate by Contract
Selecting the Contract option allows you to select whole contracts. Calculating by contract gives you
added flexibility by allowing you to filter down into contracts, versions, or even to the provision level. For
example, to calculate only an outpatient provision of a contract, you can drill down to that provision and
select it for recalculation.

In the following example, a user is recalculating provisions 6 and 7 of their Cigna PPO contract, as well as
their entire ORG2 - BCBS contract.

Notice that the Contract option also includes the same features as the Date Range selection dialog,
allowing you to narrow your criteria even further.

To recalculate by contract:
1. In the Recalculate Claims tab, click the Contract option.

2. In the Contracts table, from the Current View drop-down, select the desired simulation.

3. Select the desired contract/version/provision to recalculate. You can select more than one.

4. In theDate Range section, enter the date range criteria (if you want to calculate the entire
contract, then entering date information is not required).

5. In the Enter a name for the task field, type a name for this recalculation.
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6. Click Recalculate.

If any claims match your criteria, a message informs you that the recalculation task was queued
successfully. If no claims match your criteria, a message informs you that no claims met your selected
criteria, and to try again.

� Recalculate by Insurance Plan Code
This option allows you to calculate claims for a single insurance plan code instead of calculating all the
insurance plan codes assigned to a contract version. For example, you can use this option when a new
insurance plan code has been added to a version and you do not want to re-process an entire version
and all plan codes, just the claims with the new code.

To recalculate by insurance plan code:
1. In the Recalculate Claims tab, click the Insurance Plan Code option.

2. In theDate Type field, select the type of date:

l Discharge Date – Date the account was discharged

l Admit Date – Date the account was admitted

l Submission Date – Date the bill was submitted to the payer for reimbursement

3. For the Start Date and End Date fields, select the desired dates. You can enter dates manually, or
use the drop-down calendar. Clicking any date sets that as your start/end date.

4. Select the Claim Type:

l Institutional
l Professional

5. In the Claim Status field, select whether to use Live claims or All.

6. In the In. Plan Codes table, do the following:
a. In the Current View field, select the desired simulation.

b. In the list of insurance plan codes, expand the organization and select the check box for the
desired code. You can select as many codes as desired. You can also select the parent Org.
code instead, which recalculates all claims that have that Org. code, including all the Payer
codes associated with that Org code.

7. Click Recalculate.

Save and schedule calculations
You can name and save calculation tasks and then schedule those tasks to run using the Axiom
Scheduler. This feature is great for repetitive calculations or when you need to schedule a large
calculation to run after hours or on a recurring, scheduled basis.
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To save and schedule a calculation:
1. In themain menu header, click Claims > Recalculate.

2. In the Recalculate Claims tab, select the claim to calculate.

3. In the Enter a name for the task field, type a name for the recalculation.

4. Click Create a Saved Task.

5. In the Desktop Client, in the Explorer task pane, access the Scheduler at Libraries > Scheduler
Jobs Library > Contract Management.

6. If needed, create a new job for the calculation. Please see Scheduler for more details regarding
assigning and completing jobs and tasks using the Scheduler.
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You can access and run your saved tasks.

Run a saved recalculation task
You can rerun your saved recalculation tasks.

To run a recalculation task:
1. From the Claims menu, select Recalculate.

2. On the Claims page, click the Saved Tasks tab.

The list of saved Recalculation Tasks displays all the saved tasks in all the simulations, by default.

3. If desired, from the Simulation drop-down, select the desired simulation to filter the list of tasks.

4. Locate the tasks to run and then, in the task row, click the Run Once button.

A briefmessage displays that the task has been queued to run, and the “0” in the Recalculations
Queued section changes to “1” (or the number of tasks you selected to run).

5. To delete a task, click theDelete button in the row for that task. In the confirmation dialog, click
OK. A briefmessage displays that the task has been deleted.

Recalculate a claim from Claim Details
Users modeling contracts can now recalculate a claim from the Claim Details page instead of using the
Recalculate Claims page if they want to recalculate just the claim they are viewing. This feature allows you
to recalculate a claim and then refresh the page to view the recalculation without having to navigate
between different pages and dialogs.
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To recalculate a claim from Claim Detail:
1. From the Claims menu, select View a Claim.

2. Locate and view the claim.

3. In themenu on the left, click Recalculate.

In the Queued Tasks section (on the right in the blue header), the “0” changes to “1.”

NOTE: If you already have recalculations waiting in the queue, or if other users have
calculations waiting in the queue, the number is incremented. If you select another claim to
recalculate before the first one is finished, the number increments again.

When the “1” changes back to “0,” the recalculation is finished.

4. Refresh the page in your browser to view the recalculation results.

The data in the Last Recalc: field has changed to reflect the new recalculation date.
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For additional recalculation options or to recalculatemultiple claims, use the Recalculate Claims feature.

View claims recalculation history and rerun claims
Administrators can access a history page for recalculated claims. The Recalc History page contains a log of
all recalculated claims, whether recalculated in a batch or individually, and the ability to rerun any listed
recalculation.

The history includes:

l Recalc ID – Recalculation ID number
l Run By – Username of person/entity/process that ran the recalculation
l Start Date/Time – Start date and time of the recalculation
l End Date/Time – End date and time of the recalculation
l Claims Selected – Number of claims selected for recalculation
l Claims Processed – Number of Claims Selected that triggered a contract clause/term for payment
l Error Count – Number of errors that occurred during processing. Any errors found are displayed

at the bottom of the page in the Recalc History Errors section.
l Recalc button – Click to rerun any of the listed recalculations
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To access the Recalc History page, from themain menu, click Admin > Recalc History.

Verifying claims reimbursement calculation
Claims are automatically calculated during the nightly import process. However, theremay be cases in
which a claim does not calculate an expected reimbursement. Use the following list of checkpoints to
ensure that claims are calculated properly, and to help you figure out why an expected reimbursement
did not calculate as expected.
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Claim calculation checkpoints

� Step 1: Verify that the claim dates fall within the contract version Start and
Expiration dates
Navigate to the contract version and check the Start and Expiration dates. For a claim to calculate
correctly against a contract version, the dates on the claim must fall within the contract version’s date
range, which is its active period.

� Step 2: Verify that the Payer Code on the claim matches a code assigned to the
contract

1. In Ins. Plan Code column of the contract version, click the View/Edit button.

2. In the Insurance Plan Code dialog, look in the Payer Code column and confirm that the claim
insurance Payer Code is assigned to the contract:
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� Step 3: Verify that the Claim Bill Type is built into the contract version Provision
1. On the contract version row, click theDetails link to go to the Provision page.

2. On the Provision page, select the desired provision by clicking the blue square at the beginning of
the row. The row is highlighted light blue.

3. In the sidemenu, click Convert. The Provision Settings dialog opens, displaying the Types of Bill on
the provision. You may need to expand the top category row to see the underlying bill types, as
shown in the following example.

� Step 4: Confirm that the claim has criteria that match the contract build
1. Review the claim and compare the criteria to verify that it matches the capture data specified on

the contract clause/term.
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2. Check that the contract also has a clause that captures non-reimbursable claims. In addition to
criteria that catches reimbursable claims, each contract should have a final clause that captures
non-reimbursable claims. Without a capture clause/term, the claim will not calculate expected
reimbursement. In the following example, a No Qualifying clause is used.
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Working with standard reports
This chapter covers building a standard report.

Access standard reports
Use these instructions to access standard reports in Axiom Contract Management.

1. In themain menu header, click Reports > Reports.

The Reports page opens to the Report List tab. All previously saved reports are located here.

8
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2. Do one of the following as desired:

l To create a new report, click theNew tab, and then follow the instructions in Create a new
standard report.

l To view an existing report, select the report from the list and then click the View/Edit tab.

Create a new standard report
Use these instructions to create a new standard report.

To create a new report:
1. In themain menu header, click Reports > Reports.

2. Click theNew tab.

3. In the Report Name field of the new report form, type a name for your report.
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4. From the Report Type drop-down, select the type of report template to run.

5. Select a report date range. The report parameters available depend on the selected report type.
All reports have a date range parameter. You need to set a Start Date and an End Date for the
report.

a. In the Start Date field, click the drop-down and select a date from the calendar.

b. In the End Date field, click the drop-down and select a date from the calendar.
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6. If the type of report you are creating requires you to select a contract against which to run the
report, from the Contract drop-down, select an existing contract.

7. If the type of report you are creating requires other parameters, these display in the Parameters
section. Select any that apply to your report.

8. To add filters to your report, in the Parameters heading bar, click the arrows to the left of the
Advanced button. Do one of the following:

l From the Filter drop-down, select a filter.
l Build a filter.

9. Click Save. The report generates.

View a standard report
After the standard report is processed, the system displays the report in theWeb Client. The initial view
is the detailed view, meaning most of the rows are expanded, except for themost granular level; those
usually are collapsed, with a boxed plus symbol to the left of the rows. Expanded rows have boxed minus
symbols to the left.

To change the view of a report:
l To expand the details for an item, to the left of the item, click the plus symbol (+) (outlined in red in

the following example).
l To access a claim from a report, expand the account row and then click the account number link.
l To view selected filters, on the left above the blue report column headings, click the plus symbol

next to Selected Filters.

NOTE: These are not the same as Advanced Filters.

l To hide report details, click theHide Detail check box(outline in green in the example) and then
click Save. Report details usually include themost granular level of detail in a report, such as
individual claim level account numbers and patient account information.

l To change the size of the report on the page, select an option from the Page Width drop-down
(outlined in orange in the following example).
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Report example

Export a standard report
Exporting reports to Microsoft Excel can be a useful tool for additional claim and data analysis. Exporting
to Excel allows you to perform enhanced data sorts, comparisons, calculations, and edits.

To export a standard report to Excel:
1. Navigate to the desired report.

2. In the gray toolbar at the top of the report, click the Export to drop-down, and select Excel.

A Download button displays to the right of the export drop-down, which now displays as “Excel.”

3. Click Download. The Excel file name displays in the lower left corner of the page. Click the file to
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open it.

4. In Excel, you can expand report details similarly to the way you do in Axiom Contract
Management: by clicking on the plus icon (+) to the left of an item.

Example report with expanded filters

5. To expand all filters, click the number of highest value in the group that sits just above and to the
left of cell A1.

Each greater number represents a deeper level of expansion. In the image below, number 5 has
expanded the report down to the claim level.
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Example of fully expanded report

Edit or delete a standard report
Use these instructions to modify and save an existing standard report, or to delete a standard report.
You can make changes incrementally if you want, by saving the report after each parameter change.

These instructions are generalized; not all reports contain the report parameters used in these
instructions, and some reports contain parameters not mentioned here.

NOTE: You cannot change a report’s type.

To modify a standard report:
1. In the Report List tab on the Reports page, click the report to edit and then click the View/Edit
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tab.

2. To change the report name, in the Report Name field, type a new name.

3. To change a date parameter, expand the Parameters section if needed, and then select a new date
range from the start and end date drop-downs.

4. To change the report’s simulation, in the Simulation drop-down of the Parameters section, select
a different simulation.

NOTE: If you change the simulation, you may be required to change the contract as well, since
contracts are simulation specific.

5. To change the contract, in the Contract drop-down of the Parameters section, select the desired
contract.

6. To add a filter to the report:
a. Click the arrows to the left of the Advanced button to open the Advanced parameters.

b. From the Filter drop-down, select the desired filter.

7. Click Save.

To delete a standard report:
1. In the Report List tab on the Reports page, right-click the desired report and select Delete.

2. In the confirmation dialog, click OK to delete the report.

Run APC and eAPG Edits Reports in any simulation
You can run APC/eAPG edit reports targeting a simulation environment other than Live. Although there
is a Simulation drop-down menu for this report, previous to the 2019.1 release, the report always ran on
the Live simulation for APC/eAPG reports, regardless of the simulation selected. Now you can view edits
that occur on APC and eAPG claims grouped within any given simulation.

To run an APC/eAPG Edits report:
1. Click Reports > Reports.

2. Click theNew tab.

3. In the Report Name field, type a name for this report.

4. From the Report Type drop-down, select one of the following:
l Edits - EAPG
l For APC, Edits - OCE APC.

5. Expand the Parameters section if needed, and select a Start Import Date and an End Import Date.

6. From the Simulation drop-down, select the desired simulation.
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7. From the Contract drop-down, select the desired contract(s).

8. Click Save.

The report generates.
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Working with drill-down reports
Axiom Contract Management’s drill-down reporting feature enables you to createmulti-level, complex
reports with expandable / contractible sections. Drill-down reports are interactive and highly modifiable.
After generating a report, you can sort and rearrange columns, add or delete additional rows or columns,
apply or remove filters, etc.

Accessing drill-down reports
To access Drill-Down Reports:

l In themain menu header, click Reports >Drill-Down Reports.

Drill-Down Reports opens in a new browser tab. To get started, see Organizing drill-down reports.

9
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Organizing drill-down reports
The initial page displays your organization’s drill-down report folder structure that stores all previously
saved reports. From this page, you can add a new folder to the structure, search for and open a saved
report, or click Create New Report to access the report builder.

Drill-down reports page example

The system comes with the following folders:

l Claims
l Line Items

You can add and delete folders, and create additional subfolders as desired.

IMPORTANT: Be aware that when you make a change to any of the folders, it affects all users.

This initial set-up categorizes reports by type of report. Other options may be User Name or Department.
How facilities use the folder structure is up to them.

� Add report folders
First determine whether the new folder should be for a new category or a subcategory.

To add a new category folder:
1. In the Categories panel on the left, click +Add New.

This creates a new folder named NewCategory# that you can rename.

2. Rename the new category and then press Enter.

The new folder sorts alphabetically into the structure.
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To add a new subcategory folder:
1. In the list of categories, right-click the existing category, and select Add New.

2. Rename the subcategory, and press Enter.

If a category has subcategories, an arrow icon (>) displays to the left of the Category name. To
display all subcategories, click the arrow.
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� Edit or delete report folders
You can rename or delete report categories and subcategories.

To rename a category or subcategory:
1. Right-click the category, and select Rename.

2. Change the name, and then press Enter.

To delete a category or subcategory:
1. Right-click the category, and select Delete.

2. In the confirmation dialog, click OK.
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� Edit the folder structure
You can rearrange folders and subfolders by dragging and dropping them to new locations. You can
move reports within folders the sameway. Just keep in mind that any changes you make to a folder’s
structure or contents affects all users.

To move a folder to a different category folder:
l Drag a folder or subfolder to another category folder. Release themouse button when the

destination folder name changes color.

In the following example, the user drags the Line Items folder to the Department Denials folder.

� View the list of reports in a folder
To see the reports saved in folders:

1. Click the folder name. The reports display in the right pane under the name of the folder.
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2. To view summary details about a report, click the report name.

An information box displays just below the report name, showing more details about the report,
including the dates the report was created and last modified, the name of the user who modified
it, and any notes that were added when the report was saved.

3. To close the summary details box, click the name of the report again.

� Edit report summary information
In addition to viewing report summary information, you can edit the report name, description, and
folder location.

To edit report summary information:
1. To modify the report name, description, or folder location, on the left of the description, click Edit

info.

Administrator's Guide Axiom Contract Management │ 198



2. In theUpdate Report Detail dialog, edit the desired information, and then click Save.

Configuring drill-down reports
When you view a report with the Columns panel open, the Groupings and Measures tabs display on the
left side of the page. (By default, opened reports initially display with the Columns panel closed.)

Report shown in flat view

These tabs contain all of the data elements available for building reports. When building a report, always
select at least one item from Groupings and at least one item from Measures.
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� Organizing groupings and measures
When organizing groupings and measures, you can use the provided folder structure or create your
own. You can customize the tabs by adding, deleting, and rearranging folders to organize the groupings
and measures data elements as you wish. The folder structure built by one user has no effect on any
other user, nor does how you choose to organize the data elements. However, data elements remain
within their designated tab, Groupings or Measures, and sort alphabetically within their folder. Measures
sort alphabetically first by standard measures, then by calculated fields.

To create a new folder:
1. Determine where the folder should be created.

l To create a main folder, click Groupings (orMeasures), and then click Add New.
l To create a subfolder, first click themain folder, and then click Add New.

A new folder displays, prompting you to name it.

2. Type in the name and press Enter.

In the following image, Dates is a main folder containing two subfolders: Admit and Discharge.

To delete a folder:
1. Click the selected folder.

2. At the top of the tab, click Delete.

3. In the confirmation dialog, click OK.

NOTE: You cannot delete a folder with contents. Delete or move the folder’s contents and
then delete the folder.

To move data elements between folders, do either of the following:
l Drag-and-drop the data element from its current location to the new folder.
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l Right-click the data element, and click Cut. Then right-click on the new folder location, and click
Paste to move the data element.

About drill-down report fields
The following fields are used in drill-down reports.

� Groupings
These fields display as a grouping of rows in the report, in column format. All information requested in
the report is totaled by the selected Grouping. In a report, the first grouping displays as the first column.
Any additional groupings selected are a subgroup of the first grouping picked.

� Measures
These fields display as columns in the report.
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Threemain functions are available to calculate a measure: sum, average, and count. You can also choose
to display themaximum or minimum value for the field.

Measure names displayed in black text are standard measures in the system. Measure names in blue
text are user-defined calculated fields, as shown in the following example.

Calculated fields are listed alphabetically beneath the standard measures in the folder they are saved in.
You automatically see calculated fields in your display. Calculated fields created by other users default to
the folder “Other Users’ Calculated Fields,” which is a subfolder ofMeasures.
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Calculated fields are used to create custom measures in the system. For instructions on creating
calculated fields, see Add calculated fields to a report.

� Add Filters
Use the Add Filters button to select specific criteria from the database to incorporate into a report. Note
that a filter is not required to run a report. However, if no filters are applied, the entire database is
queried.

The Add Filters button displays on the bottom right of the page when you open a drill-down report or
edit or create a drill-down report.

See Apply filters to a drill-down report and the section on Editing and filtering drill-down reports for more
information.

� Claims tab
The Claims tab pertains to all information found on a claim. This information is only available for claims
filed and subsequently imported into Axiom Contract Management. The available Groupings and
Measures are provided in the Columns panel on the left side of the page.

Use the Claims tab to report claim and contract information. You can generate reports to analyze actual
contract performance as well as expected profitability using expected payment information. You can
generate Detailed Tracking Reports to track underpayment recoveries by payer.

� Line Items tab
The Line Items tab provides details from the claim form at the line item level. Only patients whose claims
were filed and subsequently imported into Axiom Contract Management are available. The available
Groupings and Measures are listed in the Columns panel on the left side of the page.
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Use the Line Items tab to report on data at the line item level, including Revenue Code, Service Date, and
Quantity detail.

� Applied Filters
The Applied Filters button is located at the bottom left of the page. The Applied Filters dialog displays all
of the filters applied to the current report.

l To display all the filters from the Claims and Line Items tabs that you selected to apply to the
current report (see the following example), click the up arrows on the Applied Filters button.

l To delete a single filter, click to the left of the value, and press theDelete key.
l To remove all filters, click Clear All on the right of the page. If no filters are attached to a report,

the system will search the entire database for results.

Viewing drill-down reports
All saved reports are available when you first open Drill-Down Reports. The Category section on the left
side of the page contains the folders in which saved reports are stored.

� Open a saved report
To open a saved report:

1. In the Categories panel, click the folder where the report is stored.

2. Hover your cursor over the report name, and click View.
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The report generates and opens.

After generating the report, you can edit it, change the design view, or export it to Excel. Building
and editing reports is covered in Building reports.

3. When finished viewing the report, to return to themain Drill-Down Reports page, in themenu bar,
click Reports >Open.

To open a saved report while working elsewhere in Drill-Down Reports:
1. In themenu bar at the top of the page, click Reports >Open.

You are taken back to the Drill-Down Reports opening page.

2. Click the folder in which the report is stored.

3. Hover your cursor over the name of the report, and click View.

� Open and close the Columns panel
When you open a saved report, the system generates the report and displays the results using the full
page. In this view, you do not see the Groupings and Measures tabs in the Columns panel because the
panel is minimized.

To maximize the panel, click the arrow to the left of the results. In the following images, the one on the
right shows the bar the arrow resides on in blue. You can click anywhere on this bar to maximize and
minimize Columns panel.

Administrator's Guide Axiom Contract Management │ 205



Likewise, while working with a report, you can minimize the Columns panel by clicking on the same bar,
as shown in the following example.
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Building drill-down reports
Use the NewReport page in Drill-Down Reports to create new drill-down reports. To update existing
reports, see Editing and filtering drill-down reports.

Build a new drill-down report
Use these instructions for building a new drill-down report. Creating a report that has filters, and saving it
in the drill-down interface, saves the advanced filter.

To build a new report:
1. Navigate to the Drill-Down Reports page.

2. Do one of the following:
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l Near the top of the page on the right, click Create New Report.
l In the header menu, click Reports >New.

3. Of the tabs on the right side of the page, click the tab for the type of data being retrieved. The
Claims and Line Items tabs contain information found on the patient’s UB04 or 837 claim forms,
and reside within Axiom Contract Management.

On the left side of the page are two tabs, Groupings and Measures.

NOTE: You must select at least one parameter from both tabs to generate and display a
report.

4. On the left side of the page, in theGroupings tab, click the plus sign (+) to expand any folders as
needed to locate report groupings options.
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5. Double-click a groupings option to add it to the report. When added, that option displays on the
right side of the page above the Generate button, as shown in the following example. Select more
row groupings if desired.

NOTE: If you select more than three groupings, only the first three display when you generate
the report in hierarchical view. All groupings display when you generate a report in flat view.

6. Click theMeasures tab, expand any folders as needed, and then double-click the desired
measures, one at a time, to add them to the report. If you do not see themeasure you need, you
can create one. See Add calculated fields to a report.

l To add a measure to the report as SUM of that measure, double-click themeasure.
l To add a different calculation, right-click themeasure, and select a calculation option from

themenu as shown in the following example.
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When you chose the calculation option for the desired measure, the selected measure
displays to the right of the selected grouping. This is the order in which the columns in the
report display. You can rearrange them or delete a grouping or measure before or after you
generate the report if you change your mind.

l To remove any selected options from the report before generating, right-click the option,
and select Delete.

l To rearrange report columns, drag and drop the columns to the desired order. In the
following example, the user drags themeasure COUNT claims to themiddle row. The red
arrows showwhere themeasure label will start, which in this example, is after Payer Code:
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7. In theData View section to the right of the Generate button, select the report grid type:
l Hierarchical – Select this option to display the report with grouping columns arranged in a

hierarchy.
l Flat – Select this option to display the report with grouping columns arranged side-by-side.

8. Click Generate.

9. If desired, save the report so you can use it later.

Add calculated fields to a report
If you need a measure that does not exist, you can build a calculated field. You create calculated fields by
choosing current measures and creating expressions with mathematical functions to calculate the
desired results.

To create a calculated field:
1. Open the drill-down report to which you want to add a calculated field. If you are creating a new

report, select the tab for the type of report (e.g., Claims or Line items).

2. In themenu bar at the top of the page, click Reports > Create Calculated Field.

The NewCalculated Field dialog opens.

NOTE: You cannot use a calculated field in an equation for another calculated field.
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3. Do one of the following:
l To use filters from a saved report, click theUsing option and then select a report from the

drop-down list. Reports available in this list are based on the tab that you are on when
building the calculated field. A calculated field on the Claims tab can use only the filters from
other Claim reports.

NOTE: Using the filters option limits the calculated field to only the claims found in the
selected saved report. For example, to compare pediatric claims to all claims, you need
to create a calculated field for SUM(claims) with a filter from a report limited to pediatric
claims. You can select only one report to apply as a filter to a calculated field. However,
the report used for the calculated field can contain as many filters as you need.

l If you do not want to use a filter, leave the default Not using selected.

4. Build the expression by selecting measures from theMeasures list on the left:
a. Click the desired measure, and select the desired function from the list of available

functions. Themeasure is added to the Expression box. Now you need to add an operator
or mathematical symbol.
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b. Click the Functions button to select the desired operator, or, for a mathematical equation,
use themathematical symbols on your keyboard (+ - / *) for add, subtract, divide, and
multiply, between your measures to string them together.

NOTE: Do not use special characters, such as dashes and slashes, in a calculated field
name.

TIP: If you make a mistake with the expression, click Clear All and start over.

c. Add the next measure and symbol, as needed, until your expression is complete.

TIP: If you know the complete expression, you can type it into the Expression box
manually instead of selecting Measures and Functions from themenus.

d. Click Save.

e. In the Save As dialog, select a location to store themeasure on theMeasures tab, and then
in theName field, type a name for it.

f. Click Save and Return.

The newmeasure name displays in blue text on theMeasure tab in the folder you selected.
The name becomes a column header when added to a report.

Edit or delete a calculated field
Use these instructions for managing your calculated fields.
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To edit a calculated field:
1. In the Columns panel, click theMeasures tab.

2. In theMeasures list, right-click the desired calculated field, and select Edit Calculated Field.

3. In the Edit Calculated Field dialog, do any of the following as desired:
l To clear the entire expression in the Expression box, click Clear All and then rebuild the

expression.
l To replace part of the expression, use the backspace key to remove the part you want.
l To add a measure, in theMeasures list, click the desired measure, and select the calculation

type from the pop-up menu.
l To add an operator between measures, type a mathematical symbol (+ - * /) or click the

Functions button, and select a function.

4. Do one of the following:
l To save themeasure as a newmeasure, click Save As and then, in the Save As dialog, select

a location for themeasure. In theName field, type a new name. Click Save and Return.
l Click Save.

To move a calculated field:
1. Right-click the calculated field, and select Cut.

2. Select the desired location / folder in theMeasures tab, right-click and select Paste.

TIP: You can also drag and drop calculated fields to different locations in theMeasures tab.
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To delete a calculated field:
1. In theMeasures tab, right-click the calculated field, and select Delete.

2. In the confirmation dialog, click OK.

NOTE: You cannot delete calculated fields that are attached to a report.

Apply filters to a drill-down report
Use these instructions for applying filters while building a drill-down report. Filters enable you to more
precisely select data from the database for your reports.

To apply filters:
1. On the bottom right of the page, click Add Filters.

2. To change the type of filter you are applying, click the Filter by drop-down, and make a selection
(see the following example). Each type has an underlying folder structure that groups together
similar data elements.

3. In the Fields section, click the plus symbol (+) next to the type of field you want, to view the fields
available in that folder.
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4. To select a filter to apply to the report, click the filter name.

For some filters, a list displays of the data values you can select for that filter.

For other filters, a drop-down list provides selection options:
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� To search for filter values:
l Do one of the following:

o Scroll down the entire list until you find the desired value, then click the check box
next to the value, and click theUse These button on the right to save the value.

o If you know the exact value to filter with, type it into the box, and then click Filter.
The system displays this value. Click the box and then click Use These to apply the
filter.

o Use the wild card feature. If you do not know the exact value for the filter but you
know some or part of the value, type the percent (%) symbol in the field along with a
known portion of the number/text, and click Filter. This shortens the list of values to
search from. For example, to find a certain ICD Procedure number that relates to the
heart, type “%heart.” The system provides all the ICD Procedure codes that include
the word “heart” in the description. Select the desired value(s), and click Use These.
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l Additionally, you can select more than one filter value by selecting multiple check boxes.

l To select all of the values except one, click Check All, which selects all of the filter values.
Then, you can simply uncheck the values that you do not want to use in the report.
Remember to click Use These to set the filter.

5. Each time you select a filter, click Use These to set this filter for the report.

6. After selecting the desired filters, at the bottom left of the page, click Applied Filters to view the
filters and confirm the selected criteria.

7. After adding all of the groupings and measures to the design view and applying the filters, click
Generate to view the results. The results of the report display.
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Save a drill-down report
Saving a drill-down report saves all of the selected groupings, measures and filters, and any changes to
the report format or layout.

We recommend that you save the report while viewing the report layout. This ensures that the report is
saved as the correct type (Claims or Line Items).

Report layout view
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To save the report:
1. In themenu header at the top of theDrill-Down Reports page, click Reports > Save.

The Add NewReport dialog opens. The Tab field defaults to the Report tab that you were on when
you saved the report.

2. In the Folder field, select the folder in which to save the report.

3. In theName field, type a unique name for the report. Give the report a name you can easily
remember and identify later.

NOTE: When naming a report, do not use special characters such as dashes or slashes.

4. If desired, in theDescription field, type a detailed description of the report.
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5. Click Save.

You can continue to work on the report and either save the changes or select Save As to save as a new
report with a new name.

Export a drill-down report
Use these instructions to export a copy of drill-down report results to Microsoft Excel, which transfers the
report into an Excel spreadsheet.

The system defaults to Export Row State (Expanded or Collapsed) and Export Filter Information. If you do
not want to export any of these features, highlight and click the desired setting to clear the check mark.

To export a drill-down report:
1. Generate the report.

2. In menu header above the report results, click Settings > Export to Excel, and then select the
following as desired:

l To include the ability to expand entire row levels at a time, click Export Row State
(Expanded/Collapsed).

l To include a list of filters applied to the report in the report results, click Export Filter
Information.
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l To verify your selections, click Settings > Export to Excel The option(s) you selected should
have a check mark to the left, as shown in the following example:

3. Below the dark gray menu header, click the blue Export link.

The report generates. This may take several minutes if the report is long.

The report file downloads to your computer, and a link to the file displays in the bottom left
corner of the page, as shown in the following example.

4. At the bottom of the page, click the Excel file to open it.

The following example shows a report generated in hierarchical view that was exported with the
options Export Filter Information and Export Row State (Expanded/Collapsed) selected.

The applied filters export as a collapsible list above the report results, for reports in flat view and in
hierarchical view (see list outlined in red in the following example).
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Each report level has its own expand/collapse button ( ) to the left, which you can use to
expand and collapse report sections.

On the left, above the list of filters, is a row of numbered squares (outlined in blue in the following
example). Use these buttons to expand/collapse all rows of the level that corresponds to each
button.

5. To view report details, do any of the following:

l To expand/collapse individual rows, click that row’s buttons ( / ).

l To expand all level 1 sections, click the second square ( ) in the row.

l To expand all levels, click the last square in the row, which is the third square ( ) in the
example.

l To collapse all expanded sections, click the first square ( ).

Editing and filtering drill-down reports
Drill-down reports are interactive, allowing you to filter the report to display only what you want.
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Report filtering options
Several buttons, icons, and drop-down menus display in rows above the gray shaded field names on a
generated report. These functions allow you to further edit the report.

� Limit button
The Limit button sets additional report filters. For example, to display results for Emergency and Urgent
only, select the check boxes to the left of their names, and click Limit.

This sets these Admit Type selections as an additional filter. They will be the only results displayed:

To remove applied limits, see Remove an applied filter.

� Rows menu
Use the Rows menu to make selections from the results. For example, if you sorted charges in
descending order to reveal the Admit Sources with themost charges and you are only interested in the
top five Admit Source, click Rows > Select > First 5, which selects the first five names displayed.
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l To display the top ten, go back to Rows > Select >Next 5, which selects the next five Admit
Sources listed.

l To display only the top four Admit Sources:

a. Select Rows > Select >None; this clears all of the selected Admit Sources.

b. Manually click the top four in the report. When all desired Admit Sources are selected, click
Limit to remove all of the non-selected Admit Sources from the view, displaying only those
selected.

NOTE: When you select and limit rows of data from the results, this information is set as a
filter, which is then visible in the Applied Filters dialog. If you make an error, open the Applied
Filters dialog, and remove the new filter.

You can also use the Rows menu to expand and collapse sub-grouped rows when a report uses multiple
groupings.
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� View menu
Change the grid type between Hierarchical and Flat. This is the same as selecting Flat view or Hierarchical
viewwhen viewing the report in design view.

For examples of how to use these views, see Add a grouping as a subtotal.

� Settings menu
Use this menu to set the formatting for reports exported to Excel.

For instructions on exporting a report using this menu, see Export a drill-down report.

� Design View
Design View is report-building view. In Design View, you can add, delete, or rearrange the groupings and
measures in a report. Although the following example shows a new report, you can edit existing reports
in Design View. For instructions, see Change report column order.

Groupings and measures are added to the system in the order they were selected, with groupings placed
beforemeasures. However, you can change the order of groupings and measures at any time (groupings
still order together beforemeasures). For instructions, see Change report column order.

Sort report columns and rows
When building a report, you can easily sort and rearrange report columns.
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After generating a report, you can modify the results using various functions. For example, you can alter
or sort data, add or delete additional rows or columns, or continue to drill down into the report to view
more specific results.

As an example, the following image displays partial report results using the following criteria:

l Filter: DRG = 291, 292, 293
l Grouping: Admit Source
l Measures: Sum Claims, Sum Total Charges

To sort report columns:
l Click one of the gray report column headings. A small up or down arrow displays to the right of the

column name to indicate the column is sorted in either ascending or descending order.
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l You can also sort columns by right-clicking a column heading and selecting Sort, and then from
the pop-up menu, selecting Ascending or Descending.

l Right-click a measure heading to get the same options, and to select a decimals option which,
when highlighted, lets you adjust the number of decimal places displayed in your data, as shown
in the following example.
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Add a grouping as a subtotal
When you build a report with more than one grouping, the system subtotals the second grouping
underneath the first. For example, to see all of the Bill IDs associated with each Admit Source, double-
click the Bill ID field in theGroupings tab. The system displays the following:

After generating, the report displays a plus symbol (+) to the left of the check box in each row:

To display all of the rows that subtotaled under a field value, click the plus symbol (+). You can sort or
delete these subtotaled rows, as well as sort the columns.
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When building reports with multiple groupings, the system defaults to the Hierarchical view as seen in
the previous image. This is one of two views available for displaying data. The other is the Flat view. The
Flat view displays groupings side-by-side, as shown in the following example.

NOTE: Reports with more than three groupings must be run in the flat view. Also, while the
hierarchical view subtotals the groupings, the flat view does not provide totals.
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To change from the default Hierarchical view to the Flat view, do one of the following:

l Before clicking Generate to run the report, instead, for Data View, click the Flat option.

l After the report is generated, from the View menu, select Grid Type > Flat.

Notice that in the following example, Hierarchical is the view being displayed. Likewise, if the
results display as Flat, you can follow the same steps to change it to Hierarchical.

Change groupings
After building and generating a report in hierarchical data view, you can change groupings without
having to delete the field, add the new grouping, and regenerate the report. You can use the drop-down
arrow immediately to the right of the first grouping to select the new field.

When a report is in hierarchical view, the first grouping is a drop-down selectable field, which makes it
easy to change it to a different grouping.
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To change the first grouping for a report displayed in hierarchical data view:
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l In the first column heading, click the drop-down arrow to the right of the column name, then
locate and click a different grouping.

First grouping with drop-down arrow outlined in red

Selecting a different grouping from the list

The report regenerates with the new data, as shown in the following example:
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Notice that the data have changed in the two measure columns because themeasures now apply
to the new grouping.

Change report column order
Use design view to change the order of a report’s groupings and measures columns before or after
generating the report. You can also remove groupings and measures from your report in design view.

NOTE: Groupings always precedemeasures in report layout, regardless of how you order them. You
can re-order groupings within a report’s set of groupings, and re-order measures within the report’s
set ofmeasures. You cannot put a measure before any grouping, however. Even if you do, when the
report generates, themeasure will be grouped with the other measures in the report.

To access design view without opening the report:
1. On themain Drill-Down Reports page, in the Categories panel, click the folder where the report is

saved.

2. On the right side of the page, click the name of the report to open the report summary
information box.

3. On the left side of the summary information box, click Design.
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The design view of the report opens on the right.

To access Design View from an open report:
l Above the report, click Design View.

To change the order of groupings or measures:
1. Click the grouping or measure to move and drag it to its new location.

2. When the two red arrows display in the desired position, release themouse button.

Themeasure columns are now in the new order:
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To remove groupings or measures from the report:
l Right-click themeasure or grouping to remove, and click Delete.

Remove an applied filter
When filtering drill-down report results, you may apply a filter that you later want to remove rather than
recreate the report.

To remove an applied filter:
1. At the bottom left of the page, click the arrows to the left ofApplied Filters.

The Applied Filters dialog opens, showing the filters currently applied to the report.

2. To clear a single filter, click the blue box to the left of the filter, and then press theDelete key. The
filter is removed.

3. To clear all filters, click Clear All.

To close the filter box, click the arrows to the left ofApplied Filters.
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When the filter box closes, the report automatically regenerates with the updated filters.

Delete a saved drill-down report
You can delete reports you no longer need.

To delete a drill-down report:
1. On themain Drill-Down Reports page, locate the desired report.

2. Right-click the report, and then select Delete.

3. In the confirmation dialog, click OK.

IMPORTANT: If you accidentally confirmed a deletion, you need to recreate the report; a
deleted report cannot be retrieved.
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Reporting across tabs
Reporting across tabs allows you to createmulti-sided reports and conduct multi-dimensional analysis.
For example, to see the admit source of claims that include a specific administered drug, you need to
include Line Item filters in your claim report. The drug code is stored with the charge data, while Admit
Source is a reportable field on the Claims tab. From the Claims tab, you can also find the number of
claims and their associated charges, and payments, (see following example). This methodology works for
the other tabs as well.

To report across tabs, you create a multi-tab report, as explained in the following section.

� Create a multi-tab report
The following example uses a Claims tab report. The steps are outlined from the perspective of using the
Claims tab only. However, you can add filters from any tab.

To build a multi-tab report:
1. Open an existing report or create a new one.

2. At the bottom right of the page, click Add Filters.

The Advanced Filters dialog opens.

3. From the Filter by drop-down, select Line Items. This sets a Line Items tab filter without your
needing to switch tabs.

4. In the Fields panel, expand theDemographic folder, and select Line Item Code. In the right side
of the dialog, Line Item Code values display with their descriptions.

5. Click the check box for each Line Item Code filter to apply to the report, and then click Use These.

In the following example, the user searched for a certain kind of drug by using the wildcard search
“%furo%”, which returned two kinds of injection drug.
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6. Close the Advanced Filters dialog.

7. To confirm your selected filter(s), at the bottom left of the page, click Applied Filters. In the
Applied Filters dialog, review the applied filter(s).

Setting a Line Items filter causes the system to automatically filter through the database so that
only claims information related to the criteria selected from Line Items is accessible.

8. Close the Applied Filters dialog by clicking the arrows to the left ofApplied Filters.

9. In the Columns panel, on theGroupings tab, double-click Admit Source.

10. Click theMeasures tab.

11. Double-click the following: Claims, Total Charges, and Total Payments to add them to the report,
calculated as SUM.
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12. After selecting all desired fields, click Generate.

The results show the Admit Source and the number of claims that have administered the selected
drug, along with all associated charges and payments.

NOTE: If you add a new filter that limits the Admit Source on the Claims tab, the Applied Filters
tab shows the filters from both the Claims and Line Items tabs, separating them by filter type.

� Save a multi-tab report
You use the same process to save a multiple-tab report as when saving a single-tab report. However, it is
important to note the tab you are on when you save the report. The Applied Filters from each tab is
saved; however, the report will only save the Rows/Columns of the tab you are viewing at the time that
you save the report.
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In the previous example, if you switched to the Line Items tab before saving, saving the report while on
the Line Items tab would save only the filters, not the selected Admit Source, Claims, Charges, and
Payments from the Claims tab. However, saving from the Claims tab will save the Row/Columns you
selected and all filters applied to the report, regardless of the tab they are associated with.

Improve variance reporting with Posting subcategories
When running drill-down reports on payment and adjustment posting totals, you can break out these
items into subcategories for more detailed reporting. In addition to Total Payment and Total Contractual
fields, there are 10 payment and 10 adjustment fields available in theMeasures column for the Claims
tab in Drill-Down reports. These fields allow you to break out payment and adjustment posting totals by
type for improved contractual variance reporting. You can use these fields to report on refunds, bad
debt adjustments, etc. The new drill-down report fields for adjustments are A1-A10. The new fields for
payments are P1-P10.

NOTE: To take advantage of this postings breakout feature, you need to provide a posting file with
category breakouts for payments and adjustments imported using Axiom ETL. This import can be in
addition to or part of the Axiom Contract Management Full Import job.

In the example below, adjustment fields A1 and A2 are used to break out primary contractual and facility
adjustments:

Using report sets
The Report Sets feature allows you to create single or multi-report workbooks and to schedule them to
run automatically, one time or on a regular basis.
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When you run reports from the Report Sets dialog, the generated reports are automatically exported to
Excel and saved to a selected directory accessible from the Axiom Desktop Client. The default directory is
Axiom > Reports LIbrary > CMAData > ReportSets. From this directory, you can view, save, export, and
delete reports.

Create a report set
Use these instructions to create set of drill-down reports.

To create a Report Set:
1. In themain menu header, click Reports >Drill-Down Reports.

2. On theDrill-Down Reports page, click Reports > Report Sets.

3. At the bottom left of the Report Sets dialog, click Add New Report Set.

A new row displays at the bottom of the Report Set grid.

4. In theName column of the new row, type a name for the new report set. The name of the report
set will also be the name of the report file that exports.

NOTE: Do not use any spaces or special characters in the report name. Limit the title to 15
characters because this is used for the workbook name.

5. If desired, click in theDescription column for the new row and enter a description of the report
set. Spaces and special characters are allowed in the Description field.

The Last Run At column displays the last time the report ran through the Scheduler.
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6. To enable the report set to be scheduled to run at a set time, select the Enabled checkbox.

7. At the right end of the new report row, click Save.

8. In the confirmation dialog, click OK.

The Report Set saves to the grid in alphabetical order.

9. Next, add reports to the report set.

Add reports to a report set
Use these instructions to add drill-down reports to an existing report set, and to set up headers and
footers for the generated reports.

To add reports to the report set:
1. In the Report Set table, find and select the report set.

2. At the top of the Report Sets dialog, click the Sheets tab.

3. On the Sheets tab, at the bottom left, click Add New Sheet. A new row is added to the Sheets
table.

4. Click in theQuery Name field, and then from the drop-down menu, select the drill-down report to
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add.

5. In theWorksheet Name field, type a name for the worksheet. Worksheet names become the
names of the tabs used in the generated report.

All reports, regardless of type (Claims or Line Items), are listed here alphabetically. Each added
report will be an additional sheet in the report set Excel workbook.

6. Near the right end of the new row, click Save.

7. If desired, you can add header and footer information to the sheet. See the following instructions
“Add headers and footers to reports in the set.”

8. Run and view the report, or schedule the report set to run at another time.

� Add headers and footers to reports in the set
To add header and footer information to the sheet:

1. In theHeader/Footer column for the new sheet row, click Details.

2. In theHeader Details section, type the desired information into the fields that corresponds to the
section of the header where you want the text to display.
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3. In the Footer Details section, type the desired information into the fields corresponding to the
footer sections (Left, Center, Right) where you want to place text. To add page numbers and a
time stamp of when the report was created, do the following:

a. Click in the field where you want the page number to populate; then, in the formatting

menu at the top of the dialog, click the page number button ( ).

b. Click in the field where you want to put the date and time that the report was created,

then, in the formatting menu, click the date button ( ), and then click the time button (

).

Example of page number and report time stamp set in the footer

4. At the bottom of the dialog, click Submit Details.
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Run and view a report set
Use these instructions to generate and view a set of drill-down reports.

NOTE: Before you run reports from the Report Sets dialog, confirm that your reports have been
built, that they run correctly, and that they have been saved. Otherwise, you may receive an error
when attempting to run the set.

1. Open the Report Sets dialog: 
a. In themain menu header, click Reports >Drill-Down Reports.

b. On theDrill-Down Reports page, in themenu header, click Reports > Report Sets.

2. In the Report Sets tab, in the row for the desired report set, click Run.

3. In the confirmation dialog, click OK.

4. Open theDesktop Client.

5. In the Axiom Explorer, navigate to Libraries > Reports Library > CMAData > ReportSets and locate
your report.

6. Double-click the report to open and view it.

Drill through the report by clicking the plus buttons on the left, as shown in the following example.

7. After viewing the report, do any of the following:
l Close the report. When prompted to save, select to save it.
l Close the report and export it. To export the report, right-click it and select Export.
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l Close the report and delete it. To delete the report, right-click it and select Delete.

Schedule a report set to run
Use these instructions for scheduling the running of drill-down report sets. You can schedule reports to
run once or on a regular basis. To schedule reports, you need to have CMA Scheduler permissions.

NOTE: Before scheduling a report set, confirm that the reports in the set have been built, that they
run correctly, and that they have been saved.

To schedule and run a report set:
1. Open the Report Sets dialog: 

a. In themain menu header, click Reports >Drill-Down Reports.

b. On theDrill-Down Reports page, in themenu header, click Reports > Report Sets.

2. In the Report Sets tab, in the row for the desired report set, ensure the Enabled box is checked.

3. Open theDesktop Client.

4. In the Admin ribbon tab, click Scheduler.

5. In the Scheduler dialog, on the Job tab, click New.

6. Click the Add button and select Report from Query.
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7. In theNew Job tab, on the right of the Selected Report Set field, click the open folder icon to view
available reports.

8. In the Choose Report dialog, select the report to be scheduled, and then click OK.

NOTE: Only report sets that are enabled for scheduling display in the Choose Report dialog.
For details, see Create a report set.
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9. In theNew Job tab on the left, click Scheduling Rules, and then click Add. A new rule is added to
the right side of the dialog.

10. Set the run day and time:

Administrator's Guide Axiom Contract Management │ 249



a. Under Day Of Week, double-click near the asterisk to activate the cell and then enter a
selection:

l * (Default): The job will be run on all days within the start / end range.

l 0-6: The job will run on the specified day(s), where 0 is Sunday and 6 is Saturday. Use
a comma or a hyphen to separatemultiple days (hyphen if the days are contiguous,
commas if not). For example, you can enter 1,3,5 for Monday, Wednesday, and
Friday, or enter 1-5 for Monday through Friday.

b. Under Hours, specify the time of day (hours) that you want the job to run, in relation to the
specified days:

l * (Default): The job will be run on all hours.

l 0-23: The job will be run on the specified hour or hours, where 0 is midnight and 23 is
11:00 PM. Use a comma or a hyphen to separatemultiple hours (hyphen if the hours
are contiguous, commas if not). For example, you can enter 0,12 to run at midnight
and noon, or enter 0-12 to run every hour from midnight to noon.

c. Under Minutes, specify the time of day (minutes) that you want the job to run, in relation
to the specified hours:

l * (Default): The job will be run on all minutes (essentially the job is run continuously,
once per minute).

l 0-59: The job will be run on the specified minute or minutes of the hour, where 0 is
the first minute of the hour and 59 is the last minute of the hour. Use a comma or a
hyphen to separatemultiple minutes (hyphen if the hours are contiguous, commas
if not). For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you enter an
hour but leave theminutes at the default asterisk, then the job will run every
minute in that hour.

11. If desired, schedule email notification to alert users when the report is available for viewing:
a. In theNew Job tab on the left, click Notification.

b. On the right, select the desired settings and specify message content.

12. Click Save and then name and save the schedule in the Contract Management or Product Line
Management folder.
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Advanced Filtering
The Advanced Filtering feature can providemore refined results within a report. For example, use
advanced filters to isolate claims that share similar characteristics or to provide detail on more specific
scenarios.

You can access advanced filtering from Reporting, Drill-Down Reports, and Claims Tracking.

Access advanced filters
You can access advanced filtering from Standard Reporting, Drill-Down Reporting, or Claim Tracking.
Previously built filters remain in the system, so you can access them at any timewhile using the reporting
and claim tracking tools.

� From Standard Reports
l To use advanced filtering while building a standard report, click Advanced; the Advanced

Parameters section opens.
l To build a new filter, click Build Filter.
l To use previously built advanced filters, in the Advanced Parameters section, select one from the

drop-down Filter menu.

10
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� From Drill-Down Reporting
l To build a new advanced filter while working with drill-down reports, in the bottom right corner of

the page, click Add Filters.

NOTE: The Add Filters button displays in all drill-down report pages except the report selection
page.

l For more information on using advanced filters with drill-down reports, see Apply filters to drill-
down reports.

� From Claim Tracking
l To build a new filter, in the View Tracking tab, click theUse Existing Filter option, and then click

Build Filter.

l To use an existing filter, in the View Tracking tab, click theUse Existing Filter option, and then,
from the Select existing filter drop-down, select a filter.

Build an advanced filter
Use these instructions for building advanced filters while working with standard reports and claim
tracking.

To build a new advanced filter:
1. Click Build Filter, as shown in the following example.

Example shows Advanced Parameters section in the New tab in Reporting

The Advanced Filters dialog opens.
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2. In theQuery Name field in the upper left corner of the dialog, type a name for the filter. Use a
concise, yet descriptive name so that you can easily identify the filter later.

NOTE: After saving a filter, you cannot view its makeup until you view a report with that filter
applied. To view applied filters, click the Applied Filters button while viewing the report.
Descriptive naming helps remove guessing which filters will be returned when you make a
selection.

TIP: Since using advanced filters lets you select claims using a large number of criteria, it is best
to know exactly what you want. Identify the criteria to use on this filter before assigning them.

3. In the Filter by drop-down, select one of the following:

l Claims – Select this to filter by whole claim
l Line Items – Select this to filter on specific line items.

The following example shows claims selected in the Filter by option.

4. In the Fields section, expand the filter fields as needed by clicking the plus symbol (+) to the left of
each category to see every possible filtering option.

5. From within the expanded field, click a desired criterion.
Depending on the criterion selected, the page displays either an option bank or a drop-down
menu, as shown in the following examples.

� Option bank
l Option banks allow you to select from all records of that type in the database, as in the

following example:
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� Drop-Down parameters
l Drop-down menu containing parameters to set (four inequality signs and an equal sign).

6. Select options or parameters, as appropriate:

l If presented with an option bank, click the check box to the left of each item to include that
item in the filter.

o If the selection list is long and consists of numbers, you can filter to the data range
rather than scrolling through the list. Type the number range into the Check Range
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field and then click Check Range.
o To select themajority of the options and exclude only a few choices, select the

“NOT” [Default] box and then select the ones to exclude, as shown in the following
example.

l If presented with parameters to set, as shown in the following example, select the direction
of the equality/inequality, and then from the drop-down menu, select the value on which
the inequality is based.

l Selecting AND/OR allows for another set of parameters on the following line.

More complex filters contain a few different sub-filters, such as Discharge Date, Latest
Payment Date, and Total Expected Payments.

l To build a complex filter, repeat Steps 5 and 6 as necessary to add multiple filter selections.

7. After making selections, click theUse These button to the right.
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NOTE: More complex filters may add time to report processing. Also, discharge date and
contract are already part of your basic report parameters. No additional filtering is needed
unless you require a specific payer code or you are building a filter for Claim Tracking.

8. To verify all filters were properly selected, in the bottom left corner of the Advanced Filters dialog,
click the Applied Filters drop-down. Expand the selection to see all filters chosen. If any are
missing, repeat Steps 5 and 6 and 7.

9. When finished adding criteria, click Save & Exit.
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Scheduler Overview
Using Scheduler, you can schedule certain Axiom Contract Management tasks to be processed on a
Scheduler server at a specific date and time. For example, you can schedule plan file processing or data
imports.

Processing tasks using Scheduler has advantages over manual processing, such as:
l Leverages the server's processing power and frees up your computer's resources.
l Enables recurring scheduling of ongoing tasks.
l Allows tasks to be scheduled during "off hours," during periods of low network and system

activity.
l Allows tasks to be performed in batch, including enforcing task dependencies.

Scheduler processes tasks using jobs. Each job is a scheduled unit that can contain one or more tasks.
The tasks in a job can be processed sequentially or concurrently as appropriate.

Only system administrators and users with the Scheduled Jobs User security permission can access
Scheduler.

Most Scheduler setup activities can only be performed in the Desktop Client (Excel or Windows Client).
Therefore, the Desktop Client Scheduler is the primary focus of this document. However, some job
management activities can be performed in theWeb Client, such as monitoring the job schedule, viewing
job results, and running jobs manually on demand. For more information, seeWeb Scheduler.

About Scheduler
This section contains conceptual information about the Scheduler feature in Axiom Contract
Management.

� Scheduler jobs and tasks
The primary unit of Scheduler processing is a job. Each Scheduler job can contain one or more tasks to
be performed as part of that job.

Each Scheduler job defines the following basic properties:
l The tasks to perform for the job and the properties of those tasks

11
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l The schedule of the job, including recurrence (if any)
l The priority of the job
l The notification options for the job

The tasks define the actual activities to be performed by the job, such as importing data or processing
plan files. Some Scheduler tasks correspond to existing features that can also be processed manually
(such as Process Plan Files), while other tasks are Scheduler-specific and can only be processed via
Scheduler. Each task has a unique set of options that are specific to that task and to the activity to be
performed. For more information on the available task types, see Scheduler Task Reference.

The tasks in a job can be processed sequentially or concurrently as appropriate. Tasks can be dependent
on other tasks in the job as needed—for example, you can configure a job so that if a task fails, the job
stops and does not process the next task. Tasks can also be processed iteratively, to perform the same
task repeatedly over a defined set of values.

The Scheduler jobs in your system fall into the following basic categories:
l Client-created: You can create Scheduler jobs as needed to perform tasks in your system.
l System jobs: Axiom Contract Management provides a set of system jobs to perform necessary

system tasks.
l Product-controlled: When a product is installed, it may include one or more Scheduler jobs to

support the use of that product. Generally speaking, these jobs should not be changed unless the
product documentation says customization is allowed, or as advised by Axiom Support.

� How Scheduler jobs are run
Once a Scheduler job has been created, it can be run using any of the following options:

l The job can be scheduled for execution at a future date and time using a scheduling rule.
Scheduling rules can be one-time only, or recurring.

l The job can be run "one time" manually as needed through Scheduler.
l The job can be triggered for execution using an event handler. This allows Scheduler jobs to be

triggered in various ways, such as by clicking a button in an Axiom form.

Scheduler jobs are processed by one or more servers running the Scheduler service. For Axiom Cloud
systems, the Scheduler service is part of your cloud system and managed by Axiom Support. For on-
premise systems, the Scheduler service is installed on one or more servers in your environment. The
Scheduler service polls the Axiom Application Server periodically to check for any jobs that are ready to
be run. Eligible jobs are then executed on the server, based on their processing priority.

When a job is executed by Scheduler, it is run using a particular user identity. In order for a job to be
executed successfully, the user must be an active user defined in Axiom Contract Management security,
and the user must have the appropriate security permissions to perform the tasks in the job. The user
identity for a job is determined as follows:

l If a job is a system job, then it is run as the system-managed identity of System instead of a user
identity.
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l If a job is run by using Run Now, then it is run as the user who placed the job on the schedule.
l If a job is run by an active scheduling rule, then it is run as the job owner. The job owner is the

user who last saved the job.
l If a job is run via an event handler, then the job may be run as either the job owner, or the job

requester (the user who raised the event).

� System jobs
System jobs are automatically created by Axiom Contract Management to support necessary system
functionality. Some system jobs are created as part of the initial installation and are intended to run on
an ongoing basis, while other system jobs are created on-demand in response to system events. Only
administrators can edit these system jobs.

System jobs have two defining characteristics:
l System jobs are run using the system-managed identity of System instead of a user identity. The

System identity has full rights to the system as necessary to perform system tasks.

l System jobs are run by the default System Scheduler service. For on-premise systems, this service
is created and started automatically on the Axiom Application Server, and does not require a
separate installation. This service is exclusively for running system jobs.

Axiom Cloud systems may or may not have a separate System Scheduler service, depending on
the system configuration (as determined by Axiom Support). If your cloud system does not have a
System Scheduler service, then your system jobs are run using the available Scheduler services for
the cloud system.

In the Scheduler dialog (Desktop Client), the System Scheduler service is listed on the Servers tab
using the following naming convention: <ServerName>-System.

If necessary, a product-controlled or client-created job can be flagged as a system job, so that it can be
run using the System identity instead of a user identity. To designate a job as a system job, enableMark
as System Job in theGeneral job properties. The following rules apply to manually-created system jobs:

l Only system administrators can designate a job as a system job.
l The job cannot contain any tasks that are designated as “non-system” tasks. Non-system tasks

are any tasks that might involve spreadsheet processing, such as Process Plan Files.

� Processing priority for scheduled jobs
Once a job reaches its start time, it is eligible to be processed by Scheduler and joins the processing
queue. For scheduled jobs, the start time is based on the scheduling rule that placed it on the schedule.
For other jobs, the start time is the time that the job was placed on the schedule using Run Once or
triggered by an event handler.
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Each Scheduler service has a configured number of threads that are used to process jobs. As a Scheduler
thread becomes available, it takes the next job in the processing queue. The priority of jobs in the
processing queue is determined by the combination of the job's priority category, and its Priority
Elevation setting.

Each job has a priority category, based on how the job execution was initiated. The priority categories
are as follows:

1. Manual: The job was executed manually.

2. Event Handler: The job was executed by a Scheduler event handler.

3. Scheduled Job: The scheduled instance of the job results from an active scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a currently executing job.

Manual jobs are highest priority and are processed first, and subordinate jobs are lowest priority and are
processed last. Within each category, jobs are processed according to their Priority Elevation setting.

For example, imagine that Scheduler has 2 available threads and the following jobs are eligible to be
processed:

Job Priority Category Priority Elevation

A Manual Default

B Event Handler Default

C Scheduled Default

D Scheduled Elevated

l Scheduler will execute jobs A and B first, because those are the highest priority jobs based on their
priority category.

l When the next thread becomes available, Scheduler will execute job D. Although job C may have
entered the queue first, and the two jobs have the same priority category, job D's priority
elevation is set to Elevated so it takes precedence within the category. If instead both jobs were
set to Default, then job C would be executed first if it entered the queue before job D.

l When the next thread becomes available, Scheduler will execute job C.

NOTE: If a job's Priority Elevation is set to Interrupt, then it is run as soon as it is eligible, regardless
of its priority category and regardless of whether any Scheduler threads are currently available to
process the job. If no Scheduler threads are available, a new one is created to process the job, even if
this temporarily exceeds the number of configured threads for the server.

The Scheduler dialog
The Scheduler dialog is used to create and manage Scheduler jobs.
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To access Scheduler:
l On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Scheduler.

The top section of the Scheduler dialog contains a ribbon-style toolbar with two tabs: Job and Service.
l On the Job tab, you can create, run, and edit jobs.
l On the Service tab, you can manage scheduled jobs, view job results, and perform other

Scheduler management activities.

As you perform actions on the Job and Service tabs, additional tabs are opened in the navigation pane of
the dialog. For example, clicking the Scheduled Jobs button on the Service tab opens the Scheduled
Jobs tab in the navigation pane. You can move between any open tab in the navigation pane, regardless
of which tab is selected in the ribbon. The ribbon updates to show the related commands for the
selected item.

Example Job tab
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Example Service tab

When you right-click a tab in the dialog's navigation pane, you can close or save items as follows:
l For all items, you can Close, Close All, or Close All But This.
l For jobs, you can Save or Save As. Selecting Save As allows you to save a copy of the job to the

Scheduler Jobs Library in the Axiom Contract Management file system.

The Scheduler Jobs Library is also accessible via Axiom Explorer.
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Scheduler Job Setup
To perform Axiom Contract Management tasks using Scheduler, you must create jobs. Each job can
execute one or more tasks. This section discusses how to set up jobs, including how to schedule jobs for
future execution and how to be notified when a job has been completed.

Managing Scheduler jobs and tasks
Using the Axiom Scheduler dialog, administrators can create and edit Scheduler jobs. To access this
dialog:

l On the Axiom tab, in the Administration group, clickManage > Scheduler.

NOTE: In systems with installed products, this featuremay be located on the Admin tab. In
the System Management group, click Scheduler.

This section discusses how to create, edit, and delete jobs and tasks, not how to manage the Scheduler
queue once jobs have been placed on the schedule. If you need to stop or reschedule a scheduled job,
seeManaging scheduled jobs.

Scheduler jobs are saved as XML files and are stored in the Axiom Contract Management file system at
\Axiom\Scheduler Jobs Library.

� Creating a Scheduler job
You can create a new Scheduler job to perform one or more tasks.

To create a new job:
1. In the Scheduler dialog, on the Job tab, click New.

A new tab appears in the navigation pane, labeled New Job. The left-hand side of the job lists
sections for which you can define various job settings. When you click a section name, the settings
for that section display in the right-hand side of the job.

2. In theGeneral section, define general job settings as desired.

For detailed information on the available settings for a job, see Job properties.

12
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3. In the Scheduling Rules section, specify scheduling details for the job.

You can schedule the job for future execution, for one time or on a recurring basis.

NOTE: If you are always going to run the job manually, and do not need to schedule it for
future execution, then you do not need to define scheduling rules.

For more information, see Defining scheduling rules for a job.

4. In theNotification section, specify email notification options for the job.

You can send email notifications every time the job completes, or only when the job experiences
errors. By default, the job is configured to notify on completion.

For more information, see Setting up notifications for jobs.

5. In the Tasks section, add one or more tasks to the job.

a. On the Job tab of the ribbon, in the Tasks group, click Add. This brings up a list of available
tasks. Select the task that you want to add.

The task is added to the Tasks section, and the settings for the task display in the right-
hand side of the job.

b. Complete the settings for the task as desired.

The Task Control section of the task contains standard task settings, and the Task Details
section contains settings unique to the task type. For more information, see Task Control
properties.

If a required setting is not completed, the setting is highlighted in red and error text
appears in the bottom of the dialog. Make sure to complete all required settings for the
task before saving.

Repeat this process until you have added all desired tasks to the job. Tasks are processed in the
order listed. If you need to change task order, select a task and then clickMove Up orMove
Down.

6. In the Job tab of the ribbon, click Save.

7. At the bottom of the Save As dialog, in the File name box, type a name for the job, and then click
OK.

The job is saved as an XML file in the Scheduler Jobs Library.

If the job was saved with an active scheduling rule, Axiom Contract Management determines the next
scheduled date of execution and schedules the job. You can view the job in the Scheduled Jobs list (on
the Service tab of the ribbon, click Scheduled Jobs).
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Advanced job settings
This procedure covers the basic steps of creating a job. Jobs also support the following advanced
options:

l Event handlers: You can create event handlers for the purposes of running the job using the
RunEvent function. This allows users to trigger job execution from within an Axiom file.

l Job variables: You can create job variables and then use those variables within certain job
settings. You can then dynamically pass in values for those variables when using the RunEvent
function to execute the job.

For more information, see Advanced options, Using job variables, and Using RunEvent to execute a
Scheduler job.

� Editing a job
You can edit a job at any time to change job settings, add or remove tasks, change scheduling rules, or
change notification options.

This section describes the general process of opening a job for editing. For more details on the impacts of
editing scheduling rules, see Defining scheduling rules for a job.

To edit a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(themost recently opened tab is the active tab by default).

3. Edit the job and task properties as desired.

For detailed information on the available settings for a job, see Job properties. For detailed
information on task settings, see Task Control properties.

4. In the Job tab of the ribbon, click Save.

� Deleting a job
Deleting a job removes any scheduled executions of the job from the scheduled jobs list.

To delete a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Navigate to the job that you want to delete, then right-click the job and select Delete.

You can also delete Scheduler jobs from Axiom Explorer or the Explorer task pane.
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Defining scheduling rules for a job
Once a job has been created, you can run it on demand, or you can schedule it for future execution. Jobs
can be scheduled to be run one time, or on a recurring basis. To schedule a job, you define scheduling
rules for the job.

You can add, edit, and remove the scheduling rules for a job at any time using the Scheduling Rules
section of the job properties. You can also flag a rule as active or inactive. If a job has no scheduling rules,
or if all of its scheduling rules are inactive, then it will not be run unless it is run manually by a user.

If a job is saved with an active scheduling rule, then Axiom Contract Management determines the next
scheduled instance of the job and places it in the scheduled jobs list. Once that instance has been
processed, the next scheduled instance is determined and scheduled, and so on. Each time the job is run
using an active scheduling rule, it is run as the current job owner (unless the job is a system job, in which
case it is run as the Scheduler Service System identity).

If a job has multiple active scheduling rules, Axiom Contract Management evaluates all of the rules and
schedules a single instance of the job, for the earliest time allowed by the rules. Multiple scheduling rules
do not result in multiple scheduled instances of the job.

NOTE: If a time zone is listed on the Scheduling Rules section of the job, then the defined rules will be
evaluated in the context of that listed time zone. Otherwise, scheduling rules are evaluated in the
context of the local time zone for the Scheduler Server. If necessary, the system configuration setting
SchedulingBehaviorTimezone can be used to specify a particular time zone for evaluating scheduling
rules.

� Adding a Scheduling rule
You can add a scheduling rule to a job to schedule it for future execution, either one time or on a
recurring basis.

If you only plan to run the job manually on demand, then you do not need to create a scheduling rule.

To add a scheduling rule to a job:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Scheduling Rules.

By default, this area is empty. You must add a rule in order to define scheduling for the job.

3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules section, click Add.

A new row appears in the right-hand side of the job. By default, the new row is active, but does
not have start / end dates or any specific recurrence settings.

4. Complete the following settings within the row as needed:
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Item Description

Active If you want the job to be placed on the schedule as soon as you save the
job with the new scheduling rule, then you should leave this option
checked.

However, if you just want to save your schedule settings but you are not
ready to begin scheduling the job, then you can clear the Active check box
for the rule. The job will not be scheduled until it is saved with an active
scheduling rule.

Starting On

Ending On

Optional. These dates specify the time frame for the scheduling rule. The
starting date defines the earliest point in time that the job can be
scheduled, and the ending date defines the latest point in time that the
job can be scheduled.

If these dates are not defined (left blank), then the job will be perpetually
scheduled according to the rule settings, as long as the rule is active.

If you want to schedule a one-time job, then set the starting / ending
dates to the same date and time.

NOTE: Your system locale determines the format of dates.

Day ofWeek Specify the day(s) of the week that you want the job to be run:
l * (Default): The job will be run on all days within the start / end range.
l 0-6: The job will be run on the specified day or days, where 0 is Sunday

and 6 is Saturday. Use a comma or a hyphen to separatemultiple days
(hyphen if the days are contiguous, commas if not).

For example, you can enter 1,3,5 for Monday, Wednesday, and Friday,
or enter 1-5 for Monday through Friday.

Hours Specify the time of day (hours) that you want the job to be run, in relation
to the specified days:
l * (Default): The job will be run on all hours.
l 0-23: The job will be run on the specified hour or hours, where 0 is

midnight and 23 is 11:00 PM. Use a comma or a hyphen to separate
multiple hours (hyphen if the hours are contiguous, commas if not).

For example, you can enter 0,12 to run at midnight and noon, or enter 0-
12 to run every hour from midnight to noon.
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Item Description

Minutes Specify the time of day (minutes) that you want the job to be run, in
relation to the specified hours:
l * (Default): The job will be run on all minutes (essentially the job is run

continuously, once per minute).
l 0-59: The job will be run on the specified minute or minutes of the

hour, where 0 is the first minute of the hour and 59 is the last minute of
the hour. Use a comma or a hyphen to separatemultiple minutes
(hyphen if the hours are contiguous, commas if not).

For example, you can enter 0,30 to run at the top of the hour and the half
hour, or enter 0-30 to run every minute from the top of the hour to the
half hour.

NOTE: If you specify an hour, then in most cases you should also specify a
minute (such as 0 to run the job at the top of the specified hour). If you
enter an hour but leave theminutes at the default asterisk, then the job
will run every minute in that hour.

If the Active check box for the rule is selected when the job is saved, then Axiom Contract Management
will calculate the date and time of the first scheduled execution and will place the job on the schedule.

� Editing a scheduling rule
You can edit a scheduling rule at any time, to toggle between active and inactive, and to change the start
/ end dates and recurrence settings.

NOTES:
l If a pending instance of this job is currently on the schedule, and you edit the scheduling rule,

the pending instance will be updated to match the new schedule.
l If you inactivate a scheduling rule, any currently scheduled instances of the job will be

automatically removed from the schedule.

To edit a scheduling rule:
1. In the Scheduler dialog, open a job to edit or create a new one.

2. In the left-hand pane of the job, select Scheduling Rules.

The defined rules display in the right-hand pane of the job.

3. Make any desired changes directly within the scheduling rules grid.
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� Deleting a scheduling rule
You can delete a scheduling rule at any time. If a job has no active scheduling rules, it will not be
processed unless it is manually run.

To delete a scheduling rule:
1. In the Scheduler dialog, open a job to edit.

2. Select the Scheduling Rules section of the job, and then select the rule that you want to delete.

3. On the Job tab of the Scheduler ribbon, in the Scheduling Rules group, click Remove Selected.

Alternatively, if you want to delete all scheduling rules for the job, click Clear All.

Any jobs in the scheduled jobs queue that were related to the deleted rule(s) are also deleted.

� Scheduling rule examples
The following are some example schedules and the rules used to achieve them:

Schedule Start/End Day of Week Hours Minutes

Weekdays at 11:00
PM

<optional> 1,2,3,4,5 23 0

Every 15minutes <optional> * * 0,15,30,45

Mondays at 11:30 PM <optional> 1 23 30

One time (6/30/2021)
at 1:30 PM
(Option 1)

Start: 06/30/2021 00:00

End: 07/01/2021 00:00

* 13 30

One time (6/30/2021)
at 1:30 PM
(Option 2)

Start: 06/30/2021 13:30

End: 06/30/2021 13:30

* * *

Every Wednesday in
July at noon

Start: 07/01/2021 00:00

End: 08/01/2021 00:00

3 12 0

Continuous <optional> * * *

To schedule a job to executemonthly, create twelve active scheduling rules, one for each month. This is
necessary because scheduling rules do not have a property for day ofmonth, so it is not possible to use
a single scheduling rule to create a monthly schedule. In the following example, the job will be executed
on the first day of each month, at 3:30 AM:

Example scheduling rules to execute a job monthly
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When you save the job, the rules will be evaluated and the first scheduled execution will be placed on the
schedule—in this example, the January 1 execution. Once that scheduled execution is complete, the rules
will be evaluated again, which will cause the next scheduled execution (Feb 1) to be placed on the
schedule, and so on.

Setting up notifications for jobs
Scheduler can be configured to send an email notification when a job completes, or when a job has
errors. In order for an email notification to be sent for a particular job, the following must be set up:

l The job must be configured to send a notification on completion or error. The notification settings
must include valid To and From email addresses (or use system variables).

l The System.SMTPMessageDelivery system job must be configured with a valid SMTP server for
your environment. For more information, see Scheduler setup.

When a job creates an email notification, the notification is first saved to the database. When
notifications are detected in the database, the System.SMTPMessageDelivery system job is triggered to
deliver the notifications.

NOTES:
l By default, all new Scheduler jobs are configured to send an email notification on completion,

to the user who created the job. You only need to edit the notification settings if you want the
job to use different notification behavior.

l Currently, it is not possible to configure a Scheduler job to send notifications within the
application only, instead of by email. However, when a job is run manually, the user who ran
the job may receive an in-application notification of the job status in addition to any
configured email notifications. See Application notifications for Scheduler jobs that are run
manually.

To configure a job to send email notifications:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Notification.

3. In the Job Notification Level section, select one of the following:

l Send all email notifications: (Default) An email notification is always sent when the job is
executed, regardless of the job status (success, failure, aborted, etc.).

l Send email notification only when the job has errors: An email notification is only sent if
the job experiences errors. If the job completes successfully with no errors, no email
notification is sent.

l None: No email notifications are sent for this job. The only way to check the status of the
job execution is to view the job history.

Administrator's Guide Axiom Contract Management │ 270



l Send email notification to different email addresses when the job has errors or
succeeds: This option works the sameway as Send all email notifications, except that a
separate email address can be specified to receive the error notifications.

4. In theNotification Message Content section, complete the following for the notification email:

Item Description

To The email address(es) to receive the notification email. Separatemultiple
addresses with a semicolon. For example:
l To send the email to two recipients, enter the addresses such as:
jdoe@company.com;dsmith@company.com

l To use a Scheduler job variable to define a notification recipient, enter
the variable namewith curly brackets. You can combine regular email
addresses and variables, such as: {JobOwner.EmailAddress};
jdoe@company.com

By default, the notification is configured to be sent to the user who
executed the job, using the variable {CurrentUser.EmailAddress}.

The entries in the To field must be valid email addresses, or Scheduler job
variables that will resolve to valid email addresses. Currently, it is not
supported to list user or role names, or to look up email addresses from
Axiom Security.

NOTE: When using Send email notification to different email addresses
when the job has errors or succeeds, this user will be notified if the job
completes successfully (including partial success), but not if the job fails.
Job failure notifications are sent to the To (on error) recipients.

From The email address that themessage is sent from. This can be something
like axiomscheduler@company.com, so that the recipient can easily tell
that themessage has been generated by Scheduler.

By default, this is set to the Scheduler "from" email address as defined in
the system configuration settings, using the system variable
{Scheduler.FromEmailAddress}.

NOTE: For installations that are using subsystems, the system variable
{Scheduler.FromEmailAddress}may resolve to a subsystem
administrator email address instead of the Scheduler "from" email
address.

Subject The subject of themessage. By default, this is set to "Axiom Scheduler
Notification."

User Message Optional body text for the email. This text is included in addition to the
Scheduler auto-generated text regarding the job status.
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If Send email notification to different email addresses when the job has errors or succeeds is
enabled, the following additional options are available:

Item Description

To (on error) The email address(es) to receive the notification email when the job result
is Failed. Separatemultiple addresses with a semicolon.

This user only receives a notification if the job fails. If the job result is
Success or Partial Success, this user will not receive a notification (only the
To user will).

Subject (on
error)

The subject of the job failuremessage. By default, this is set to "Axiom
Scheduler Notification."

Job variables can be used in all notification settings.

� Application notifications for Scheduler jobs that are run manually
If you run a Scheduler job manually, you can receive a notification within the application to let you know
the status of the job. This notification will display in the Notifications task pane of the Desktop Client, and
in the Notifications panel of theWeb Client. This notification works as follows:

l The in-application notification is only sent if the Scheduler job is run manually using the Run Now
option in Scheduler (or by using an equivalent "run now" action within a product-specific web
page). In-application notifications are not sent if the job is run via a scheduling rule or an event
handler.

l The in-application notification honors the Notification settings defined for the job to determine
whether the notification is sent. For example, if the job is set to None, then the in-application
notification is not sent. If the job is set to Send all email notifications, then both an email
notification and an in-application notification will be sent when the job completes.

l The in-application notification only reports the status of the job—success, failure, or partial
success. It does not contain any error or success details, and does not include any messaging as
defined in the Notification settings for the job. For more information, view the job results within
the Scheduler dialog in the Desktop Client, or the Scheduler page of theWeb Client.

l The in-application notification is always sent to the user who ran the job manually.

NOTE: If the job is configured to Send email notification to different email addresses when the job
has errors or succeeds, this is treated as Send all email notifications for purposes of sending the in-
application notification. The user who ran the job will be notified when the job is completed,
regardless of the job status.
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Example success notification

Job properties
This topic is a reference for the settings that can be defined for a Scheduler job.

� General
This section defines general settings for the job.

Item Description

Description Optional. The description of the job.

The job description can also be edited in Axiom Explorer, in the Scheduler Jobs
Library.

Job Restart
Behavior

Specifies whether and how the job should be restarted if it is interrupted prior
to completion. Select one of the following:
l Do not reschedule this job. In this case, you must manually reschedule the

job if it needs to be run before its next scheduled execution.
l Restart the job from the first task. The entire job is run again, even if some

of the tasks were completed successfully before the job was interrupted.
l Resume the job beginning with the first uncompleted task. (Default) The

job resumes and only the uncompleted tasks are run.

A job would be interrupted if the Scheduler server processing it was restarted,
or if the Scheduler service on the server was stopped or restarted, or if the
Scheduler server was disabled from the Servers tab (Service > Servers) of the
Scheduler dialog.
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Item Description

Job Results
Cleanup

Specifies whether historical job results are purged when the job is run.

To purge job results:
1. Select Purge historical job results whenever this job runs.

2. In Number of days to keep results for this job, specify the number of
days to keep when purging results. By default this is set to 0, which
means all job results will be purged except the result for the current job
execution.

A day is counted as 24 hours from the time the cleanup task is executed. So if
you specify 1 day, and the task is run at 11:00 PM on Tuesday, then all results
prior to 11:00 PM Monday are purged.

If this option is not selected, then historical job results remain in the database
until the system's Purge System Data task is run.

Priority Elevation Specifies the priority of the job in the scheduled jobs queue, within the job's
priority category. Select one of the following:
l Default: (Default) This job is run on a "first come, first served" basis. The

total number of jobs that can be run at one time is determined by the
configured number of Scheduler threads for the installation.

l Reduced: The job is designated as a low priority job, and remains at the
bottom of the queue until other jobs with Default and Elevated priority have
been run.

l Elevated: The job is designated as a high priority job, and is moved to the
top of the queue to be run before Default and Reduced priority jobs.

l Interrupt: The job is run immediately, regardless of any jobs currently
waiting in the scheduled jobs queue, and regardless of whether any
Scheduler threads are currently available to run it. If no Scheduler threads
are currently available, a new thread is created, even if this exceeds the
configured thread limit for the installation.

Job execution order also depends on the priority category of a specific job
execution. See Processing priority for scheduled jobs.
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Item Description

Mark as System
Job

Specifies whether the job is run as a system job. Only administrators can edit
this check box.

If this check box is selected, the job is run under the "Scheduler Service" system
identity instead of a user identity, and the job is run by the system Scheduler
server which operates on the Axiom Application Server.

Generally, this check box should only be selected for system "support" tasks
that should not depend on individual user rights. This check box is not available
if the job contains non-system tasks (generally, spreadsheet-related tasks).

For more information, see System jobs.

Put the system
in 'admin only'
mode during this
job

If this option is selected, then the system will be placed into administrator-only
mode at the start of the job, and then placed back into full access modewhen
all tasks are completed (including any sub-jobs). This is the same behavior as
going toManage > Security > System Access and selecting Administrators
Only.

NOTES:
l You should make sure that any jobs using admin-only mode do not overlap.

For example, imagine that job A starts and places the system in admin-only
mode. While job A is still running, job B starts and finishes. If job B also uses
admin-only mode, then when job B finishes the system will be placed back
into full access mode, meaning the remainder of job Awill be processed in
full access mode.

l Any job using admin-only modemust be run by an administrator.

Generally speaking, any job set to run using admin-only mode should be run at
a timewhen no end users will be logged into the system and no other Scheduler
jobs will be running.

� Job Variables
This tab has two sections for job variables:

l In the Job values section at the top of the tab, you can manage user-defined variables for use in
the current job.

To add or remove variables, use the Add, Remove Selected, or Clear All commands in the Job
Variables group of the Job tab. This group is only available when you have selected the Job
Variables section in the left-hand side of the job.

When creating user-defined variables, do not add curly brackets to the variable name. Curly
brackets are only required when you use the variable in a job or task setting.
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l In the System defined values section at the bottom of the tab, you can view the system variables
available for use in the job.

You can right-click any variable in this section (user-defined or system-defined) and select Copy variable
name to clipboard. You can then navigate to the setting where you want to use the variable, and then
paste it. The variable will be pasted with the necessary curly brackets.

For more information, see Using job variables.

� Scheduling Rules
Each row in this section defines a scheduling rule for the job. Jobs will be automatically scheduled
according to the settings in this section.

To add or remove scheduling rules, use the Add, Remove Selected, or Clear All commands in the
Scheduling Rules group of the Job tab. This group is only available when you have selected the
Scheduling Rules section in the left-hand side of the job.

For more information, see Defining scheduling rules for a job.

Item Description

Active Specifies whether the scheduling rule is active. If this check box is not selected,
then the rule is ignored for purposes of scheduling the job.

Starting On Optional. Specifies the earliest date and time for the scheduling rule to take
effect.

If you want the job to run one time only, set Starting On and Ending On dates
to the same date/time.

Ending On Optional. Specifies the expiration date and time for the scheduling rule. Once
this date is past, no further executions will be scheduled for this rule.

Day ofWeek Specifies the day(s) of the week that you want the job to be run:
l * (Default): The job will be run on all days within the start / end range.
l 0-6: The job will be run on the specified day or days, where 0 is Sunday and 6

is Saturday. Use a comma or a hyphen to separatemultiple days (hyphen if
the days are contiguous, commas if not).

Hours Specifies the time of day (hours) that you want the job to be run, in relation to
the specified days:
l * (Default): The job will be run on all hours.
l 0-23: The job will be run on the specified hour or hours, where 0 is midnight

and 23 is 11:00 PM. Use a comma or a hyphen to separatemultiple hours
(hyphen if the hours are contiguous, commas if not).
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Item Description

Minutes Specifies the time of day (minutes) that you want the job to be run, in relation
to the specified hours:
l * (Default): The job will be run on all minutes (essentially the job is run

continuously, once per minute).
l 0-59: The job will be run on the specified minute or minutes of the hour,

where 0 is the first minute of the hour and 59 is the last minute of the hour.
Use a comma or a hyphen to separatemultiple minutes (hyphen if the hours
are contiguous, commas if not).

� Event Handlers
If an event handler is associated with the job, it is listed here. There are two types of event handlers:

l System event handlers, for completing system-triggered tasks. SeeManaging event handlers.
l User-defined event handlers, for running jobs via RunEvent. See Advanced options.

To add or remove event handlers, use the Add, Remove Selected, or Clear All commands in the Event
Handlers group of the Job tab. This group is only available when you have selected the Event Handlers
section in the left-hand side of the job.

Item Description

Active Specifies whether the event handler is active or not within the current job. If
inactive, then actions that trigger the event handler will ignore this job.

Event Name The name of the event handler.

Multiple jobs can have an event handler with the same name; all those jobs will
be affected when the event handler is triggered.

Execute As The user identity under which the job will be run when the event handler is
triggered.
l Owner: For system-managed event handlers, the owner is the system

Scheduler identity. For user-defined event handlers, the owner is the user
who last saved the job.

l Requester: For all event handlers, the requester is the user who caused the
event handler to be triggered.

� Notification
This section defines email notification settings for the job. For more information, see Setting up
notifications for jobs.

Job variables can be used in this section. For more information, see Using job variables.
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Item Description

Job Notification
Level

Specifies when email notifications are sent for the job. Select one of the
following:
l Send all email notifications (Default)
l Send email notification only when the job has errors
l None
l Send email notification to different email addresses when the job has

errors or succeeds

If anything other than None is selected, then you must complete the remaining
fields.

To The email address(es) to receive the notification email. Separatemultiple
addresses with a semicolon.

To (on error) The email address(es) to receive the notification email when the job fails.
Separatemultiple addresses with a semicolon. Only applies when Send email
notification to different email addresses when the job has errors or succeeds
is enabled.

From The email address to use as the "From" address for the notification email.

Subject The subject text for the notification email.

Subject (on
error)

The subject text for the notification email when the job fails. Only applies when
Send email notification to different email addresses when the job has errors
or succeeds is enabled.

User Message Optional. The body text for the notification email.

Text entered here will be appended to the body text generated by Scheduler.

� Tasks
This section defines the tasks in the job. In the ribbon, task commands are available on the Job tab, in
the Tasks group.

l To add a task, click Add.
l To change the order of tasks, select a task and then clickMove Up orMove Down.
l To delete a task, select the task and then click Remove Selected.
l To delete all tasks, click Clear All.
l To copy a task, right-click the task and then click Copy. You can copy the task within the same job,

or to another open job in the Scheduler window. Right-click any task (or the Tasks section header)
and then select Paste. The job is pasted underneath the job you right-clicked (or at the end of the
list if you right-clicked the Tasks section header).
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l To rename a task, double-click the task name to make it editable, and then type the new name.
For example, if you have a job with multiple File Processing tasks, then you may want to edit the
name of each task so that you knowwhich file each task relates to at a glance. (You can also right-
click and select Rename.)

Tasks are processed in the order they are listed in the job. By default, when you add a new task to a job,
it is placed at the bottom of the list. Make sure to move the new job if it should not be processed last.

Tasks can be processed concurrently instead of sequentially if they are configured to be run as a
subordinate job within the parent job.

Each task type has its own unique settings in addition to the standard task settings. For more
information, see Scheduler Task Reference.

� Job Results
Displays historical results for the job. This section is blank if the job has never been run.

Job results may be purged periodically by using the Job Results Cleanup option for the job, or by the
system Purge System Data task.

NOTE: Users with the Scheduled Jobs User security permission only see results for jobs that they
executed. Administrators see results for all executions.

For more information on job results, see Viewing job results.

Advanced options
Creating event handlers for a job

You can create user-defined event handlers in a job, for the purposes of automatically triggering the job
for execution when the event name is called by another feature. Axiom Contract Management supports
several features that can be used to raise an event:

l The RunEvent function and command
l File Group triggers
l The Raise Event Scheduler task

Event handlers are defined by name. Multiple jobs can have an event handler with the same name.
When that event handler is called, it will affect all jobs that contain the event handler with thematching
name.

To create an event handler in a job:
1. In the Scheduler dialog, open a job to edit or create a new job.

2. In the left-hand side of the job, select Event Handlers.

Administrator's Guide Axiom Contract Management │ 279



3. On the Job tab of the ribbon, in the Event Handlers group, click Add.

A new event handler is added to the job.

4. Double-click the Event Name field so that the field becomes editable, and then type the desired
event handler name.

For example, if the event handler will be used to trigger Process Plan Files jobs, you might name
the event handler ProcessPlanFiles.

This event name is the name that will be used in features such as RunEvent to trigger this job for
execution.

5. In the Execute As field, select one of the following to determine the user identity that will be used
to run the job when it is executed via the event handler:

l Owner: The job will be run under the identity of the job owner.

The job owner is the user who last saved the job. If you are not sure who the current job
owner is, you can check the Job Variables tab. The current job owner is listed in the System
defined values section.

l Requester: The job will be run under the identity of the user who triggered the event
handler.

By default, event handlers are set to run as theOwner. You should carefully consider this option
as it may affect whether the job can be run and how the job is run.

For example, if the event handler is set to Requester, but the user who triggered the job does not
have access to the file group specified for a Process Plan Files task, then the task will fail.

This may be the desired outcome—you may want the job to be dependent on the user's rights,
and therefore you should specify Requester. On the other hand, you may want the job to run in
the sameway every time, regardless of the user that triggers the job. In that case you should
specify Owner.

By default, the event handler is set to Active, which means it will be found by any process that triggers
the event handler. If you want to temporarily exclude this job from event handler processing, you can
clear the Active check box.

� Associating an event handler with a file group
If a Scheduler job with an active event handler is stored in a file group Utilities folder, then the event
handler is associated with that file group. When using RunEvent to trigger jobs for execution, you can
optionally specify a file group context so that only event handlers associated with that file group (or no
file group) are considered.

In order to store a Scheduler job within a file group, you must first create and save the job within the
Scheduler Jobs Library. Then, you can use Axiom Explorer to move the job from the Scheduler Jobs
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Library to the file group Utilities folder. If the file group and its utilities are later cloned using any
process—such as regular file group cloning, scenario creation, or file group rollover—then the event
handler is also cloned and will be associated with the new file group.

� Deleting an event handler
If you no longer need an event handler, you can delete it from the job. Select the event handler and then
click Remove Selected. You can also Clear All to remove all event handlers from the job.

User-defined event handlers display along with the system event handlers in the Event Handlers tab
(Service > Event Handlers). If you right-click a user-defined event handler in this location and select
Remove event handler, it does not delete the event handler from any jobs that use it, but it does set the
event handler to inactive.

Using job variables

You can use job variables within a Scheduler job, to define the value of the variable when the job is run.
Job variables aremanaged in the Job Variables section of the job.

There are two types of variables:
l User-defined variables: You can create a variable and then use it within any job or task setting

that supports variables, but only within that particular job. The primary use for user-defined
variables is to run a job via RunEvent (either the function or the command), and pass in a variable
value at that time.

l System variables: Axiom Contract Management provides a number of system variables that can
be used within relevant job and task settings. For example, instead of specifying a "hard-coded"
email address for the job notification, you can use a system variable to specify that whoever ran
the job should receive the notification.

In all cases, to use a variable within a job or task, enter the variable name into the desired setting,
enclosed in curly brackets. For example: {variable}

TIP: If you want to use a variable in a job, you can right-click the variable and then select Copy
variable name to clipboard. Navigate to the setting where you want to use the variable, and then
paste it into the setting (the curly brackets are added automatically).

At the job level, variables can be used in any of theNotification Message Content settings in the
Notification tab. At the task level, in general, variables can be used in any task field that accepts typed
user input.

When the job is run, the variable values used for the job display in the job results under Job Values, and
also in the email notification (if applicable).
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� User-defined variables
User-defined variables are created in the Job Variables tab. You define the name of the variable (without
brackets), and if desired, define a default value for the variable.

When the job is run, the user-defined variable will be replaced with a value as follows:
l If the job was scheduled using RunEvent (function or command), and RunEvent sent a name /

value pair that matches the name of the job variable, that value is used.

l If the job was scheduled as a result of a file group trigger, and the trigger has a defined variable
that matches the name of the job variable, that value is used. Multiple values are returned as a
comma-separated list.

l If the job contains a Process Document List task or a Process Plan Files task with a defined post-
processing variable that matches the name of a job variable, that value is used after that task has
been processed.

l Otherwise, the default value defined in the Job Variables tab is used.

If the value is blank, then the job or task setting using the variable will be evaluated as blank. If the
setting cannot be blank, then an error will result when the job is executed.

� System variables
The available system variables are listed at the bottom of the Job Variables tab. Most of these variables
relate to user names and addresses, for use within the job notification settings.

When the job is run, the system variable is replaced with the applicable system value.

The following values are available:

Variable Description
{CurrentUser.EmailAddress}

{CurrentUser.LoginName}

{CurrentUser.FullName}

Returns the current user's email address,
login name, or full name.

The current user is the user identity under
which the job is currently being run.
Generally, this is the user who executed the
job. If the job was executed via an event
handler and the event handler is set to
owner, then the current user will be the job
owner.

{JobOwner.EmailAddress}

{JobOwner.LoginName}

{JobOwner.FullName}

Returns the job owner's email address, login
name, or full name.

The job owner is the user who last saved the
job.
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Variable Description
{Scheduler.ConfiguredFromEmailAddress} Returns the system's default "from" address,

as defined in the system configuration
settings.

{Scheduler.FromEmailAddress} This returns a value as follows:
l If the current user belongs to a

subsystem, this returns the subsystem
administrator's email address.

l If the current user does not belong to a
subsystem, this returns the default
configured "from" address.

{CurrentSubsystem.AdminEmailAddress} Returns the email address of the subsystem
administrator for the subsystem that the
current user belongs to.
l If the subsystem has multiple

administrators, the email is sent to the
first administrator.

l If the user belongs to multiple
subsystems, the first returned subsystem
for the user will be used. No specific logic is
applied to determine the "correct"
subsystem for any particular job.

l If the user does not belong to a
subsystem, then no email address is
returned.

{EventHandler.EventName} Returns the name of the event handler that
caused the job to be scheduled, if applicable.
Otherwise the variable returns blank.

{NotificationAddress} Returns the notification address defined for
the plan codes that triggered a Scheduler job.

This variable only applies when the job is
executed as a result of a file group trigger, and
only if the optional notification address
settings are defined for the file group.
Otherwise, no email address is returned.
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Variable Description
{Task.CurrentIterationValue}

{Task.IterationNumber}

Returns the current iteration value and the
current iteration number. These variables
only apply when using the Iteration feature
for a task.

For more information, see Using iterative task
processing.

Processing tasks in parallel

Each Scheduler job can havemultiple tasks. By default, each task in the job is processed sequentially, in
the order that the tasks are listed in the job.

If desired, you can configure tasks so that they are processed concurrently (in parallel) instead of
sequentially. If appropriate, this may speed up the processing of the job.

� Configuring tasks for parallel processing
In order to process tasks in parallel, the tasks must be configured to run as subordinate jobs (sub-jobs).
To do this, edit the following settings in the Task Control section for each task:

l Select Create a Subordinate Job for this Task.
l Ensure that the following setting is not selected:Wait for all Subordinate Jobs to complete

before proceeding to the next Task.

In the following example, if all four tasks are configured to be run as subordinate jobs, then they can be
run in parallel (depending on the available Scheduler threads).

Scheduler task configured to run as a subordinate job to enable parallel processing
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� How parallel processing works
When a task is configured to execute as a subordinate job, then it is not processed within the "parent"
job. Instead, a sub-job is created for the task. The sub-job joins the Scheduler queue and is eligible for
processing according to the normal Scheduler processing rules. For more information, see Processing
priority for scheduled jobs.

For example, imagine that you have a job with four tasks, and these tasks are not dependent on each
other. If you use the default settings, Scheduler takes the first task in the list and starts processing. The
second task is not started until the first task is complete, and so on.

If instead you configure each task as a sub-job, then when the "parent" job is processed, it will create
four sub-jobs. If two Scheduler threads are available for processing, then two of the sub-jobs are
processed at the same time. If four Scheduler threads are available, then all four sub-jobs are processed
at the same time. Once all of the sub-jobs are complete, the parent job is completed, and its status
reflects the overall status of all of the sub-jobs.

If tasks are dependent on each other, then you should not process them as sub-jobs, or you should use
theWait setting as appropriate. For example, imagine that the first four tasks in the job can be run in any
order, but the fifth task must be processed last. In that case, you can configure the first four tasks to run
as sub-jobs, but on the fourth task you must enableWait for all Subordinate Jobs to complete before
proceeding to the next Task. This will cause Scheduler to wait for all sub-jobs to finish before it proceeds
to the fifth, final task.

In the following example, the file processing tasks are configured as sub-jobs so that they can be run in
parallel. The last file processing task is configured to wait, so that all of the file processing tasks will be
finished before the file collection task begins.

Scheduler task configured to wait for all subordinate jobs to complete
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Using iterative task processing

You can configure a Scheduler task to use iterative processing, so that the task is repeated multiple times
using a designated list of values. Each iteration of the task uses a different item in the list, until all items
have been processed.

When you enable iterative processing for a task, you define the list of values by specifying a table column
and an optional filter. The task will then be processed for each unique item in the table column. You can
reference the column values within the task properties by using a built-in Scheduler job variable. As each
iteration of the task is processed, the variable is replaced with the column value for the current iteration.
Using this approach, the task can dynamically change for each iteration.

For example, you may have an import that you want to perform for four different entities in your
organization. The import configuration is exactly the same except that the source file or query is different
for each entity. If the import uses entity as a variable, then you can set up a single import task and
configure it to iterate over the list of entities. Each iteration uses a different entity name or code, which
you can pass into the import variables so that the import uses the correct source file or query for the
current entity.

� Enabling iterative processing
Iterative processing is enabled in the Task Control properties of the task. Select the task within the
Scheduler job, then click Task Control to expand that section. Any task can use iterative processing,
though it is more useful for certain task types such as Import ETL Package.

Complete the following properties in the Iteration section of the Task Control properties.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate
Job for each iteration

Specifies whether each iteration is processed as a separate subordinate
job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution ofmultiple iterations. This option should
only be enabled if the order of iteration processing is not important.
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Item Description

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept.Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the iterative
processing. You can use any filter that is valid against the source table (the
table of the iteration column).

When iterative processing is enabled for a task, the iterations are always processed within a subordinate
job. Therefore, enabling the Task Control option of Create a Subordinate Job for this Task is
unnecessary.

If your job has multiple tasks, and you want the tasks after the iterative task to wait for all iterations to
complete before executing, then you must enable the following Task Control option for the iterative task:
Wait for all Subordinate Jobs to complete before proceeding to the next Task.

� Configuring the task to change for each iteration
In order for the Scheduler task to apply the current iteration value to each iteration, you must use the
built-in iteration variables within the task. These variables are job variables, and can be used like any
other job variable. The following variables are available:

Variable Description
{Task.CurrentIterationValue} Returns the current value from the iteration list.
{Task.IterationNumber} Returns the number of the current iteration.
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To continue the previous example, imagine that you are setting up an import for iterative processing by
entity. To define the list of entities, you set up the Iteration settings in the Task Control section like the
following:

This example will iterate over the list of entities in the Entities column, limited to only those entities
where the Costing column is set to True. If this resolves to 4 entities, then the task will be processed 4
times, once for each entity.

The import is configured with a variable {Entity}, which it uses to process the correct entity source file.
In order to pass the current task iteration value to the import variable, you can use the job variable
{Task.CurrentIterationValue} in the import task settings. For example:
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When the first iteration is performed, the {Task.CurrentIterationValue}will be resolved as
Entity_1, so the import will be processed using Entity_1 as the value for the {Entity} import variable.
For the second iteration, the value Entity_2will be used, and so on. Using this approach, the import will
be processed for all entities in the iteration column.

Conditionally processing tasks in a job

You can configure a task so that it is only processed if a particular condition is met. This feature is
configured in the task settings, in the Task Control section, under Process task only if the value of this
expression is true.

To enable conditional processing, you must specify a logical expression that will resolve to either true or
false when the job is executed. If true, then the task is processed as normal. If false, then the task is
skipped.
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The logical expression is evaluated using an IF function on the Scheduler server as follows:

=IF(Expression, 1, 0)

You can enter any expression that would be valid in an IF function. You can use Excel functions, Axiom
functions, and Scheduler job variables in the expression. If you use a job variable, it must be placed in
quotation marks unless you expect the variable value to be resolved and evaluated as a number.

If the task is not processed because the condition resolves to false, this is not considered a failed task. If
there are other tasks in the job, they will be processed. If you want an entire job to be conditional, you
can do either of the following:

l Repeat the condition in each individual task settings. Keep in mind that the condition will be
evaluated for each individual task, which means that if it is possible for the condition to change in
between tasks, some tasks might be processed while others aren't.

l Use the condition on a Raise Event task that then triggers another job for processing. For more
information, see Raise Event task.

� Examples
The following are some example expressions for conditional processing:

GetData("Process","FG='2012 Budget'","SystemStatus")=1

If this GetData function returns 1, the expression resolves to true and the task is processed. If not, it is
false and the task is skipped.
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AND("{EventHandler.EventName}"="ProcessPlanFiles",{Dept}=1000)

If this job was triggered for execution by the ProcessPlanFiles event handler, and if the job variable Dept
resolves to 1000, then this expression is true and the task is processed. Note that in the first part of the
expression, the event handler variable will return a string value so it must be placed in double quotation
marks. In the second part of the expression, the department variable will return a number so it is not
placed in quotation marks.

AND(Day(Now())<=7,Weekday(Now())=2)

This expression will return true if it is the first Monday of themonth, otherwise it will return false.

Using RunEvent to execute a Scheduler job

Using RunEvent, you can trigger the execution of a Scheduler job from various contexts, such as within
Axiom files, task panes, or Axiom forms. There are two different versions of RunEvent:

l RunEvent function: The RunEvent function can be used in Axiom files to trigger the execution of a
Scheduler job from a spreadsheet.

l RunEvent command: The RunEvent command can be used in task panes or Axiom forms to trigger
the execution of a Scheduler job.

Both the function and the command work in the sameway and use similar parameters. Some limitations
apply depending on the context where RunEvent is being used. It is assumed that an administrator (or a
power user with the necessary rights) sets up the desired jobs within Scheduler, and then sets up
RunEvent in the appropriate context so that end users can trigger it.

The end user who triggers the job using RunEvent does not need to have file permission to the job or
any access to Scheduler. The job itself can be configured to execute its tasks using the permissions of the
job owner or using the permissions of the end user who triggered the job (the requester). If the job is run
as the requester, then the end user must have the appropriate permissions to the files impacted by the
job (for example to the target file for File Processing, or to the target file group and plan files for Process
Plan Files).

NOTE: You can also use the Raise Event Scheduler task to trigger the execution of a Scheduler job
from a different Scheduler job. This works in a similar manner as the RunEvent features.

� Setting up a Scheduler job for RunEvent
All uses of RunEvent require the same job setup in Scheduler:

l The job that you want to execute via RunEvent must already be created within Scheduler. When
setting up the job, consider items such as the notification settings. Do you want the notifications
to go to the user that executed the job, or to the job owner, or both?
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l The job must contain an event handler that will be used to trigger the job execution. When
creating the event handler, consider whether you want the job to run as the job owner, or as the
requester (the user who clicks on the RunEvent function). This may impact email notifications and
determines the user rights under which the job will run.

For more information, see Advanced options.

l Optionally, the job can use variables. Variable values can be defined in the RunEvent function or
command and passed to the job. You would do this if aspects of the job need to be dynamic; for
example, if you want to use a different filter depending on which user is running the job or based
on a user selection in the file. For more information see the Variable example section below.

� Setting up RunEvent
RunEvent uses the following properties to trigger Scheduler jobs:

l The event handler name that identifies the Scheduler job(s) to trigger for execution.
l An optional confirmation message to present to the user before proceeding with the event. Not

available when using the command within an Axiom form.
l An optional success message to present to the user after the event has been raised.
l An optional file group context to target the job execution to only event handlers that are

associated with a particular file group (or no file group). For the RunEvent command, this is an
optional parameter. For the RunEvent function, the current file group context is automatically
applied if the file with the function belongs to a file group.

l If variables are being used, one or more variable names and values to pass to the Scheduler job.
This is available in all contexts, however, task panes do not currently support the ability to
determine the variable values dynamically.

The following shows an example RunEvent function for use in an Axiom file:

=RunEvent("Click here to process plan files","ProcessPlanFiles","You are
about to process plan files for the "&C3&" region. Do you want to
continue?",,"filter = "&C4)

The first parameter defines the display text for the function, while the second parameter specifies the
event handler name. In this example we have also defined a custom confirmation message for the user
and a variable value to pass a filter to the job. The following screenshot shows the function in the
spreadsheet:

Administrator's Guide Axiom Contract Management │ 292



The next screenshot shows a RunEvent command set up on a Button component for an Axiom form. You
can see the same event name and the filter variable also being read from a sheet location.
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� RunEvent behavior and user experience
The behavior and user experience for RunEvent depends on the context and whether you are using
optional custom messages.

l The user starts the process by doing one of the following:
o Double-clicking the RunEvent function in the spreadsheet.
o Clicking the Button component that is configured for RunEvent in the Axiom form.
o Double-clicking the RunEvent item in the task pane.

l A confirmation prompt displays to the user, asking them to confirm that they want to proceed.
The user can click Yes to proceed, orNo to cancel. Default text is used if no custom text is defined
in the RunEvent properties.

NOTE: This step does not apply when executing RunEvent from an Axiom form. The Axiom
form context does not support a confirmation message. However, you can configure the
Button component to display a confirmation message before executing the RunEvent
command.

l Axiom Contract Management checks the list of event handlers in Scheduler to see if any match the
specified event handler name in RunEvent. This check works as follows:

o If RunEvent has a file group context, then Axiom Contract Management only tries to match
with event handlers that are associated with the same file group, or with no file group. Any
event handlers associated with a different file group are ignored. The RunEvent command
has a file group context if a file group is specified in the shortcut parameters, whereas the
RunEvent function automatically has a file group context if the file with the function belongs
to a file group.

o If RunEvent does not have a file group context, then all event handlers are eligible to match.

If any matching event handler names are found, then all Scheduler jobs that reference the event
handler are triggered for execution. If multiple jobs reference thematching event handler, then all
of those jobs will be executed.

If variable values are defined in the RunEvent properties, those values are passed to the job and
are used when the job is executed.
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l A confirmation message displays to the user as follows:
o If no jobs were found that contained the specified event handler, the user is notified that

no jobs were found.

o If jobs were placed on the schedule, the user is notified that the specified event was
scheduled. Default text is used if no custom text is defined in the RunEvent properties.

NOTE: If executing RunEvent from an Axiom form, this message displays in the bottom left
corner of the form, not in a separatemessage dialog.

When the job is finished processing, email notifications are sent according to the settings in the job.

� Variable example
When using RunEvent to execute a Scheduler job, you can pass a variable value to the job. For example,
imagine that you want to execute a Process Plan Files job, and you want to send a filter value to the job.

Step 1: Set up the variable in the job
The first step would be to create a job variable in the job, and then use the job variable in the filter
setting.

Example job variable

NOTE: In this case, we have defined a default value for the filter variable (1=0) that does not result in
any plan files. This is because we do not want to process any plan files unless a filter is provided by
RunEvent. If we left the default value blank, that would mean all plan files would be processed if no
filter was provided by RunEvent.
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Example use of variable in job settings

For more information on Scheduler job variables, see Using job variables.

Step 2: Configure RunEvent to use the Variable
Now that the job is set up to use the filter variable, you must configure RunEvent to pass in a value for
that variable. If you are using the RunEvent function in an Axiom file, you use the following syntax within
the function parameters:

variablename=variablevalue

These name / value pairs can be placed in the RunEvent function starting in the fifth parameter of the
function. If you have two name / value pairs to pass to the job, you can use the fifth and sixth
parameters, and so on.

For example, to pass the filter DEPT.Region='North' to the job, the RunEvent function would be
constructed as follows:

=RunEvent("Double-click to process plan
files","ProcessPlanFiles",,,"filter=dept.region='North'")

More likely, you would be reading the variable value from another place in the sheet, so the function
would look something like:

=RunEvent("Double-click to process plan
files","ProcessPlanFiles",,,"filter="&C4)

Where the filter value is read from cell C5.

When the job is executed by use of this RunEvent function, the value DEPT.Region='North'will be
placed in the Plan File Filter box of the Process Plan Files task, and the job will be run using that filter.
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When using RunEvent in an Axiom form, the variables and their values are defined in the Event Variables
section. In this context you place the name of the variable in the left-hand box, and then in the right-
hand box you enter the cell reference (in brackets) where the variable value will be read.

The Event Variables section is also present when configuring RunEvent for use in a task pane, however in
this context the only option is to "hard-code" the values in the RunEvent properties.

Run another Scheduler job from within a Scheduler job

Scheduler jobs have two ways to run another Scheduler job:
l Raise Event task: This task uses an event handler name to trigger one or more Scheduler jobs for

execution. The jobs triggered by the event handler are run independently from the job containing
the Raise Event task.

l Run Scheduler Job task: This task runs a specified Scheduler job as a subordinate job within the
current "parent" job. Essentially, the tasks in the target job are run within the parent job, which
means that other tasks in the parent job can reference the results of those tasks.

The decision of which task to use depends on several factors, but themost important is whether the
Scheduler jobs are independent or dependent. If the first job is dependent on the execution of the
second job, then you must use the Run Scheduler Job task. When the Raise Event task is used, the
triggered jobs are run independently.

The following chart details some comparison points between the two tasks:

Comparison Raise Event Run Scheduler Job

Can pass variables to target job Yes Yes

Can execute target job as requester or owner Yes No

Can wait for target job to complete before
continuing

No Yes

Can use results of target job in subsequent tasks No Yes

� Using the Raise Event task
The Scheduler Raise Event task is typically used when you need to trigger another job for execution once
the current job is complete. The Scheduler job(s) triggered by the event handler are added to the
schedule and then executed independently from the current job. For example, you might place the Raise
Event task at the end of the task list, so that all tasks in the current job must complete successfully
before the Raise Event task is run.
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Because the jobs triggered by the event handler are run independently, you cannot perform additional
tasks in the current job that depend on the results of the triggered jobs. The current job will not wait for
the triggered jobs to be run.

Event handlers can be configured to run a job as either the job owner or as the requester (meaning the
user that triggered the event). This allows some additional flexibility in how the triggered jobs are run.
For example, you may want to trigger a job that needs to be run using administrator permissions. As
long as the event handler is configured to run as job owner (and the owner is an administrator), then
that triggered job will always have the necessary permissions, regardless of the user who is running the
job with the Raise Event task.

� Using the Run Scheduler Job task
The Run Scheduler Job task is typically used when you need to run another job and then perform
additional tasks once that job is complete. Because the target job is run as a subordinate job within the
"parent" job, the parent job can wait for the "child" job to complete before it continues processing tasks.
Later tasks in the parent job can reference the results of the completed child job, such as querying data
saved from the child job, processing plan files created by the child job, and so on.

Keep in mind that if you want the parent job to stop processing tasks if the target job fails, thenWait for
all Subordinate Jobs to complete before proceeding to the next Taskmust be enabled for the task and
If this Task fails, continue executing subsequent Tasksmust be disabled for the task. This is the default
configuration.

The child job is run using the same user permissions as the parent job. The user running the parent job
must have the appropriate permissions to complete all tasks in both the parent job and the child job.

� Chaining multiple Scheduler jobs
You can "chain" multiple Scheduler jobs together using either approach. For example, you may have
three Scheduler jobs that you want to run, in a particular order.

You can placemultiple Run Scheduler Job tasks in a parent job, where each task triggers a separate job.
Because these tasks run as subordinate jobs, and the parent job can wait for each child job to complete,
it is easy to run the jobs in order. However, if you want to stop processing the jobs if one fails, there is no
built-in way to do that (as discussed in the previous section). You would need to set up the Run
Scheduler Job tasks to run or not based on a condition, where the condition tests some result from the
previous job.

To chain jobs using Raise Event, the last task in each job can be a Raise Event task. Each job will perform
its tasks and then trigger the next job in the chain. When using this approach, the chain automatically
stops if failure occurs, because if a task in the job fails then the job stops and will not proceed to the
Raise Event task. The disadvantage of this approach is that the jobs cannot also be run separately, unless
you manually disable the Raise Event tasks or configure the Raise Event tasks to not run based on a
condition.
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Running a job
If a job is saved with an active scheduling rule, then the job is automatically placed on the schedule to be
run according to that rule. Each time the job is run according to the rule, it is run as the current job
owner (unless it is a system job, in which case it is run as the System identity).

However, you can also choose to run a job manually. If you run a job manually, the job is added to the
Scheduled Jobs list with a start time of now, to be processed according to its job priority settings. The
job will be run using your user identity (again, unless it is a system job).

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

To manually run a job:
1. In the Scheduler dialog, in the Job tab, click Open.

The Axiom Explorer dialog opens, showing the Scheduler Jobs Library only.

2. Select the job and then click Open.

The job opens in the Scheduler dialog. Make sure the job is the active tab in the navigation pane
(themost recently opened tab is the active tab by default).

3. In the Job tab of the ribbon, click Run Once.

A confirmation message informs you that the job has been placed on the schedule.

NOTE: When you click Run Once, any unsaved changes to the job are automatically saved. This save
will designate you as the job owner (if you are not already the job owner).

You can also run jobs manually using the Scheduler area of theWeb Client. For more information, see
Running a job manually in theWeb Client.

Scheduler Task Reference
Each Scheduler task in a job has two sections of task properties:

l Task Control: Common task properties that apply to all task types. For more information, see
Task Control properties.

l Task Details: Properties specific to the current task type. For more information, see the topics for
each individual task type.

The following task types are available:
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Task Description

Active Directory
Import

Import users from Active Directory into Axiom Contract Management. This
task adds new users, and can also disable users that no longer exist in the
Active Directory domain.

Collect Worksheets Collect worksheets from multiple files into a single file.

Copy On Demand
Plan Files

Copy plan files from one on-demand file group to another.

Create Plan Files Create new plan files (same as the Create Plan Files utility for file groups).

Echo Task Test the Scheduler server. This task sends a message to the Scheduler
server and asks it to send themessage back.

Execute Command
Adapter

Execute a command from the Command Library.

Execute SQL
Command

Run a SQL statement on an Axiom database.

Export ETL Package Export data to an external database, using an export utility defined in the
Exports Library.

File Processing Perform file processing actions on a report. You can use the report's native
file processing settings, or override the settings.

Import ETL Package Import data into Axiom Contract Management, using an import utility
defined in the Imports Library.

Process Document
List

Process any set of Axiom files—for example, driver files or report utilities.
The task calculates and saves the files, and can also refresh Axiom queries
and save data to the database.

Process Plan Files Process plan files (same as the Process Plan Files utility for file groups).

Process Template List Process a template file. The task runs designated Axiom queries, time-
stamps the queries, and saves the template.

Purge System Data Purge old Scheduler results and system temp tables.

Raise Event Trigger another Scheduler job for execution, using a named event handler.

Run Scheduler Job Run another Scheduler job as a subordinate job.

SMTP Message
Delivery

Deliver email notifications resulting from Scheduler jobs.

Start Process Start a process definition for Process Management.

Update Indexes and
Constraints

Update the indexes and constraints in your Axiom Contract Management
database.
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Task Control properties
The following task properties are available for all Scheduler task types. To edit these properties, select the
task in the Scheduler job, then expand the Task Control section.

Item Description

Skip this Task If selected, the task will not be run when the job is processed.

By default, this option is not selected, which means this task will be run.

Process task only if
the value of this
expression is true

Optional. Enter a logical expression to conditionally process this task
depending on whether the expression resolves to true or false at the time
the job is executed. If true, the task is processed as normal. If false, the
task is skipped.

The logical expression is evaluated by the Scheduler server using an IF
function. The expression can be any statement that would be valid within
an IF function. You can use Excel functions, Axiom functions, and
Scheduler job variables in the expression. If you use a job variable in the
expression, you must place the variable in double quotation marks unless
you expect it to be resolved and evaluated as a number.

For more information, see Conditionally processing tasks in a job.

If this Task fails,
continue executing
subsequent Tasks

If selected, the job will continue processing even if this task fails.

By default, this option is not selected. If a task in a job fails, the job is
canceled and no further tasks are processed.

Create a Subordinate
Job for this Task

If selected, this task will be processed as a subordinate job to the current
job.

Selecting this check box enables concurrent processing of different tasks, if
the option toWait for all Subordinate Jobs to complete before
proceeding to the next Task is not selected.

NOTE: This option is not available for Process Plan File tasks.

Wait for all
Subordinate Jobs to
complete before
proceeding to the
next Task

If selected, the job will wait for any subordinate jobs to complete before
moving to the next task.

If this check box is not selected, and the option Create a Subordinate Job
for this Task is selected, then tasks can be processed concurrently instead
of sequentially.

This check box is selected by default for Plan File Refresh and File
Processing tasks. For other task types, this option is not selected by
default.
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Item Description

Override Log Level for
this Task

By default, Scheduler jobs perform logging at the same level that is
specified for the application. If necessary, you can override the logging
level for a particular task, so that it always runs at a specified logging level.
You may want to do this if you encounter performance issues for tasks
that generate a lot of logged messages.

To do this, select the check box forOverride Log Level for this Task, then
select the desired logging level from the drop-down list.

NOTE: This option is only available for File Processing tasks.

NOTE: Older systems may see a setting namedWorkbook processing engine to use. If this option is
present, it should always be set to Axiom Web Engine. Use of Excel for processing on the Scheduler
server is no longer supported. All Scheduler tasks that involve spreadsheet processing are processed
using the same spreadsheet emulation engine as theWindows Client.

Iteration
This section can be used to optionally enable iterative processing for the task. For more information, see
Using iterative task processing.

Item Description

Iterate this Task Specifies whether iterative processing is enabled for the task. If enabled,
then the task will be performed N times, where N is the number of unique
items in the specified iteration column. Job variables can be used to apply
the current iteration value and iteration number to the task.

Create a Subordinate
Job for each iteration

Specifies whether each iteration is processed as a separate subordinate
job. By default, this is disabled, which means that all iterations are
processed sequentially within the overall subordinate job created to
process the iterations.

If enabled, then each iteration is processed as a separate subordinate job,
enabling concurrent execution ofmultiple iterations. This option should
only be enabled if the order of iteration processing is not important.

Column The column that contains the values to iterate over. Use Table.Column
syntax to specify the column. Multiple-level lookups can be used.

For example, if you specify Dept.Region, then the task will be processed
once for each unique region value in the column (after applying any filter
to limit the list of values).
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Item Description

Group By Optional. By default, the group by column is the same as the iteration
column, so that the task is processed once for each unique value in the
iteration column. However, if needed, you can specify a different grouping
level.

You can use any column or columns that would be valid as the "sum by"
level for an Axiom query, where the primary table is the table specified for
the iteration column.

Order By Optional. By default, the values are sorted based on the iteration column,
in ascending order. You can specify a different sort column, or use the
same sort column but change the order to descending.

The sort order is ascending unless the keyword desc is used to specify
descending order. For example:

Dept.Dept desc

Filter Optional. A filter criteria statement to limit the list of values for the iterative
processing. You can use any filter that is valid against the source table (the
table of the iteration column).

Active Directory Import task
This task imports users from Active Directory groups into Axiom Contract Management security. For
more information on using Active Directory integration with Axiom Contract Management, see the
Security Guide.

This task has three tabs of settings: Source Directory, Notification, and Preview Import.

NOTE: The user running this task must be an administrator or have the Administer Security
permission.

For Axiom Cloud systems, the Active Directory Import task can import users from your local Active
Directory by use of the Axiom Cloud Integration Service. If you have a remote data connection that is
enabled for user authentication, this task will use that connection when the job is executed by Scheduler.

� Source Directory tab
On this tab, you specify the domain to import from and the groups to import.

Administrator's Guide Axiom Contract Management │ 303



Item Description

Domain or
Server

Select either Domain or Server to specify the source domain for the import.
l If you select Domain, enter the name of the domain.
l If you select Server, enter the name of the domain controller server.

The server option is available in case you are not currently logged into the
source domain, and your current domain does not have access to the source
domain. In this case, you must use domain credentials in order to access the
source domain.

Only one domain can be selected per import task. If you want to import users
from multiple domains into an Axiom Contract Management system, then you
must createmultiple import tasks.

Credentials Specifies the credentials to use when accessing Active Directory for the import.
Select one of the following:
l Use process credentials: (Default) Use the credentials of the network service

account for Axiom Scheduler Server (on-premise installations) or Axiom
Cloud Integration Service (Axiom Cloud systems).

l Specify domain credentials: Enter the credentials of a specified domain User
and Password. This option is required if you identified the source domain
using the server name instead of the domain name.

Never Enable
Users

Specifies whether the import enables imported users as part of the process:
l If unchecked (default), then newly imported users are enabled as part of the

import. Additionally, any existing imported users who have been changed to
disabled are re-enabled.

l If checked, then newly imported users are not enabled as part of the import.
A security administrator must modify the security settings after the import is
complete to enable the new users. Existing imported users retain their
current enabled status.

Groups to
import

The Active Directory groups for which members will be imported into Axiom
Contract Management Security.
l Click Add to select from a list of groups for the specified domain. If the

specified domain name is not valid or if Axiom Contract Management cannot
connect to it, then an error will result when attempting to add groups.

l If you need to remove a group, select the group and click Remove.
l Click Role Mapping to definemappings for the selected groups. If a mapping

exists for a group, then when users are imported for that group they are
automatically assigned to themapped role and subsystem. See the
discussion following this table for more information.
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Role mapping
In the Role Mapping dialog, click Add mapping (the plus icon) to add a role mapping for a group. Then
complete the following:

l In theDirectory Group column, select the Active Directory group to bemapped.

l In the Axiom Role column, select the role to be assigned to users in that group. If you want to
map the group to more than one role, add another mapping row. You can select None if you do
not want the users in the group to be assigned to any role.

l In the Subsystem column, select the subsystem for users in that group. If you want to map the
group to more than one subsystem, add another mapping row. This option only displays if
subsystems are enabled for your system.

l In theUser Type column, select the license type for the imported users. The default license type is
Standard.

l In the Authentication Type column, select the authentication type for the imported users,
Windows User or SAML. The default authentication type is Windows User. Note that the selected
authentication type will be assigned to users regardless of whether that authentication type is
currently enabled for the system.

You can map each group to multiple roles and subsystems. If a group has no defined mappings, then the
users will not be assigned to any roles or subsystems. If the import creates new users without mappings,
the assigned user type is Standard and the assigned authentication type is Windows User.

To remove a mapping, select themapping in the grid and then click Remove mapping (the X icon). If
users have already been imported using this mapping, removing themapping will not remove the users
from the role or subsystem in subsequent imports (unless other group mappings in the import use the
same role or subsystem, and the users are not also part of that group).

NOTE: If a user belongs to multiple mappings—either multiple mappings for a single group, or
multiple mapped groups—then the user will be assigned to the user type and the authentication
type for the last-processed mapping.

� Notification tab
On this tab, you specify users to be notified when changes aremade in Axiom Contract Management
Security due to the import.

Type in one or more email addresses to be notified. Separatemultiple addresses with a semi-colon. For
example:

jdoe@axiomepm.com;jsmith@axiomepm.com
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When the import task is run, if any users are created or modified in the Axiom Contract Management
system, an email notification will be sent to the addresses specified here. The email summarizes the
changes made. This email notification is independent of any job-level notification settings (which notify
based on overall job completion or failure).

We recommend setting up this task-level notification to send emails to the security administrator(s)
responsible for maintaining the security settings in Axiom Contract Management, so that he or she can
define security settings for newly added users, validate changes made to existing users, and perform any
other follow-up tasks.

Scheduler job variables can be used in this setting.

� Preview Import tab
On this tab, you can preview the import results to test that the import is set up as desired.

To preview the results, click Preview. Axiom Contract Management processes the import task but does
not actually make the changes to the system. Instead, the tab displays a summary of the changes that
would result.

The preview shows a list of users that would be added, changed, or disabled.

NOTE: The preview is always executed locally, even for Axiom Cloud systems. The remote data
connection to the Cloud Integration Service is only used when the task is executed by Scheduler.

Collect Worksheets task
This task collects sheets from multiple source workbooks and combines them into a single target
workbook. You can then save the target workbook to a specified file location, and/or email the
workbook.

NOTE: This task is primarily intended for backward-compatibility only. Themain method of
performing a file collect operation is to use the file processing feature with the File Processing
Scheduler task. For more information on setting up a file collect report using file processing, see the
Axiom File Setup Guide.

Typically, this task would be used at the end of a job with multiple File Processing tasks, to take the
results of those tasks and collect them into a single workbook.
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Item Description

Save or Email
Workbook

Specifies the delivery option for the target workbook. Select one of the
following:

l Save Workbook: The target workbook is saved to the specified output
folder.

l Email Workbook: The target workbook is emailed to the specified recipients.
The file is not saved anywhere on the file system.

l Save and Email Workbook: The target workbook is both saved and emailed.

� Target Workbook
Complete the following settings to define the target workbook:

Item Description

Output Folder The folder location where the target workbook will be saved (if you are saving
the workbook). Click the folder icon to select a folder location, or type a folder
location.

If the specified folder does not already exist, Axiom Contract Management
attempts to create it.

Job variables can be used in this setting.

Output File
Name

The name of the target workbook. Job variables can be used in this setting.

File Type The file type of the target workbook. Select XLS, XLSX, or XLSM.

NOTE: PDF displays as an option, but it is not supported in this context.

� Email Settings
This section only applies if you are emailing the target workbook. The "From" address is always the
Scheduler default From address (as defined in the system configuration settings).

Item Description

To Enter the email addresses to receive the target workbook via email. Separate
multiple addresses with a semicolon.

Subject Line The subject line for the email.

Body Text The body text for the email.
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� Source Workbooks
In this section, you specify one or more source workbooks from which to collect worksheets. Workbooks
are identified by folder location. Within a folder location, you can specify one or more workbooks by
name, or by using wildcards, or by using *.* to collect all workbooks at the location.

All sheets in each source workbook will be collected. Ideally, you will be collecting from workbooks that
only contain relevant sheets (for example, no blank "Sheet2," etc.), and where the sheets have unique
names. If multiple workbooks have sheets with the same name, the sheets will be incremented by
number in the target workbook.

To add a workbook, click the Add button. In the Edit Workbooks Source dialog,
complete the settings as described below, then click OK to add the workbook to the
list.

To remove a workbook, select the workbook in the list and then click the Remove
button. Only one workbook can be selected at a time.

To change the order of workbooks, select the workbook in the list and then click the
arrow buttons to move the workbook up or down. Source workbooks are processed
in the order they are listed in the grid.

Item Description

Folder Path The folder location of the source workbook(s). Click the folder icon to select a
folder location.

NOTE: The Folder Path location must be accessible by the Scheduler service
user account. If you specify a network folder location using the Browse button,
the location is automatically entered as a UNC path. If you specify a C: drive
location, that will be evaluated as the C: drive of the Scheduler server.

Job variables can be used in this setting.

Workbooks The workbooks from which you want to collect worksheets, within the specified
folder path.

l Specify *.* if you want to collect all files in the folder path.
l Specify individual file names to collect from specific files. Separatemultiple

file names with semicolons.

You can use wildcards (* or ?) to specify groups of files that share naming
conventions. For example: North*.xls to collect all XLS files where the file
name starts with "North".

Only files with the following file types are valid to be collected: XLS, XLSX, XLSM.
If you are using wildcards, thematches must be valid file types, or else the task
will fail with an error.

Job variables can be used in this setting.
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Once you have saved a source workbook location, you can edit it by double-clicking the row.

Copy On Demand Plan Files task
This task copies on demand plan files from one file group to another. It performs the same actions as the
Copy On Demand Plan Files command in the Command Library.

This is an advanced feature and should only be used if it is the only way to achieve the desired
population of plan files between two related file groups. It is the responsibility of the solution designer to
ensure that the copied plan files will behave as expected in the target file group. For example, the plan file
must be designed to dynamically save to the appropriate tables and columns within the context of the
new file group.

The Copy On Demand Plan Files task uses two tabs to define the properties of the task.
l Options: Defines the options to be used for the copy operation
l Plan Files: Specifies the plan files to copy

� Options tab
The following options are available on the Options tab. Note that all of these options can be changed
dynamically by using system variables.

Item Description

Source File
Group

The file group to copy plan files from. Click the folder icon to select a file group.
You can select any on-demand file group, or any file group alias that currently
points to an on-demand file group.

Destination File
Group

The file group to copy plan files to. Click the folder icon to select a file group. You
can select any on-demand file group, or any file group alias that currently points
to an on-demand file group.

Keep original
plan file creator

Specifies whether the plan file creator for the copied plan files is set to the same
creator as the original plan files. By default, this option is enabled.

If this option is disabled, then the plan file creator for the copied plan files is set
to the user identity used by the Scheduler job when it is run.

Administrator's Guide Axiom Contract Management │ 309



Item Description

Use default
template

Specifies whether the copied plan files have the option to adopt the default
template of the new file group. This is primarily intended to be used when
copying plan files to a file group that uses virtual, form-enabled plan files, so
that the copied plan files can be converted to virtual files and use the new
template.
l If disabled (default), then the target file group must contain copies of the

original templates that were used to create the plan files from the source file
group. If these templates are not present, then the copy process will fail.

l If enabled, then the copied plan files will be assigned a template as follows:
o If the target file group contains copies of the original templates that were

used to create the plan files from the source file group, the copied plan
files use those templates.

o If the target file group does not contain copies of the original templates,
the copied plan files use the default template specified for the target file
group in the file group properties.

If the target file group does not contain copies of the original templates and
does not have a designated default template, then the copy process will fail.

Copy plan file
attachments

Specifies whether plan file attachments are copied to the target file group when
a plan file is copied. By default, this option is enabled.

If this option is disabled, then plan file attachments will not be copied to the
target file group.
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Item Description

Save plan files
after copy

Specifies whether the new plan files are processed and saved in the target file
group after the copy is performed. This is intended to perform a save-to-
database within the context of the new file group. By default, this option is
disabled.

If you enable this option, then after the plan files are copied to the new file
group, they are opened, refreshed, and saved (including a save-to-database).
The refresh includes all active Axiom queries where Refresh during document
processing is enabled.

Regardless of whether this option is enabled, if it is ever intended to save the
copied plan files in the target file group, then they must be designed so that
they save data to the appropriate tables after being copied.

NOTES:
l If Process with Utilities is enabled for the target file group, then utility

processing is performed instead of normal processing. The default data
source is used.

l If you enable this option but also specify a Copy data utility, then the new
plan files are not processed and saved. Instead, the designated utility file is
processed for each new plan file.

Copy data utility Optional. Specifies a utility file to process for each copied plan file. You can select
any file in the Utilities folder of the target file group, or a file in the Reports
Library.

The primary purpose of this option is to handle copying virtual plan files
between file groups. Because the plan files are virtual, no data exists in the file
itself and therefore saving the new plan file will not populate data for the new
file group. Instead, you should create a utility file that queries in the necessary
data for the original plan file, then saves the necessary data for the new plan file
to the appropriate tables for the new file group. Reserved document variables
are available to return information in the utility file such as the old plan file code
and the new plan file code.

For more information, see Copy data utility.

NOTE: Save plan files after copymust be enabled in order to specify a copy
data utility. If a utility is specified, then the new plan files are not saved and
instead the utility file is processed for each new plan file.

Default Values Optional. This section can be used to apply default values to any columns in the
target plan code table, when the new record is created in the target file group.
For more information, see Defining default values.
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� Plan Files tab
On the Plan Files tab, specify the plan files from the source file group that you want to copy to the target
file group. There are three different options that you can use to specify the plan files: Choose from list,
Use filter, and All.

Themost common option when copying plan files using Scheduler is to define a filter. You can
dynamically copy a subset of designated plan files using the filter. If the Scheduler task is triggered by
using RunEvent, you can pass in the filter from the source of the RunEvent (such as an Axiom form).

Copy a filtered set of plan files
To use a filter to copy a subset of plan files, select Use Filter. When the Scheduler task is executed, Axiom
Contract Management will process only the plan files that meet the filter. You can specify the filter
directly, or use a job variable.

To specify the filter, click the Filter Wizard button. You can also manually type a filter criteria statement
into the filter box. The filter must use the plan code table of the source file group, or a lookup table. For
example: CapReq2020.Transfer=1, where CapReq is the plan code table.

Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

If you want to set the filter dynamically, you can use the Filter system variable to override the filter
defined in the task. This is intended for use when running Scheduler jobs via RunEvent. If a variable value
is specified when triggering the event, such as the value CapReq2020.CapReq IN (45,67,98) , then
that filter statement is used to determine the plan files to be copied instead of the filter defined in the
task.

Copy all plan files
To copy all plan files, select All. When the Scheduler task is executed, Axiom Contract Management will
copy all plan files in the file group (except for those hidden via the Show on List column). This is not a
common use case for the copy feature, but can be used if needed.

Copy selected plan files
To copy certain plan files, select Choose from list, and then select the check boxes for the plan files that
you want to copy. When the Scheduler task is executed, Axiom Contract Management will copy only the
selected plan files. This is not a common use case for the copy feature, but can be used if needed.

NOTE: This option is not available when using a file group alias as the source file group for the task.
This is because the alias could change to point to any file group, which could result in a different list of
plan files.
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� Defining default values
When the copy action is performed, the columns for the new record are populated as follows:

l If a value has been defined for a column in theDefault Values section, that value is used.
l Otherwise, the value from the original record in the source file group is used. This only occurs if

the column names match in the source and target tables, and if the column in the target table is a
compatible data type to accept the copied value.

If a column exists in the source table but not the target table, that value is ignored and does not cause an
error. If a column exists in the target table but not in the source table, then it is only populated during
the copy action if a default value has been defined. If the target table contains columns with lookup
relationships, those columns must be populated with valid values (either from the original record or by
using default values) or else the copy action will fail.

To define default values for the new records:
l Click the plus button to add a new column/value pair to theDefault Values section.

l In the left-hand box, type the name of the column in the target plan code table. For example:
SourceID. Do not use Table.Column syntax.

l In the right-hand box, type the value to be placed in this column. You can enter a "hard-coded"
value, or you can enter the name of a column from the source plan code table in brackets to use
the value from that column. For example, [CapID]. The column reference is only necessary if you
want the source column value to be placed in a column that has a different name than the source
column. If the columns have the same name, the value will be copied automatically as noted
previously in this section.

For both the column name and the value, you can use file group variables via a file group alias. Axiom
Contract Management looks up the current target of the alias, and finds the current value of the
designated variable within that file group. Built-in variables and custom variables can both be used. To
reference a variable, use the following syntax:

{FileGroupAliasName.VariableName}

For example: {CP_CurrentYear.FileGroupYear} returns the file group year for the file group
that is currently the target of the CP_CurrentYear alias.

Scheduler job variables can also be used in the column name and in the value.

� Overriding task settings using system variables
All of the settings for the Copy On Demand Plan Files task can be overridden using system variables. This
is intended for use when the task is being triggered by RunEvent (such as from within an Axiom form),
and you want to pass in variable values to determine how the task is run.

The variable names for this task are as follows:
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Variable Description

CopyDataSourceFileGroupID Overrides the Source File Group. Must be set to a valid file group ID.
File group names or alias names cannot be used.

CopyDataTargetFileGroupID Overrides theDestination File Group. Must be set to a valid file
group ID. File group names or alias names cannot be used.

CopyDataUtilityPath Overrides the Copy data utility. Must be set to a valid document
path in Axiom Contract Management.

Filter Overrides the Plan File Filter to specify the plan files to copy. Must
be set to a valid filter criteria statement.

KeepOriginalPlanFileCreator Overrides the option Keep original plan file creator. Must be set to
a valid Boolean value (True/False).

UseDefaultTemplate Overrides the option Use default template. Must be set to a valid
Boolean value (True/False).

CopyPlanFileAttachments Overrides the option Copy plan file attachments. Must be set to a
valid Boolean value (True/False).

SavePlanFilesAfterCopy Overrides the option Save plan files after copy. Must be set to a
valid Boolean value ( True/False).

To override task properties using these variables:
l Add the variables that you want to use to the Job Variables tab. For example, if you want to

override the source and target file groups, the copy data utility, and the plan file filter, then add
those variables to the Job Variables tab. You do not need to add a variable name if you do not
plan to override it.

Example Job Variables tab to override certain settings for the copy task

You do not need to define a default value for the variable. If the value is blank, then the setting
defined in the task is used. The corresponding task property will only be overridden if the variable
has a defined value.

l You do not need to add the variables to the task properties. The variables automatically overwrite
the task properties if they have defined values.
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l When configuring RunEvent, define values for the variables as needed. For example, you could
have a form where you allow the user to select the source and target file group for the copy
action. Based on the user's selected file group names, you can use the GetFileGroupID function to
determine the IDs for those file groups. You can then pass those IDs as variable values for the
variables CopyDataSourceFileGroupID and CopyDataTargetFileGroupID.

Example RunEvent properties to pass certain variable values to the copy task

� Plan file process considerations
If the target file group has an active plan file process, the new plan file is started in that process as part of
the plan file creation. The process initiator for the plan file is set as follows:

l If the plan file process has a designated Process Initiator Column, the user listed in that column is
the process initiator.

l If the plan file process does not have a Process Initiator Column, or the column value is blank,
then:

o If Keep original plan file creator is enabled for the command, then the original plan file
creator is the process initiator.

o Otherwise, the user performing the copy operation is the process initiator.
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� Copy data utility
If a Copy data utility is specified, this processing is performed as follows:

l The selected plan files are first copied to the new file group. If the plan files are virtual, then the
placeholder document records are copied instead of physical plan files.

l The utility file is opened once before processing begins. Any data lookups or Axiom queries that
are configured to refresh on open are executed at that time.

l The utility file is then iteratively processed for each new plan file as follows:
o Document variables are set in the utility, and the workbook is calculated.
o Axiom queries set to Refresh during document processing are refreshed.
o A save-to-database is executed.

The utility file is not closed and reopened for each new plan file. All processing occurs within the same file
session, similar to when performing multipass file processing.

The following reserved document variables are available to the utility file, to be returned using
GetDocumentInfo. These variables return necessary information about the copied plan files and the
source and target file groups.

Variable Description

SourceFileGroupID The ID of the source file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to query from the source file group.

SourcePlanCode The plan code of the original plan file from the source file group. You can
use this code to filter Axiom queries to return data for the original plan file.

TargetFileGroupID The ID of the target file group. You can use this ID in functions such as
GetFileGroupVariable—for example, to return the name of the data table
to save data to for the target file group.

TargetPlanCode The plan code of the new plan file in the target file group. You can use this
code to save data for the new plan file.

For example, GetDocumentInfo("Variable","SourceFileGroupID") returns the ID of the source
file group.

Create Plan Files task
This task creates plan files for a file group. It works the sameway as the Create Plan Files utility that is
available from the file group menu.

This task has two tabs of settings in the Task Details area: General and Plan Files.
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NOTE: If you are using Create Plan Files to create new on-demand plan files, those plan files will be
automatically started in the designated Plan File Process for the file group. This only applies when
creating a brand new plan file. If an existing plan file is overwritten, its process status will be left as is.

� General tab
The following settings are available on the General tab:

Item Description

Select File Group The file group for which plan files will be created. You can select any file group or
file group alias.

If the Scheduler job is stored in a file group Utilities folder, then you can select
Use Current File Group to automatically use the file group that the Scheduler
job belongs to. This is the recommended approach when the Scheduler job
belongs to a file group, so that it will automatically update to point to the
current file group when the file group is cloned.

NOTE: If the task uses an alias, then you cannot select individual plan files on
the Plan Files tab. Only theUse Filter and All options are available.

Overwrite
existing plan
files?

By default, this option is not selected, which means that existing plan files will
not be overwritten, even if the plan file is selected to be created.

If selected, existing plan files will be overwritten.

� Plan Files tab
On the Plan Files tab, specify the plan files that you want to create. This tab lists all plan codes that you
have the right to access. (If a plan code has been set to False in the designated Show On List Column for
the plan code table, then it is not available in this list.)

You can create plan files in any of the following ways:
l Create all plan files: To create all plan files, select All. This will cause all plan files to be created, for

all existing and future plan codes.

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all plan codes to be selected, but then the list of plan codes is fixed and will not adjust for
any future changes. For example, if you add a new department in the future, that new
department will only be created by this task if you use the All option.

Administrator's Guide Axiom Contract Management │ 317



l Create selected plan files: To create certain plan files, select Choose from list and then select the
check boxes for the desired plan codes.

To find the plan files you are looking for, you can sort, filter, and group the list using standard
Axiom grid features. You can show additional columns and hide columns by right-clicking in the
column header. If you have filtered the list, you can select the check box in the header to select
only the plan codes that currently display in the dialog.

NOTE: This option is not available if the file group for the task is an alias. This is because the list
of plan files could change when the alias target changes.

l Create a subset of plan files using a filter: To use a filter to create a subset of plan files, select
Use filter, and then type a filter into the filter box. You can also use the Filter Wizard to build the
filter. The filter must use the plan code table or a reference table that the plan code table links to.
For example: DEPT.Region='West'.

Once you have entered a filter, you can click Refresh plan file list to show only those plan codes
that currently match the filter. This feature is to help you determine whether you have defined the
filter as intended. The filter will be applied to the list of plan codes when the Scheduler job is
processed, so if changes have been made to the plan code table since then, the actual list of plan
files processed will reflect those changes.

You can also use a job variable for the filter. For example, you can define a job variable named
"filter" and then place the text {filter} in the filter box. This is intended for use when running
Scheduler jobs by using the RunEvent function. If a value is specified in the RunEvent function,
such as "Filter=dept.region='west'", then that filter will be used in place of the {filter} variable
to determine the list of plan files to be created.

NOTE: If you use a variable, and you leave the default value for that variable blank within the
Job Variables tab, then all plan codes will be created if no value is passed by the RunEvent
function (or if the value is invalid). You may want to define a default filter that results in no
values (such as 1=0), so that plan files are only created if a valid filter value is passed.

IMPORTANT: For all of these options, theOverwrite existing plan files option on the General tab
determines whether all selected plan files are created, or only the plan files that do not already exist.

Echo task
This task is used for testing purposes only, to check whether a Scheduler server is running and
operational. The task sends a message to the Scheduler server, and asks it to send themessage back (an
"echo"). If successful, themessage displays in the job results. No other action is performed.
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Item Description

Message to Echo Themessage to send to the Scheduler server for testing.

Job variables can be used in this setting.

Sleep Time The time to pause in between message echoes, in seconds. Scheduler will echo
themessage once, then wait the specified sleep time, then echo themessage
again.

Execute Command Adapter task
This task executes a selected command from the Command Library.

� Task properties
This task has one property named Command Name that specifies the command to execute.

To select a command to execute:
1. Click Edit Command.

2. In the Shortcut Properties dialog, click the browse button [...] to the right of the Shortcut Target
box.

3. In the Axiom Explorer dialog, select the desired command from the Command Library, then click
Open.

This returns you to the Shortcut Properties dialog. The selected command is now listed in the
Shortcut Target box, and the Shortcut Parameters section displays the parameters for the
command.

4. Complete the Shortcut Parameters for the command as needed. The available parameters
depend on the selected command.

You can later edit the shortcut parameters or select a different command by clicking Edit Command.

� Supported commands
Only certain commands are available for execution in this context. The following commands are available:

l File Group Rollover
l Create File Group Scenario

l File Group Rollover
l Create File Group Scenario

Systems with installed products may have Scheduler jobs that use the following additional commands:
l Create File Group From Prototype
l Upgrade File Group To Prototype Version
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These commands can only be configured by product developers. Clients looking for more information on
how to use a particular product-delivered Scheduler job should consult their product documentation.
Syntellis employees should consult internal resources for more information on this feature as needed.

Execute SQL Command task
This task runs a SQL statement on an Axiom database. If needed, you can also use this task in a user-
defined job to run any valid SQL statement on an Axiom database.

NOTE: The SQL statement in this task will be run as the Axiom database user, regardless of which
user executes the job.

This task has the following settings:

Item Description

Source Axiom
Database

Select the database on which to run the SQL statement:
l Current system database: The database for the current system.
l Current audit database: The corresponding audit database for the current

system.

SQL Command
Text

Enter any valid SQL statement to be run against the specified database.

To validate the syntax of the SQL statement, click the Check SQL syntax button
. Axiom Contract Management sends the statement to your database server

to see if the statement can be parsed, resulting in either a success message or
an error message.

Job variables can be used in the SQL statement. The Check SQL syntax button is
not available if the statement uses variables.

Export ETL Package task
This task exports data from Axiom Contract Management to an external database (same as executing an
export from the Exports Library).

This task has one setting, Select ETL Export Package. This is the name of the export package to process.
You can select any export that is defined in the current system.

File Processing task
This task performs file processing on a specified report file or file group utility. The file must already be
enabled for file processing. You can use the file processing settings that are already in the file, or you can
override any setting.

The following settings must be completed for the task:
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Item Description

File to Process The report to process for the task. Click the Browse button to open the Axiom
Explorer dialog, and then select a report to process. You can select any report
that you have access to within the Reports Library or a file group Utilities folder.

Only one report can be selected for each File Processing task. If you want to
process multiple reports, you can add multiple File Processing tasks to the
Scheduler job.

TIP: Once the file is selected, only the file name displays in the task. If you want
to know the folder location of the selected file, hover your cursor over the field.
The folder location is listed in the tooltip.

If this Scheduler job is stored in a file group Utilities folder, then you can
optionally navigate to the report through the Current File Group node at the
top of the file groups list. When you do this, the path to the file is stored relative
to the current file group, which means that it will automatically update when
the file group is cloned. This is the recommended method of referencing the
report to process when both the Scheduler job and the report belong to the file
group.
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Item Description

Override file to
process

Optional. Specifies a Scheduler job variable to override the file to process. The
override file will then be used for processing instead of the original file. This
feature allows you to pass in an alternate file to process, when using Run Event
or Raise Event to trigger the Scheduler job for processing.

To use a job variable, enter the variable name in curly brackets, such as
{MyFile}. When the job is executed, this variable must resolve to a valid file
path in the Axiom Contract Management file repository. Note that it is not valid
to leave the variable value blank (the task will not use the original file to
process).

NOTES:
l The override feature is only exposed to product developers. It is only

visible in client systems if the job is delivered as part of a product package
and an override variable is specified in that job.

l The File to Process field must point to a valid file for file processing when
the override feature is used, even though that file will never actually be
processed by the task. If the file to process is missing or invalid, then the
task validation will fail.

Process
Multipass

Specifies whether the report will be run using multipass processing.
l If this option is selected, multipass processing is performed. This is

equivalent to selecting File Output > File Processing > Process File
Multipass.

l Otherwise, multipass processing is not performed and multipass settings do
not display in the task. This is equivalent to selecting File Output > File
Processing > Process File.

NOTE: If you select Process Multipass, but the file does not have any defined
multipass settings, then you must override the blank multipass settings for the
file and define them in the equivalent of "advanced mode." If you want to use
"basic mode" settings (specify only a source column and Axiom Contract
Management automatically completes the rest of the settings for you), then
you should edit the file to define the basic modemultipass settings so that they
can be inherited by the task.

Enable iterative
calculation while
processing

Specifies whether iterative calculations are enabled for the file during
processing. In most cases you will leave this option disabled.

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings are
fixed at a maximum of 100 iterations and a maximum change value of .001.

For more information on iterative calculations, see theMicrosoft Excel Help.
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� Advanced options
This section only displays if multipass processing is enabled for the task, and the task uses settings that
are eligible for parallel processing. Click on the down arrow next to the title to expand the section and
view the options.

Parallel processing for file processing tasks is performed based on multipass passes. With certain task
settings, multiple passes can be separated into sub-jobs, which can then be processed at the same time
(in parallel). This can improve the performance of the task.

For example, imagine that you aremultipass processing a file by department. If the task is processed
sequentially, then the task would process Dept 100 and finish it, then move to Dept 110 and finish it, etc.
When parallel processing is used instead, Depts 100-199 can be separated into one sub-job, Depts 200-
299 into another sub-job, etc. Because the sub-jobs are processed in parallel, multiple departments are
processed at the same time, so the overall task can completemore quickly.

Item Description

Maximum
Parallel Jobs

Themaximum number of subordinate jobs to run in parallel. The default
number is 4.

This is the total number of sub-jobs that can be run at the same time for this
task. Ultimately the number of sub-jobs that are run in parallel depends on the
number of Scheduler threads that have been configured for use at your
organization, and the number of Scheduler threads that are currently available
(threads that are not processing other higher-priority jobs).

Processing Batch
Size

The number ofmultipass passes to include in each sub-job at a time. The
default number is 10 for eligible snapshot and export processes, and 7000 for
eligible save-to-database processes (save once at end).

Passes are determined based on themultipass list of items. For example, if you
are processing by department (DEPT.DEPT), then each department is a separate
pass. If the batch size is set to 10, then each sub-job would process 10
departments at a time.

In most cases, the default settings are sufficient. If you are experiencing lengthy
processing times and want to optimize performance, you can adjust this setting
as follows: divide the number of passes by the number of available Scheduler
threads. For example, if there will be 100 passes and there are 4 Scheduler
threads, set the batch size to 25.
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NOTES:
l For save processes, only "save once at end" processes are eligible for parallel processing. In

this case, the records to be saved to the database are extracted after each pass to a central
temporary table. Once all passes are complete, then all records are saved to the database
from the temporary table. Save processes where data is saved directly after each pass are not
eligible, because these processes may depend on sequential processing.

l There is no way to disable parallel processing if the task is eligible; however, you can adjust the
parallel processing settings if desired.

� File processing settings
Once you have selected a file to process, the file processing settings from that file display within the task
as read-only. You can leave the settings as they are, or you can override any setting.

l To override a setting, select theOverride check box to the right of the setting. The setting
becomes editable, and you can change it. The change only applies to the file processing task—the
setting remains unchanged within the file.

l If you override a setting, make sure that any related settings make sense in the context of the
change. For example, if File Generation is set toMultiple Output Files, and you override it to be
Single Output File, then you should also check the Sheet Names setting to make sure that you
will end up with unique sheet names within the file.

NOTE: If the target file for the task uses File Collect or Batch processing, then it is not possible to
override the settings on the File Collect Configuration Sheet or the Batch Control Sheet.

For more details on file processing settings, see the Axiom File Setup Guide.

Note the following requirements when running file processing using Scheduler:
l TheOutput Folder location must be accessible by the Scheduler service user account. If you

specify a network folder location using the Browse button, the location is automatically entered as
a UNC path. If you specify a C: drive location, that location will be evaluated as the C: drive of the
Scheduler server.

l If the file processing type is Print, the Scheduler server(s) must be configured to access the
specified printer. This may require the assistance of your IT department.

Job variables can be used in any file processing setting that accepts a typed user input.

� Batch variables
If the file has defined batch variables, you can specify variable values to be used for the file processing
task. When the task is executed, any specified variable values are temporarily placed within the file,
within the designated cell for that variable value. The file can be set up to use the variable value in some
way during processing.
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Item Description

Variable Names The names of the variables, as defined in the File Processing Control Sheet for
the source file. If no names are listed, then no variables are defined in the file.

Variable Values The variable values to be placed within the file when the file processing task is
executed.

Job variables can be used in the batch variable settings. For example, a job variable can be used as the
value for a batch variable.

Import ETL Package task
This task imports data into Axiom Contract Management (same as executing an import from the Imports
menu).

NOTE: If the import package is configured to Ignore lookup and key errors, then if errors are found
the execution status of the job will be Partial Success. This will trigger an email notification if the job is
configured to notify only on error.

Item Description

Select ETL
Import Package

The import package to process. You can select any import that is defined in the
current system.

Source Filename The path and name of the source file. This option only applies in the following
situations:

l The import is configured to pull data from a source file (instead of a database
table).

l The import is configured to prompt the user for the source file during
execution.

If the import is configured to always use the same source file, then that file
displays for reference in the Source Filename box, but it is grayed out and
cannot be changed.

Job variables can be used in this setting.

Package
Variables

Specifies values for any variables used in the import package.

Variables are listed in the right-hand side of the grid. Use the drop-down list next
to the variable name to select from the defined set of choices, or type in a value.

Job variables can be used in this setting.
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Process Plan Files task
This task processes plan files in a file group. It performs the same actions as the Process Plan Files utility
available from the file group menu.

The Process Plan Files task uses several tabs to define different options. The available tabs and the
options on those tabs depend on the selected Processing Mode on theOptions tab.

l Options: Defines the overall processing mode and processing options
l Plan Files: Specifies the plan files to process
l Axiom Queries: Specifies which Axiom queries to run in plan files (only applies to Normal

Processing)
l Utilities: Specifies which data source to use for utility processing (only applies to Process with

Utilities)
l Processing Variables: Defines variables to pass into plan files from Scheduler, and to Scheduler

from plan files

� Options tab
The following options are available on the Options tab:

Item Description

Processing Mode Select the type of processing to perform:
l Normal Processing: Plan files are opened, refreshed, and saved. You

can configure which actions occur.
l Process with Utilities: A list of utilities is iteratively processed per plan

file. Utilities are opened, refreshed with data for each plan code, and
saved. This is primarily intended for processing form-enabled plan files
with embedded forms.

l Update Persistent Plan Files: Update existing plan files for text,
formatting, or formula fixes. This is an advanced feature.

l Process with Custom Utility: Plan files are processed using a custom
utility provided by Axiom Support. This is an advanced feature.

The default processing mode is Normal Processing. However, if the file
group has been configured so that utility processing is the default
processing mode for that file group, then Process with Utilities is selected
by default.
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Item Description

Select File Group The file group for which plan files will be processed. You can select any file
group or file group alias, including file group scenarios (click Show
Scenarios in the Choose File Group dialog to show scenarios in the file
group list).

If the Scheduler job is stored in a file group Utilities folder, then you can
select Use Current File Group to automatically use the file group that the
Scheduler job belongs to. This is the recommended approach when the
Scheduler job belongs to a file group, so that it will automatically update to
point to the current file group when the file group is cloned.

NOTE: If the task uses an alias, then you cannot select individual plan files
on the Plan Files tab. Only theUse Filter and All options are available.

Advanced Options:
Worker Batch Size

Optional. Specifies the number of plan files to be processed in each batch.
The batch size must be a number between 10 and 100.

By default this is left blank, which means that the batch size is
automatically calculated based on the number of plan files to be processed
divided by the total number of threads on all enabled Scheduler servers.
Generally speaking, you should not customize this setting unless you are
advised to by Axiom Contract Management Support.

NOTE: Each batch of plan files is processed by a subordinate job. These
subordinate jobs are automatically created for the Process Plan Files task
and are processed in parallel, dependent on the number of Scheduler
threads that are available at any one time.

Options for Normal Processing mode
If Normal Processing is the selected processing mode, the following additional options are available on
the Options tab:
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Option Description

Save document
after processing

Specifies whether plan files are saved during processing. This option is selected
by default.

This option does not cause a save-to-database to be performed—that option
must be selected separately.

NOTES:
l If this option is not selected, then the utility will open the file as read-only

and will not attempt to acquire the document lock before processing.
l If the file group uses virtual plan files, this option does not apply because the

plan files cannot be saved. However, if the option is enabled, Axiom Contract
Management will attempt to acquire the document lock before processing,
which is not necessary. This option should not be enabled when processing
virtual plan files.

Run Save To
Database on
plan files after
processing

Specifies whether a save-to-database is performed in plan files during
processing. This option is selected by default.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a save-
to-database.

Create a plan file
restore point
before
processing

If selected, then a plan file restore point will be created before processing
begins. This option is not selected by default.

Restore points can be used to restore plan files to the state they were in before
changes weremade.

NOTE: If the file group uses virtual plan files, this option does not apply. Plan
files are not saved and therefore restore points are irrelevant.

Options for Process with Utilities
If Process with Utilities is the selected processing mode, there are no additional options on the Options
tab.

Plan files are not saved when using Process with Utilities, and plan file restore points are not created.
When using this mode, the processing is being performed in the utility files, not in the plan files, so it is
not necessary to save the plan files. Additionally, in most cases the plan files used with this mode are
virtual form-enabled plan files, so the save and restore options are irrelevant.

Options for Update Persistent Plan Files
IfUpdate Persistent Plan Files is the selected processing mode, the following additional option is
available on the Options tab:
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Option Description

Report File Click the Browse button to select the report file that is configured with the
PlanFileReconfig_ControlSheet. This file must be saved in the Reports Library.

This control sheet contains the settings that will be applied to plan files during
processing.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the plan
file update.

Options for Process with Custom Utility
If Process with Custom Utility is the selected processing mode, the following additional options are
available on the Options tab:

Item Description

Report File Click the Browse button to select theMicrosoft Excel spreadsheet file that
contains the VBA custom utility. The file must be saved in the Reports Library.

VBAModule Select the VBA module to run as part of this utility. The drop-down list shows
the VBA modules available in the selected file.

VBA Function Select the VBA function to run as part of this utility. The drop-down list shows
the VBA functions available in the selected module.

Plan files are always saved when using this processing option, and plan file restore points are always
created before processing. A save-to-database is not performed in this mode, so if you need to save
data, you should process plan files using Normal Processing after you have verified the results of the
custom utility processing.

� Plan Files tab
On the Plan Files tab, specify the plan files that you want to process. There are three different options
that you can use to specify the plan files: Choose from list, Use filter, and All. You should use the option
that corresponds to howmany plan files you want to process—all plan files, or a subset of plan files. If
you want to process a subset of plan files, you can select individual files to process or you can use a filter
to define the subset.
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NOTES:
l If a plan file is locked by another user when the task is executed, then processing for that file

will fail. Failures are noted in the result history for the job.

l If a plan file has not yet been created for a particular plan code, then that plan code will not
display in this list and will be ignored when processing. Scheduler does not support creating
plan files as part of the Process Plan Files task (you must use the separate Create Plan Files
task for this purpose).

l If the file group uses a Show on List column, then any plan code that is set to Falsewill not
display in the plan file list and will be ignored when processing.

Process all plan files
To process all plan files, select All. The list of all plan files is generated each time the Scheduler task is
executed, so that if new plan files have been added then those new plan files will be included in the
processing (the reverse is also true if any plan files have been removed).

Alternatively, you can select Choose from list and then select the check box in the column header,
causing all current plan codes to be selected. However, in this case the list of selected plan codes is fixed
and therefore will not automatically adjust for any future changes.

Process selected plan files
To process certain plan files, select Choose from list, and then select the check boxes for the plan files
that you want to process. When the Scheduler task is executed, Axiom Contract Management will
process only the selected plan files.

To find the plan files you are looking for, you can sort, filter, and group the list using standard Axiom grid
features. You can show additional columns and hide columns by right-clicking in the column header. If
you have filtered the list, you can select the check box in the header to select only the plan files that
currently display in the dialog.

NOTE: This option is not available if the file group for the task is an alias. This is because the list of
plan files could change when the alias target changes.

Process a filtered set of plan files
To use a filter to process a subset of plan files, select Use Filter. When the Scheduler task is executed,
Axiom Contract Management will process only the plan files that meet the filter.

You can use the Filter Wizard to create the filter, or you can manually type a filter criteria statement into
the filter box. The filter must use the plan code table or a lookup table. For example: DEPT.Region='US
West'where Dept is the plan code table.
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Once you have entered a filter, you can click Refresh plan file list to show the plan files that currently
match the filter. The refresh feature is intended to help you determine whether you have defined the
filter correctly.

You can also use a job variable for the filter. For example, you can define a job variable named "filter" and
then place the text {filter} in the filter box. This is intended for use when running Scheduler jobs via
RunEvent. If a variable value is specified when the event is triggered, such as the value
dept.region='west', then that filter statement will replace the {filter} variable and will be used to
determine the list of plan files to be processed.

NOTE: If you use a variable, and you leave the default value for that variable blank within the Job
Variables tab, then all plan codes will be processed if no value is passed by the RunEvent function.
You may want to define a default filter that results in no values (such as 1=0), so that plan files are
only processed if a valid filter value is passed.

� Axiom Queries
On the Axiom Queries tab, select the queries that you want to run in the plan files. By default, all listed
queries are selected. This tab only applies when using Normal Processingmode.

If you do not want to run a particular query, you can clear the check box. You can select or clear
individual check boxes, or you can use the check box in the header to select or clear all queries currently
displayed in the list. You can sort, filter, and group the list using standard Axiom grid functionality.

Example Axiom Queries tab

The list of Axiom queries is based on the source templates that were used to create the plan files. Only
Axiom queries that meet the following criteria are eligible for selection:

l Active is set to On, or the setting uses a formula.
l Refresh during document processing is set to On.
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If a query uses a formula for the Active setting, this means the query is dynamic and may or may not be
run, depending on how the formula resolves in each plan file to be processed. When a particular plan file
is processed, each selected query will be evaluated based on the current settings in that plan file. If both
Active and Refresh during document processing areOn for that plan file, then the query will be run. If
either or both settings areOff for that plan file, the query will not be run. You can tell whether a query is
dynamic or not by looking at theDynamic column in the query list.

If a query is not selected on this tab, then that query will not be run in any plan files during processing,
regardless of whether Active or Refresh during document processing are enabled in the plan file.

The plan file selection on the Plan Files tab affects the Axiom query list as follows:
l If you have selected individual plan files, then only the eligible queries for the source templates of

the selected plan files are shown.
l If you have selected All or Use Filter, then all eligible queries for all used templates are shown. If

the file group has templates that have not been used to create any plan files, then those
templates are not included in the list.

The listed queries are identified by template, worksheet, and query name. The following additional
properties are also listed for each query:

l Refresh On Open: Indicates whether the Axiom query is configured to refresh automatically when
the file is opened. This is for information purposes only, to help you determine whether the query
needs to be included in the processing. The Refresh on Open status is ignored by Process Plan
Files—if the query is selected it will be run along with the other selected queries, and if it is not
selected it will not be run.

l Dynamic: Indicates whether the query is dynamically enabled. Truemeans that the query uses a
formula for the Active setting.

NOTE: If a query is listed on this tab but it is grayed out and unavailable for selection, that means
that although the query is active (either directly or dynamically), the query is not eligible to be run
using Process Plan Files (because the setting Refresh during document processing is set to Off). This
query is listed for your information only, so that you understand the query cannot be run as part of
the process.

� Utilities tab
On theUtilities tab, select the ProcessPlanFileUtilities data source to use during processing. This data
source determines which utility files are processed and the processing order. This tab only applies when
using Process with Utilitiesmode.
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Example Utilities tab

For each template listed, use theUtilities Data Source field to select the data source to use for plan files
created from that template.

l If the template only has one data source, that data source is selected.
l If the template has multiple data sources, then the data sourcemarked as the default data source

is selected by default. If desired, you can use the drop-down list to select a different data source.

When plan files are processed, Axiom Contract Management reads the specified data source in each plan
file to determine the utilities to be processed for that plan file.

The plan file selection on the Plan Files tab affects the Utilities list as follows:
l If you have selected individual plan files, then only the templates used to create the selected plan

files are shown.
l If you have selected All or Use Filter, then all used templates are shown. If the file group has

templates that have not been used to create any plan files, then those templates are not included
in the list.

� Processing Variables
This tab can be used to define variables to pass into plan files before processing begins, and to pass
variables back to the Scheduler job after processing has been performed. This tab is optional and is only
used in special situations.

Pre-Processing Document Variables
This section can be used to pass document variables into plan files before processing. This can impact the
processing of plan files if the files are configured to use the variable values in someway.

For each pre-processing document variable, you can specify a variable name and a variable value. The
plan files must be set up with GetDocumentInfo functions that return the values for the specified
variables.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Pre-Processing Workbook Variables
This section can be used to pass values into plan files before processing. This can impact the processing
of plan files if the files are configured to use the values in someway.

For each pre-processing variable, you can specify a workbook location to place the value, and the value
to be placed.

Item Description

Workbook
Location

The location in the workbook for the value to be placed. Any existing value in
this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, then the value will be saved in the file.

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the plan file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.
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The specified location and value will apply to all plan files being processed by the task. If you are going to
use pre-processing variables, the location should be predefined in the template and therefore available
to all plan files built using that template. If the plan files will be built using multiple templates, then all
templates should be set up with the same designated location, or you should set up separate processing
tasks based on template type.

Post-Processing Workbook Variables
This section can be used to pass a value from plan files back to the Scheduler job after processing has
been performed. This can impact the processing of subsequent tasks in the job if those tasks are
configured to use the value in someway.

For each post-processing variable, you can specify the location in the workbook to find the value, and
the job variable to use that value.

NOTE: If this task processes multiple plan files, the resulting variable value will be from the last file
that was processed.

Item Description

Workbook
Location

The location in the workbook to find the value to be passed to Scheduler. This
value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created. However, in most cases you will want the variable to be
already set up with a default value, so that the job does not have validation
errors that prevent saving.

The specified location and job variable will apply to all plan files being processed by the task. If you are
going to use post-processing variables, the location should be predefined in the template and therefore
available to all plan files built using that template. If the plan files will be built using multiple templates,
then all templates should be set up with the same designated location, or you should set up separate
processing tasks based on template type.

Even though the task may process many plan files, only the job variable value from the last-processed
plan file will be used. The plan files must be set up so that all plan files result in the same value after
processing, or else your results will vary depending on which plan file was the last file to be processed.
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Process Document List task
This task processes a user-defined set of documents. The process operation always calculates the files. In
addition, you can opt to run Axiom queries in the files, process alerts in the files, and then perform a
save-to-database and/or save the files.

You can process any Axiom-managed Excel files by using this task. The primary intent of the task is to
process files such as driver files or report utilities. For example, you may be using Axiom queries and
GetData functions in your driver files that need to be updated regularly. Rather than opening, refreshing,
and saving each driver file, you can use this task to define the set of files and schedule processing.

NOTES:
l Generally speaking, plan files should not be processed using this task. Instead, the Process

Plan Files task should be used.

l This task does not perform file processing actions on the file. File processing can be set up for
report files and driver files, and can be used to perform actions such as file delivery, using
standard or multipass processing. If you want to perform file processing using Scheduler, use
the File Processing task.

� Documents to process
Specify the documents to be processed when the task is run. Documents are processed sequentially in
the order listed.

To add a document, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

To remove a document, select the document in the list and then click the
Remove button. Only one document can be selected at a time.

To change the order of documents, select the file in the list and then click
the arrow buttons to move the file up or down.

Only Axiom-managed Excel files are valid to be processed in the task.

Selecting a document using a file group alias
You may want to specify the document to process using a file group alias, so that the task does not have
to bemanually updated after rolling over to a new file group for a new year of planning. When you are
selecting a document in the Axiom Explorer dialog, you can expand the file group alias to see all of the
files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.
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Selecting a document to process using a file group alias

When you select a document underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the document within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected document.

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in the
new file group automatically. If the file does not exist in the new file group, the task will fail with an error.

� Processing Options
By default, both options are selected. Axiom queries are refreshed before the save-to-database occurs.

If neither option is selected, then the files are calculated and then saved.
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Item Description

Perform all enabled
Axiom Queries in
selected workbooks

If this option is selected, then all eligible Axiom queries in all selected files
will be refreshed when the task is run. This option is selected by default.

Axiom queries are eligible for processing if they are active and use either of
the following refresh behaviors: Refresh on File Open and Refresh During
Document Processing.

Enable iterative
calculation while
processing

Specifies whether iterative calculations are enabled for the file during
processing. In most cases you will leave this option disabled.

If this option is selected, then iterative calculations are enabled for the file
during the Axiom query refresh process. The iterative calculation settings
are fixed at a maximum of 100 iterations and a maximum change value of
.001.

For more information on iterative calculations, see theMicrosoft Excel
Help.

Save document after
processing

If selected, then files will be saved after processing. This option is selected
by default. The user executing the task must have Read/Write access to
the files.

This option does not cause a save-to-database to be performed—that
option must be selected separately.

NOTE: If this option is not selected, then the utility will open the file as
read-only and will not attempt to acquire the document lock before
processing.

Run Save To Database
on plan files after
processing

If selected, then a save-to-database will be performed after processing.
This option is selected by default. The user executing the task must have
the Allow Save Data permission to the files.

This option does not cause the file itself to be saved—that option must be
selected separately. It is not required to save the file in order to perform a
save-to-database.

Process alerts in
selected workbooks

If selected, then alerts in the file will be processed. The file must contain an
Alert Control Sheet and one or more alerts must be defined in the file.

If Axiom queries are enabled for processing as well, the queries will be run
before alerts are processed.

� Pre-Processing Document Variables
This section can be used to pass document variables into the target files before processing. This can
impact processing if the files are configured to use the variable values in someway, such as to filter an
Axiom query.
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For each pre-processing document variable, you can specify a variable name and a variable value. The
target file must be set up with GetDocumentInfo functions that return the values for the specified
variables.

To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

The following example screenshot defines the value for the document variable Dept. The value is defined
using the value of a Scheduler job variable {Dept}. A value for Dept can be passed into the Scheduler
job when the job is started, and then passed into the target file using the document variable.

� Pre-Processing Workbook Variables
This section can be used to pass values into the file before processing. This can impact processing if the
files are configured to use the values in someway. For each pre-processing variable, you can specify a
workbook location to place the value, and the value to be placed.

NOTE: The specified value will be placed in all files listed to process. Therefore, unless all files are set
up to use the same location and the sameway of deriving the value, you will need to create a
separate Process Document List task for each file. If you are not using pre-processing variables, then
this does not matter.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Workbook
Location

The location in the workbook for the value to be placed. Any existing value in
this location will be overwritten for the duration of the processing. If the file is
saved as part of the processing, the value will be saved in the file.

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Formula The value to be placed in the specified workbook location. The value can be a
"hard-coded" value, or a formula, or a job variable that will be resolved at time
of processing.

If the value is a formula, the formula is placed into the target cell and calculated
in the target file. The formula can be any formula that would be valid within a
spreadsheet in the Axiom client. This includes using Excel functions and Axiom
functions. The formula can also use job variables, which will be resolved before
placing the formula in the target cell.

� Post-Processing Workbook Variables
This section can be used to pass a value from the file back to Scheduler after processing has been
performed. This can impact the processing of subsequent tasks in the job if those tasks are configured to
use the value in someway. For each post-processing variable, you can specify the location in the
workbook to find the value, and the job variable to use that value.

NOTES:
l If this task processes multiple documents, the resulting variable value will be from the last

document processed.

l If the task is run as a sub-job, then the post-processing variable is not passed back to the
"parent" job. The task must be executed as a regular task within the job in order to pass the
variable value back to the job.
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To add a variable, click the Add button to add a row to the list. Complete the settings
for the variable as described below.

To remove a variable, select the variable in the list and then click the Remove button.
Only one variable can be selected at a time.

To change the order of variables, select the variable in the list and then click the
arrow buttons to move the variable up or down.

To edit the variable settings, double-click the applicable cell to make the cell contents editable. When you
are finished editing, you can press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Workbook
Location

The location in the workbook to find the value to be passed to Scheduler. This
value will become the value for the assigned job variable for the duration of
executing the current job (unless a later process within the same job overwrites
the value for the same job variable).

The location can be specified using SheetName!CellRef syntax (for example:
Report!A13), or by using a named location in the file.

Job Variable The job variable that you want to use the value in the specified workbook
location. Do not enclose the variable name in curly brackets (you are not using
the variable here, you are simply referencing the variable name).

If the job variable does not already exist in the job (on the Job Variables tab),
then it will be created when the job is executed. However, in most cases you will
want the variable to be already set up with a default value, so that the job does
not have validation errors that prevent saving.

Process Template List task
This task processes a user-defined list of file group templates. During processing, any Axiom queries with
Refresh during template processing enabled are executed and time-stamped, and then the template
files are saved.

The primary purpose of this task is to enable use of time-stamped Axiom queries with virtual plan files.
Because virtual plan files are re-created from template each time they are accessed, Axiom queries
cannot be time-stamped within the plan files. Virtual plan files can use the time stamp from the template,
but under normal circumstances, Axiom queries are not time-stamped when they are run in templates.
However, when Axiom queries are run during template processing, the Last refresh time for the query is
updated, which means that the queries can be configured to only run if the primary table has changed.
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To use this task to enable time-stamped Axiom queries for virtual plan files, do the following:
l In the template, enable Refresh only if primary table changed since last refresh and Refresh

during template processing for the Axiom queries that you want to be time-stamped.
l In Scheduler, create a job with a Process Template List task and add the template to the task.

Define a scheduling rule for the job as appropriate. For example, you might want the template to
be processed nightly.

When the template is processed, the designated Axiom queries will be run if the primary table has
changed, and the time stamps are updated. When a virtual plan file that uses this template is opened,
the queries will not be run again if the primary table has not changed.

This task should only be used to process Axiom queries that meet the requirements of time-stamped
queries.

� Templates to process
Specify the templates to be processed when the task is run. Templates are processed sequentially in the
order listed. If you havemultiple templates to process (in the same or different file groups), you can run
them all in the same task.

To add a template, click the Add button. In the Axiom Explorer dialog,
select the file or files that you want to add, and then click Open.

To remove a template, select the file in the list and then click the Remove
button. Only one file can be selected at a time.

To change the order of templates, select the file in the list and then click the
arrow buttons to move the file up or down.

Normal template behavior rules apply during processing. For example, save-to-database and action
codes are not run in templates. The only exception to normal template behavior during this task is that
any executed Axiom queries will be time stamped.

Selecting a template using a file group alias
You may want to specify the template to process using a file group alias, so that the task does not have
to bemanually updated after rolling over to a new file group for a new year of planning. When you are
selecting a template in the Axiom Explorer dialog, you can expand the file group alias node to see all of
the files in the current target of the alias.

For example, in the following screenshot, the file group alias Current Budget is expanded. Because the
alias currently points to the file group Budget 2018, the folders and files under the alias are from Budget
2018. When you select a file or folder, you can see the real file path in the top of Axiom Explorer.
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Selecting a template to process using a file group alias

When you select a template underneath an alias, the file path is written using alias syntax, so that the
Scheduler task will look for the template within the current target of the alias. This path is visible in the
tooltip that displays when you hover your cursor over a selected template.

File path using file group alias syntax

When the file group alias is updated to point to a new file group, the Scheduler task will use the file in the
new file group automatically. If the file does not exist in the new file group, the task will fail with an error.

Purge System Data task
The Purge System Data task is intended to clean up old data in your system, to help keep your system
running efficiently.

NOTE: Scheduler automatically creates a system job for this task (System.SystemDataPurge), which
administrators can edit as needed.
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This task purges the following data when it is run:
l Scheduler job result history
l Scheduler and system email notifications
l System temp table data
l Audit history
l Alerts

For each category of data, you can specify a number of days of data to keep when the task is run. All
results older than the specified number of days will be deleted. Note that 0 days means that no data is
purged for that category.

Section Item Description

Scheduler
Results

Number of days to keep
result history

The number of days of job result history to keep
when the task is run. By default, this is set to 15
days.

SMTP Messages Number of days to keep
delivered messages and
attachment data

The number of days of delivered message data
to keep when the task is run. By default, this is
set to 15 days.

Temporary
Tables

Number of days to keep
temp table data

The number of days of temp table data to keep
when the task is run. By default, this is set to 15
days.

Audit History Number of days to keep
system history

The number of days of system audit history to
keep when the task is run. By default, this is set
to 15 days.

"System history" encompasses all audit data—
including prior document versions and deleted
documents—except table audit data.

Table History Number of days to keep
table history

The number of days of table audit history to
keep when the task is run. By default, this is set
to 15 days.

Table audit data is tracked for tables where
Audited is set to True.

Alerts Number of days to keep
alerts

The number of days of alerts to keep when the
task is run. By default, this is set to 60 days.

Job variables can be used in all of these settings.
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Each purge routine in the task is limited to purging a specific number of rows at a time (50000). If the
number of rows to be purged exceeds this limit, then the excess data is retained until the next time the
task is run. If you notice data in the database that you expected to be purged, most likely the amount of
data to be purged exceeded the limit, and the data will be purged next time the task is run.

� Other purged data
This task also cleans up the following items in your system:

l Deleted columns. When a column is deleted from a table in Axiom Contract Management, the
column is immediately deleted from the associated view (which prevents it from being accessed in
the system), but it remains in the base table. This task finishes the process of removing obsolete
columns from the base tables.

l Orphaned user folders. If the system contains any user folders that do not match up with existing
users, these folders are deleted. Although user folders are deleted when a user is deleted from
security, orphaned user folders can result from other processes, such as migrating a system
between different management databases.

These items are not associated with any specific task settings; the delete process is performed whenever
the task is executed.

Raise Event task
The Raise Event task can be used to trigger other Scheduler jobs for execution, using a named event
handler. This task has one required setting:

Item Description

Event Name Enter the name of the event that you want to raise for execution. This name
must match a defined event handler name in one or more other Scheduler jobs.

When this task is run, it looks for any jobs that contain the specified event
handler name. These jobs are added to the schedule and are eligible to be
processed immediately, depending on Scheduler thread availability and any
other higher-priority jobs already in the queue.

NOTE: It is not possible to specify a file group context for the event handler
when using Raise Event. Axiom Contract Management will run all jobs that
contain the specified event handler name, regardless of whether the event
handler is associated with a file group.

Event Variables
This section can be used to pass variables into the jobs triggered by the event handler. If the jobs are
configured to use the variables, these values can impact how the jobs are processed.
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To add a variable, click the Add button to add a row to the list. Complete
the settings for the variable as described below.

To remove a variable, select the variable in the list and then click the
Remove button. Only one variable can be selected at a time.

For each variable, you can specify a variable name and a variable value. To edit the variable settings,
double-click the applicable cell to make the cell contents editable. When you are finished editing, you can
press the Enter key or Tab key to exit the cell, or click outside of the cell.

Item Description

Variable Name The name of the variable. Do not enclose the variable name in curly brackets
(you are not using the variable here, you are defining its value).

Variable Value The value of the variable. The value can be a "hard-coded" value, or it can be a
job variable that will be resolved at time of processing.

If you use a job variable to define the value, the job variable must be enclosed
in curly brackets.

Run Excel Macro task
This task runs an Excel macro on an Axiom file.

NOTE: This task is no longer supported because it requires Excel processing on the Scheduler server.
It is still available on the task list, but cannot be executed.

Please contact Axiom Contract Management support if you need assistance with this task.

Item Description

Workbook Path The path and name of the file to run themacro on.

You can click the Browse button to navigate to the file.

Macro Name The name of themacro to run.

Macro
Arguments

If themacro takes arguments, you can enter the argument values here.

Click Add to add an argument, Remove to delete the selected argument, or
Clear to clear all arguments.

Job variables can be used in all of these settings.
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Run Scheduler Job task
This task runs a specified Scheduler job as a subordinate job within the current job. The job containing
the Run Scheduler job task is the parent job, and the target job for the task is the child job.

By default, the parent job waits until the child job is complete before continuing to the next task in the
parent job. This means that tasks after the Run Scheduler Job task can be reference the results of the
child job. For example, the child job may perform a save-to-database. The subsequent tasks in the
parent job can access the data saved by the child job.

� Task Control options
When you create the Run Scheduler Job task, the options in the Task Control section are pre-set as
follows:

l The option Create a Subordinate Job for this Task is grayed out. This is because the target job is
always run as a subordinate job.

l The optionWait for all Subordinate Jobs to complete before proceeding to the next Task is
enabled by default. This means that tasks after the Run Scheduler Job task can be dependent on
the target job and reference the results of that job. If you disable this option, then the parent job
will continue to the next task in the job immediately after creating the subordinate job—it will not
wait for the subordinate job to complete.

Keep in mind that if you want the parent job to stop processing tasks if the target job fails, thenWait for
all Subordinate Jobs to complete before proceeding to the next Taskmust be enabled for the task and
If this Task fails, continue executing subsequent Tasksmust be disabled for the task. This is the default
configuration.

If needed, you can use the option Process task only if the value of this expression is true to detect
whether a subsequent task in the parent job should be processed. For example, if you know that the
child job saves a particular value to the database, you can check for the existence of that value to
determine whether to process the task. For more information on using this option, see Conditionally
processing tasks in a job.

� Target Scheduler job
In the Task Details section, use the Browse button to select the target Scheduler Job. You can select any
job that you have access to in the Scheduled Jobs Library.

When the Run Scheduler Job task is executed, it creates one or more subordinate jobs as needed to
execute the tasks in the target Scheduler job. As long asWait for all Subordinate Jobs to complete
before proceeding to the next Task remains enabled in the Task Control options, the parent job waits
for all subordinate jobs to be completed beforemoving on to the next task in the parent job.
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NOTE: The user executing the job does not need to have security access to the target Scheduler job
for Run Scheduler Job. It is assumed that if the user can execute the parent job, the user should be
able to execute the target job.

� Child Job Values
If the target job for the Run Scheduler Job task has defined job variables, those variables and their
default values are listed in this section. The default values are determined as follows:

l If the parent job and the child job have a variable with the same name, the default value is the
value defined in the parent job. This value will be passed to the child job and used when the child
job is run.

l Otherwise, the default value is the value defined in the child job.

To override a variable value, select theOverride check box and then click inside theOverride Value field
to enter a value. You can enter a hard-coded value or use a job variable from the parent job. Enter the
variable name in curly brackets to use that variable's value as the override value.

For example, imagine that both the parent job and the child job have a variable of {Dept}. In the parent
job, the value of {Dept} is set to 20000, and in the child job the value is set to 40000. The Run Scheduler
Job task will display the parent value of 20000 as the default value, and that value will be used when the
child job is executed.

Now imagine that the parent job has a variable of {StartDept} set to 20000, and the child job has a
variable of {Dept} set to 40000. In this case, the Run Scheduler Job task will display the value of {Dept}
as defined in the child job (40000). If you want to use the parent job value for {StartDept} instead,
then you must select the Override check box and enter {StartDept} as the Override Value. Now the
value of {Dept} in the child job will be overridden and set to 20000.

SMTP Message Delivery task
This task delivers email notifications for Scheduler jobs.

NOTE: Scheduler automatically creates a system job for this task (System.SMTPMessageDelivery),
which administrators can edit as needed.

Item Description

Server name The server name of the SMTP email server.

Port number The port number for the SMTP email server. By default, the port is 587, but you
can specify a different port number if needed.
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Item Description

Server requires
authentication

Select this check box if the SMTP email server requires authentication.

If selected, type a Username and Password.

Test Mode Specifies whether the task is run in test mode. If this check box is selected, the
task verifies that it can successfully connect to the SMTP server to send email
notifications, but no emails are actually sent.

For the System.SMTPMessageDelivery job, new systems are automatically set
to test mode. If you restore a database, the restore process also sets the
system job to test mode. You must disable test mode before any emails will be
sent.

Start Process task
This task starts a process for Process Management. You can use this task to automatically start a process
at a specific point in time, including recurring schedules (such as to automatically start a monthly
process).

This task can be used to start a generic process definition or a plan file process definition.

Item Description

Process to start The process definition to start. Click the Browse button to select the process
definition file. You can select any process definition that you have access to
within the Process Definition Library or within a file group Process Definitions
folder.

If the Scheduler job is stored in a file group Utilities folder, then you can
optionally navigate to the process definition file through the Current File Group
node at the top of the file groups list. When you do this, the path to the file is
stored relative to the current file group, which means that it will automatically
update when the file group is cloned. This is the recommended method of
referencing the process definition file when the Scheduler job belongs to a file
group.
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Item Description

Restart process if
it is already
running

Specifies whether the Scheduler task will restart the process if it is already
running, or if the process will be left as is.
l Select this option if you want to start the target process regardless of

whether it is already running. The current process instance will be aborted
and a new process instance will start over at step 1. This option is selected by
default.

l Clear this option if you want to leave the existing process instance running.
In this case, the Scheduler task will take no action if the target process is
already running.

Scheduler tasks for database maintenance
Scheduler provides several built-in tasks that are intended for databasemaintenance. By default, these
tasks are included in the System.IndexMaintenance job, which runs regularly to maintain your database.
However, these tasks can also be added manually to jobs as needed to perform additional database
maintenance.

The following databasemaintenance tasks are available:
l Rebuild Database Indexes task
l Update Database Statistics task
l Update Indexes and Constraints task

All of these tasks are predefined versions of the Execute SQL Command task. You can use the Source
Axiom Database field to specify whether the task is executed against the system database or the audit
database.

For the SQL Command Text, the actual SQL code used by each task is generated automatically by Axiom
Contract Management when the task is executed. This ensures that the tasks always use themost
current SQL code for each task as defined by Axiom Contract Management.

Web Scheduler
Although most Scheduler setup activities can only be performed in the Desktop Client, some job
management can be performed in theWeb Client. Using the "Web Scheduler", you can monitor and
manage the job schedule, review job results, and process existing jobs on demand.

To access Scheduler in the Web Client:

1. In theWeb Client, click themenu icon in the Global Navigation Bar. From the Area menu,
select System Administration.
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2. From the Navigation panel, select Tools > Scheduler.

When you access the Scheduler area, a Scheduler panel becomes available in the left side of the Task Bar.
You can use this panel to change the current Scheduler view.
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Example Scheduler area in Web Client

Managing the job schedule in the Web Client
In the Scheduler area of theWeb Client, you can view the status of all jobs that are currently on the
schedule. If necessary, you can view the job details, remove the job from the schedule, or run the job
now.

To view the current job schedule:
l On the Scheduler page, from the Scheduler panel, select Scheduled Jobs.

The Scheduled Jobs grid displays all jobs that are scheduled to be processed, or are currently in process.
This includes scheduled jobs, jobs executed manually via Run Now, and jobs that were triggered for
execution via an event handler.
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Example Scheduled Jobs grid

You can use the Actions column in the right side of the grid to perform any of the following actions on a
job:

View the job properties and results.

Remove the job from the schedule.

IMPORTANT: If the job is on the schedule due to a scheduling rule, this
action disables the scheduling rule and removes all future executions from
the schedule as well. If you want future scheduled instances of the job to
proceed, you must edit the job to re-enable the scheduling rule.

Run the job now.

This action places the job on the schedule for immediate execution (if
another manual instance of the job is not already pending). The future
scheduled instance of the job remains on the schedule.

To refresh the list, click the Refresh icon in the Task Bar.

For each job on the schedule, you can view the following information:

Item Description

Job The name of the job.

User The user identity that the job will be run as. If the job is a system job, the user is
System.

This is typically the name of the user who placed the job on the schedule, but not
always (for example, when using an event handler that is set to run as the job owner
instead of as the requester).
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Item Description

Status Job status is either Pending (waiting to be executed) orWorking (currently being
executed).

Server If a job is currentlyWorking, then the server executing the job is listed here.
Otherwise, this column is blank.

Priority The priority category for the job:

1. Manual: The job was executed manually.

2. Event Handler: The job was executed by a Scheduler event handler.

3. Scheduled Job: The scheduled instance of the job results from an active
scheduling rule.

4. Subordinate Job: The job was generated as a subordinate job, from a
currently executing job.

The priority category determines how jobs are evaluated for processing order, in
conjunction with the job's Priority Elevation setting. Manual jobs are highest
priority, and subordinate jobs are lowest priority. For more information, see
Processing priority for scheduled jobs.

Start Time The start time of the job. The job is eligible for immediate execution if the start time is
now or passed. Jobs may not be executed right at the start time if no Scheduler
threads are currently available to execute the job, or if other eligible jobs have higher
priority.

If the job is on the schedule due to a scheduling rule, the start time is based on the
scheduling rule. If the job was manually executed via Run Now or triggered by an
event handler, the start time is the time the execution was initiated.

Due In The length of time until the job is due to be processed. For example, if the job is
scheduled to run at noon and it is currently 11:50 AM, then the job is due to be run in
10minutes.

This column is intended to make it easy to see when a job will be run, without
needing to calculate it based on the start time.

NOTE: If a job has a scheduling rule with a recurring schedule, only the first scheduled execution
appears in the Scheduled Jobs list. For example, if you have a job that is scheduled to run once a
month for a year, you will not see all twelve scheduled executions in the list—you will only see the
first scheduled execution. Once that instance has been run, the scheduling rule is re-evaluated and
the next scheduled execution appears in the list.
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Viewing job results in the Web Client
In the Scheduler area of theWeb Client, you can view the results of jobs that have been executed. For
each job, you can see when it was run, and whether it completed successfully or had errors.

To view job results:
l On the Scheduler page, from the Scheduler panel, select Job Results.

The Job Results grid shows a list of jobs that have been recently executed. The grid shows the following
summary information:

l The name of the job, and the ID of the particular execution of that job
l The user identity the job was run as
l The status of the job, such as Success or Failure
l The Scheduler server that ran the job
l The start time and duration of the job

To refresh the list, click the Refresh icon in the Task Bar.
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Example Job Results grid

To view detailed results for a particular job execution, hover your cursor over the job and then click the
View icon in the far right column. This opens the job properties to the Job Results section, with the
corresponding execution ID expanded. You can further expand the job results to see the specific tasks
that were executed.

Example Job Results detail showing tasks executed

To view the detailed task results, hover your cursor over the task and then click the View icon in the
far right column. This opens a dialog to display the results for that task. For example, for a file processing
task, the detailed results would contain information such as the processing type and the number of
passes, and the output that was created at the end of the process.
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Once you are viewing the Job Results section of the job properties, you can review all of the available job
history as needed. Expand any execution ID to view the details for that particular execution.

TIP: You can also view job results by opening a job and viewing the job properties, which include the
job results. In some cases it may be easier to open the job and review all of its results rather than
trying to find the job within the overall job results. For more information, see Viewing jobs and event
handlers in theWeb Client.

NOTE: Users with the Scheduled Jobs User security permission can only see job results for jobs that
they executed. Administrators can see job results for all jobs.

� System job results
By default, system job results are hidden in the Job Results grid. System jobs such as the SMTP message
delivery job may run frequently, and can easily fill up the result history, making it difficult to find results
for user-initiated jobs.

If you want to view results for system jobs, you can do one of the following:
l Clear theHide system jobs check box above the Job Results grid. The list immediately updates to

include system jobs.
l Open the system job directly, and view its job results within the job. For example, you can go to

the Scheduled Jobs page and double-click the System.SystemDataPurge job to view all results for
that job.

� Job result availability
Job results are purged periodically to help optimize system performance. The availability of job results in
your system depends on the configuration of the system job System.PurgeSystemData. This system job
runs periodically to purge old data in your system, including old job results. By default, when this job is
run, it purges job history older than 15 days.

The configuration of this system job can only be viewed and edited in the Desktop Client, and only by
administrators. For more information, see Configuring Scheduler system jobs.

Additionally, individual jobs can be configured to purge old results when the job is run. In theWeb
Client, you can view the job properties to see if this option is enabled, but you cannot edit the job
properties. The option is displayed in theGeneral section of the job, under Job Results Cleanup. For
more information on viewing job properties, see Viewing jobs and event handlers in theWeb Client.

Running a job manually in the Web Client
In the Scheduler area of theWeb Client, you can run a job manually as needed.
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When using this approach, the job is run now. It is not possible to run a job manually and specify a
future execution time. If you want to schedule a job for future execution, you must define a scheduling
rule on the job, which can only be done in the Desktop Client. For more information, see Defining
scheduling rules for a job.

To run a Scheduler job manually:
1. On the Scheduler page, from the Scheduler panel, select Job Explorer.

2. In the Job Explorer page, locate the job that you want to run. This page lists all jobs in the
Scheduler Jobs Library that you have permission to access.

3. Hover your cursor over the job, then click the Run Once icon in the far right column.

The job is added to the schedule with a start time of now, and is eligible for immediate execution
(pending available Scheduler threads and any higher-priority jobs already in the queue). You are
automatically taken to the Scheduled Jobs area of Scheduler, so that you can see the job on the
schedule.

Running a job manually does not impact any scheduled executions of the job as determined by
scheduling rules. For example, if a job is scheduled to be run at 10:00 PM tonight, and you run the job
manually at 2:00 PM, the job will still be run as scheduled at 10:00 PM.

Viewing jobs and event handlers in the Web Client
In the Scheduler area of theWeb Client, you can view Scheduler jobs and event handlers.

� Viewing jobs
You can view any job in the Scheduler Jobs Library that you have permission to access.
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Scheduler jobs are read-only in theWeb Client. You can view the job properties to better understand the
purpose of a particular job and the tasks that it performs. TheWeb Client does not support creating new
jobs, editing existing jobs, or deleting jobs. If you need to perform any of those actions, you must use
the Desktop Client. For more information, see Scheduler Overview.

To view a Scheduler job:
1. On the Scheduler page, from the Scheduler panel, select Job Explorer.

2. In the Job Explorer page, locate the job that you want to view. This page lists all jobs in the
Scheduler Jobs Library that you have permission to access.

3. Hover your cursor over the job, then click the View icon in the far right column.

The job opens, and the Scheduler panel updates to show the viewable sections of the job. You can
switch between sections by selecting section names in the Scheduler panel. By default, theGeneral
section is shown.
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Example job properties

All job properties are defined in the Desktop Client. The following is a brief overview of the job properties
shown in theWeb Client.

Section Description More Information

General General job properties that impact the job's
processing priority and processing behavior.

Job properties

Variables Variables used by the job.
l If the job has defined variables, those variables

display in the Job Variables section at the top of
the page. Most likely, the tasks in the job are
configured to use these variables. This typically
means that the job is designed to be run using an
event handler, and the necessary variable values
will be passed to the job when it is triggered.

l The System Variables section displays the job's
values for various system-defined variables. This
section can help you understand who the owner
of the job is, and how other system variables will
resolve for the job.

Using job variables
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Section Description More Information

Scheduling Rules Scheduling rules to schedule jobs for future
execution. If the job has an active scheduling rule, the
job will be executed according to the rule (one time or
recurring, depending on how the rule is configured).
l Day of Week, Hours, andMinutes specify when

the job will be executed within the start / end
range of the rule. An asterisk in any of these fields
means "all"—for example, if Hours is set to * then
the job is run every hour.

l Starting On and Ending On determine the start /
end range of the rule. If they are blank, then the
rule has no start or end date.

Defining scheduling
rules for a job

Event Handlers If the job is designed to be run using an event
handler, the event handler name is listed here. The
Execute As property determines whether the job is
run as the requester or the job owner when it is
triggered for execution.

Viewing event
handlers

Notifications Notification settings for the job. The job can be
configured to send email notifications when the job
completes, or only when the job has errors. Variables
can be used to determine the notification recipients.

Setting up
notifications for jobs

Tasks Tasks to be executed by the job, listed by name and
task type. No other task properties are available in
theWeb Client. If you want to seemore information
about the task, you must view the job in the Desktop
Client.

Scheduler Task
Reference

Results Detailed results of the previous job executions.
Results are organized by execution ID and displayed
in execution order (themost recent listed first).

Viewing job results in
theWeb Client

� Viewing event handlers
You can view the event handlers that are defined in the system. Event handlers are used to trigger
Scheduler jobs based on an event.

For example, an Axiom form can have a Button component that is configured with the RunEvent
command. When a user clicks the button, the specified event name is passed to Scheduler, and any jobs
associated with that event are triggered to run. Variable values can also be passed from the form to the
Scheduler job as part of this process.
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Event handlers are read-only in theWeb Client. If you need to create, edit, or delete an event handler,
this can only be done in the Desktop Client. For more information, seeManaging event handlers.

To view Scheduler event handlers:
l On the Scheduler page, from the Scheduler panel, select Event Handlers.

The Event Handlers grid lists all of the event handlers as follows:
l Event Name: Name of the event handler. This is the name used in features such as RunEvent to

trigger execution of a Scheduler job.

l Job: Name of the job where the event name is used. When the event is raised by a feature such as
RunEvent, this job will be executed.

l User: The user identity that will be used to execute jobs triggered by the event handler. If the
event handler is configured to run as the requester, then Requester is listed here. If the event
handler is configured to run as the owner, then the owner name is listed here (either a specific
user name, or System).
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Security
Axiom Contract Management security roles
Axiom Contract Management provides four main user security roles. Following are summaries of each
role. For details, refer to the following table.

CMA Admin – User with the CMAAdmin security role have Administrative privileges within the
application.

CMA Analyst – Users with the CMAAnalyst security role have standard user level permissions within the
application.

CMA User – Users with the CMAUser security role have restricted rights.

CMA Scheduler – Users with the CMA Scheduler security role have access to the Axiom Scheduler and
ETL tools within the Axiom.

Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Contracts Add, delete,
and modify
all aspects of
the contract

View only View only No access

Simulations Add, delete,
and modify
all aspects of
a simulation

View only View only No access

12
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Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Claims
View a
Claim

l View all
tabs

l Add and
modify
Claim
Tracking

l View
Voucher

l View all tabs
l Add and modify Claim

Tracking
l ViewVoucher

View only No access

Claims Re-
calculate

All features of
re-calculate

All features of re-calculate No access No access

Claims
Track /
Assign
Claims

l Create,
delete,
and edit
user-
defined
categories

l Export
reports

l Build
filters

l Create, delete and
edit user-defined
categories

l Export reports and
claims lists

l Build filters

l View and export
Claims lists

l Run Reports using
existing filters

l Export reports

No access

Import
Data

View only.
We
recommend
contacting
support prior
to deleting
any data
from the
system.

View only View only Create,
delete,
edit Axiom
ETLS to
facilitate
loading
data into
Axiom
tables

Reports l Create,
view, edit
reports

l Build
Advanced
filters

l Create new
l View existing
l Build Advanced filters

l View/run only
l Export Reports

No access
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Access to: CMA Admin CMA Analyst CMA User CMA
Scheduler

Axiom
Scheduler

No access to
Axiom jobs

No access to Axiom jobs No access to Axiom
jobs

Create,
edit,
delete,
and
schedule
Axiom
jobs
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